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What Does This Logo Mean?
It means this courseware has been approved by the Microsoft® Office Certification Program to be 

among the finest available for learning Microsoft® Office Outlook® 2007. It also means that if you 

complete and fully understand this courseware, you will be prepared to take an exam certifying your 

proficiency in this application.

What Is a Microsoft Office Specialist?
A Microsoft Office Specialist is an individual who has passed exams that certify his or her skills in 

one or more of the Microsoft Office desktop applications such as Microsoft Word, Microsoft Excel, 

Microsoft PowerPoint, Microsoft Outlook, or Microsoft Access. The Microsoft Office Specialist 

Program is the only program in the world approved by Microsoft for testing proficiency in Microsoft 

Office desktop applications. This testing program can be a valuable asset in any job search or career 

advancement.

More Information
To learn more about becoming a Microsoft Office Specialist, visit www.microsoft.com/officespecialist.

The availability of Microsoft Office certification exams varies by application, application version, and 

language. Visit the site listed above for exam availability.
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Microsoft® Office Outlook® 2007: A Professional Approach is written to help 

you master Microsoft Outlook. The text takes you step-by-step through the 

Outlook features that you’re likely to use in both your personal and business 

life.

Case Study
Learning about the features of Outlook is one thing, but applying what you 

learn is another. That’s why a Case Study runs through the text. The Case 

Study offers the opportunity to learn Word in a realistic business context. 

Take the time to read the Case Study about AllWood Mills, Inc., a fictional 

business located in Dubuque, Iowa. All the application exercises for this 

course involve AllWood Mills.

Organization of the Text
The text includes three units. Each unit is divided into smaller lessons. 

There are six lessons, each self-contained, but building on previously learned 

procedures. This building block approach, together with the Case Study and 

the features listed next, enables you to maximize the learning process.

Features of the Text
• Objectives are listed for each lesson.

• Required skills for the Microsoft Certification Exam are listed for each 

lesson.

• The estimated time required to complete each lesson up to the Lesson 

Applications section is stated.

• Within a lesson, each heading corresponds to an objective.

• Easy-to-follow exercises emphasize “learning by doing.”

• Key terms are italicized and defined as they are encountered.

• Extensive graphics display screen contents.

• Toolbar buttons and keyboard keys are shown in the text when used.

• Large toolbar buttons in the margins provide easy-to-see references.

• Lessons contain important Notes, useful Tips, and helpful Reviews.

• A Lesson Summary reviews the important concepts taught in the lesson.

• A Command Summary lists the commands taught in the lesson.

• Concepts Review includes true/false, short answer, and critical thinking 

questions that focus on lesson content.

• Skills Review provides skill reinforcement for each lesson.

• Lesson Applications ask you to apply your skills in a more challenging way.

• On Your Own exercises let you apply your skills creatively.

• Unit Applications give you the opportunity to use the skills you learn 

throughout a unit.

• Includes an Appendix of Microsoft’s Certification standards, a Glossary, 

and an Index.
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Microsoft Office Certification Program
The Microsoft Office certification program offers certification for each 

application, and an overall “Office Specialist” option once enough exams 

have been passed. This certification can be a valuable asset in any job search. 

For more information about this Microsoft program, go to www.microsoft.

com/officespecialist. For a complete listing of the skills for the Outlook 2007 

certification exam and a correlation to the lessons in the text, see Appendix: 

Microsoft Office Certification.

Professional Approach Web Site
Visit the Professional Approach Web site at www.mhhe.com/pas07 to access 

a wealth of additional materials.

Conventions Used in the Text
This text uses a number of conventions to help you learn the program and 

save your work.

• Text to be keyed appears either in red or as a separate figure.

• Filenames appear in boldface.

• Options that you choose from tabs and dialog boxes, but that are not 
illustrated buttons, appear in green; for example, “Choose Print from the 

Office menu.”

• You’re asked to save each document with your initials followed by the 

exercise name. For example, an exercise might end with this instruction: 

“Save the document as [your initials]5-12.” Documents are saved in 

folders for each lesson.

If You Are Unfamiliar with Windows
If you’re unfamiliar with Windows, review the “Windows Tutorial” available 

on the Professional Approach Web site at www.mhhe.com/pas07 before 

beginning Lesson 1. This tutorial provides a basic overview of Microsoft’s 

operating systems and shows you how to use the mouse. You might also want 

to review “File Management” to get more comfortable with files and folders.

Screen Differences
As you practice each concept, illustrations of the screens help you follow the 

instructions. Don’t worry if your screen is different from the illustration. These 

differences are due to variations in system and computer configurations.
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You’ll need Microsoft Office Outlook 2007 to work through this textbook. 

Outlook 2007 needs to be installed on the computer’s hard drive or on a 

network. Use the following checklists to evaluate installation requirements.

Hardware
• Computer with 500MHz or higher processor and at least 256MB of RAM

• CD-ROM drive and other external media of your choice for saving files

• 1.5GB or more of hard disk space for a “Student” Office installation

• 1024 ⫻ 768 or higher-resolution video monitor

• Printer (laser or ink-jet recommended)

• Mouse

• Modem or other Internet connection

Software
• Outlook 2007 (from Microsoft Office Systems 2007)

• Windows XP with Service Pack 2 or later, or Windows Vista or later 

operating system

• Browser and Internet access

installation requirements

xi





Windows Tutorial xiii

If you are not familiar with Windows, review this “Windows Tutorial” carefully.

You will learn how to

• Use a mouse.

• Start Windows.

• Use the taskbar, menus, Ribbon, dialog boxes, and other important 

aspects of Windows.

If you are familiar with Windows but need help navigating 

Windows files and folders, refer to the section “File 

Management.” There you will find information on how 

Windows stores information and how to use Windows 

Explorer, a tool for managing files and folders.

Computers differ in the ways they can be set up. In most 

cases, when you turn on your computer, Windows loads 

automatically and the Windows log-on screen appears. 

When you see the Windows log-on screen, you need to log 

on and key a password. In order to log on, you need to know 

how to use the mouse, a device attached to your computer.

Using the Mouse
A mouse is a pointing device that is typically attached to your computer. 

Optical versions, which are not attached, are also available. The mouse is 

your access to the computer screen, allowing you to accomplish specific 

tasks. It operates through a pointer, a screen object you use to point to 

objects on the computer screen. The normal shape for the mouse cursor is 

an arrow. To move the pointer arrow on the screen, you roll the mouse on 

any flat object, or on a mouse pad, which has a smooth surface designed for 

easy mouse rolling. Although you can use the keyboard with Windows, you 

will probably find yourself using the mouse most of the time.

 To use the mouse to point to an object on the computer screen:

 1. Turn on the computer (if it is not on already). Windows loads, and the 

log-on screen appears. The screen includes a log-on name and picture 

assigned to you by your instructor.

To log on, you need to move the mouse pointer to the log-on name that was 

assigned. The pointer on the computer screen mirrors the actions made by 

the mouse when you roll it. Place your hand over the mouse and roll it to the 

left. The pointer on the screen moves to the left.

  2. Roll the mouse to the right, and watch the pointer on the screen move to 

the right.

 3. Practice rolling the mouse in all directions.

 4. Roll your mouse to the edge of the pad, and then lift it up and place 

it back in the middle of the pad. Try it now to see how it works. When 

you feel that you can control the mouse position on the screen, roll the 

mouse to the name you have been assigned.

NOTE

All examples in this tutorial refer 
specifically to Windows Vista. If you are 

using any other version of Windows, 
your screen might differ slightly from the 
images shown in this tutorial. However, 

because most basic features are common 
to all versions of Windows, this tutorial 

should be helpful to you no matter which 
version of Windows you use.

windows tutorial
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xiv Windows Tutorial

To log on, you will need to click the name to select it. Mouse clicks are 

covered in the next section; instructions for logging onto Windows Vista are 

covered in succeeding sections.

Clicks and Double-Clicks
A mouse typically has two buttons at the front (the edge of the mouse 

where the cord attaches)—one on the left (primary) and one on the right 

(secondary). A mouse might also have a center button or a wheel.

 Single-click actions with the mouse are used to position the pointer at a 

specific screen location. To perform a single click:

 1. Roll the mouse around on the mouse pad until the pointer on the screen 

is over an object on the screen. Remember that the direction in which 

you move the mouse on the pad represents the pointer’s movement on 

the screen.

 2. Press and release the left mouse button once. Pressing and releasing 

the mouse button is referred to as a click. The computer tells you that 

the action has been performed when the object you click is highlighted 

(typically, the color of the selected object changes) to indicate to you 

that it has been selected. In Windows, you often need to select an object 

before you can perform an action. For example, you usually need to 

select an object before you can copy it.

 Pressing and releasing the mouse button twice is referred to as a double-

click. When you double-click an object on the screen, it is selected—the 

object is highlighted—and an action is performed. For example:

•   When you double-click a folder, it is highlighted 

and opens to a window showing the items the folder 

contains.

•   When you double-click a word in a text file, it is 

selected for a future action. In a text file, the pointer 

becomes an I-beam for selecting text in the document.

Selecting and Highlighting
You can also select a larger object such as a picture or a block of text by 

using the mouse.

 1. Position the pointer on one side of the object, and hold down the left 

mouse button.

 2. Roll the mouse until the pointer reaches the other side of the object.

 3. Release the mouse button. The selected object is highlighted.

Drag and Drop—Moving an Object 
Using the Mouse
You can use the mouse to move an object on the screen to another screen 

location. In this operation, you select an object and drag the mouse to move 

the selected object, such as an icon. The operation is known as drag and 

drop.

NOTE

Whenever you are told to “click” or 
“double-click” an object on the computer 

screen, use the left mouse button.
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 1. Using the mouse, move the pointer over the object you want to drag.

 2. Perform a single-click action by pressing the left mouse button but keep 

it pressed down. The selected object will be highlighted.

 3. With the left mouse button still depressed, roll the mouse until the 

pointer and selected object are placed at the desired new location.

 4. Release the mouse button to drop the object. The object is now 

positioned at the new location.

Using the Right Mouse Button
Pressing and quickly releasing the right mouse button is referred to as a right-

click. Although the right mouse button is used less frequently, using it can 

be a real time-saver. When you right-click an icon, a shortcut menu appears 

with a list of commands. The list of commands displayed varies for each icon 

or object.

 As you progress in this tutorial, you will become familiar with the terms 

in Table 1, describing the actions you can take with a mouse.

 

TABLE 1 Mouse Terms

TERM DESCRIPTION

Point  Roll the mouse until the tip of the pointer is touching the desired 

object on the computer screen.

Click  Quickly press and release the left mouse button. Single-clicking 

selects objects.

Double-click  Quickly press and release the left mouse button twice. Double-

clicking selects an object and performs an action such as opening a 

folder.

Drag  Point to an object on screen, hold down the left mouse button, and 

roll the mouse until the pointer is in position. Then release the mouse 

button (drag and drop).

Right-click  Quickly press and release the right mouse button. A shortcut menu 

appears.

Select  When working in Windows, you must first select an object in order to 

work with it. Many objects are selected with a single click. However, 

depending on the size and type of object to be selected, you may 

need to roll the mouse to include an entire area: Holding down the 

left mouse button, roll the mouse so that the pointer moves from one 

side of an object to another. Then release the mouse button.

Pointer Shapes
As you perform actions on screen using the mouse, the mouse pointer 

changes its shape, depending on where it is located and what operation you 

are performing. Table 2 shows the most common types of mouse pointers.
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Starting Windows: The Log-on Screen
The Windows Vista log-on screen allows several people to use the same 

computer at different times. Each person is assigned a user account that 

determines which files and folders you can access and your personal 

preferences, such as your desktop background. Each person’s files are hidden 

from the others using the computer. However, users may share selected files 

using the Public folder. The log-on screen lists each user allocated to the 

computer by name.

 If the administrator has added your name to a given computer, the log-on 

screen will include your name. If the computers are not assigned to specific 

individuals, you may find a box for Guest or for a generic user. If your 

computer is on a network, your instructor might need to provide you with 

special start-up instructions.

After you have logged on to Windows Vista, the desktop 

is the first screen you will see. It is your on-screen work 

area. All the elements you need to start working with 

Windows appear on the desktop.

 1.  If you have not already turned on the computer, do so 

now to begin the Windows Vista loading process. The 

Windows log-on screen appears.

TABLE 2 Frequently Used Mouse Pointers

SHAPE NAME DESCRIPTION

 Pointer Used to point to objects.

 I-Beam  Used in typing, inserting, and selecting text. 

When the I-beam is moved to a selected 

location, it turns into a blinking bar.

 Two-pointed arrow  Used to change the size of objects or 

windows.

 Four-pointed arrow Used to move objects.

 Busy Indicates the computer is processing a

   command. While the busy or working in 

background pointer is displayed, it is best

 Working in background  to wait rather than try to continue working. 

Note: Some of the working in background 

actions will not allow you to perform other 

procedures until processing is completed.

 Hand  Used to select a link in Windows’ Help or 

other programs.

NOTE

On some computers, the log-on screen 
does not appear automatically. You might 

have to press the following keys, all at 
once, and then quickly release them: 

Ctrl ⫹ Alt ⫹ Delete .
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 2. Click your name to select it. The Password box appears with an I-beam 

in position ready for you to type your password.

 3. Type your password.

 4. Click the arrow icon to the right of the box. If you have entered the 

password correctly, the Windows desktop appears. If you made an error, 

the Password box returns for you to type the correct password.

The Windows Desktop
The Desktop includes the Start button, taskbar, and sidebar. You may also 

see icons on the desktop that represent folders, programs, or other objects. 

You can add and delete icons from the desktop as well as change the desktop 

background. The Start button is your entry into Vista functions.

Figure 1
Windows Vista 

Desktop

Using the Start Menu
Click the taskbar Start button to open the Start menu. You can also press 

the Windows logo key on the keyboard to open the Start menu. Use the 

Start menu to launch programs, adjust computer settings, search for files 

and folders, and turn off the computer. If this is a computer assigned to 

you for log-on, your Start menu may contain items that differ from those of 

another user assigned to the same computer. To open and learn about the 

Start menu, first click the Start button on the Windows taskbar. The Start 

menu appears.

Icons

Sidebar 

Taskbar 

Start button

Quick Launch Toolbar Notification area
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 The left pane consists of three sections divided by separator lines. The 

top section, called the pin area, lists programs that are always available for 

you to click. These can include your Internet browser, e-mail program, your 

word processor, and so forth. You can remove programs you do not want 

listed, rearrange them, and add those you prefer.

 Below the separator line are shortcuts to programs you use most often, 

placed there automatically by Windows. You can remove programs you do 

not want listed, rearrange them, but not add any manually.

 All Programs displays a list of programs on your computer and is used to 

launch programs not listed on the Start menu.

 Below the left pane is the Search box which is used to locate programs 

and files on your computer.

 The right pane is also divided into three sections. It is used to select 

folders, files, and commands and to change settings. Use the icons at the 

bottom of the right pane to save your session, lock the computer, restart, 

switch users, and shut down.

Figure 2
Start menu

Pin area

Click to open All 
Programs

Power button

Lock button
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TABLE 3 Typical Components of the Start Menu

COMMAND USE

Left Pane

Pin area  Lists programs that are always available. You can add and 

delete items to the pin area.

Internet Connects to the default browser.

E-mail Connects to the chosen e-mail service.

Below the First Separator Line

Programs  Lists programs that you use most often. You can add to and 

rearrange the programs listed.

Below the Second Separator Line

All Programs  Click to display a list of programs in alphabetical order and a 

list of folders. Click to open a program.

Start Search  Use to search programs and folders. Key text and results 

appear.

Right Pane

Personal folder Opens the User folder.

Documents Opens the Documents folder.

Pictures Opens the Pictures folder.

Music Opens the Music folder.

Games Opens the Games folder.

Search  Opens the Search Results window. Advanced Search options 

are available.

Recent Items  Opens a list of the most recent documents you have opened 

and saved.

Computer  Opens a window where you can access disk drives and other 

hardware devices.

Network  Opens the Network window where you can access computers 

and other devices on your network.

Connect To  Opens a window where you can connect to a different 

network.

Control Panel Opens the Control Panel.

Default Programs  Opens the Default Programs window where you can define 

default programs and settings.

Help and Support  Opens the Windows Help and Support window. Help 

offers instructions on how to perform tasks in the Windows 

environment.

Power button Turns off the computer.

Lock button  Locks the computer, or click the arrow beside the Lock 

button to display a menu for switching users, logging off, 

restarting, or shutting down the computer.

Table 3 describes the typical components of the Start menu.

Using the All Programs Command
Most programs on your computer can be started from the All Programs 

command on the Start menu. This is the easiest way to open a program not 

listed directly on the Start menu.

 1. To open the All Programs menu, click the Start button. The Start menu 

appears.
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 2. Click All Programs or the triangle to the left near the bottom of the left 

pane. The All Programs menu appears, listing the programs installed on 

your computer. Every computer has a different list of programs. Notice 

that some menu entries have an icon to the left of the name and others 

display a folder. Click a folder, and a list of programs stored in that 

folder appears. Click a program to open it. Point to a program to see a 

short description of the program.

Figure 3
All Programs 

window

Program icons

Folder containing 
programs

Click to return to 
opening Start menu

 3. Click Microsoft Office to open a list of programs in the Microsoft 

Office folder. Click Microsoft Office Word 2007. (See Figure 3.) In a few 

seconds, the program you selected loads and the Word window appears. 

Notice that a button for the program appears on the taskbar. Leave 

Word open for the present.
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Customizing the Start Menu
Both the Start menu and the desktop can be customized. You can add 

shortcuts to the desktop if you prefer, and you can add and delete items 

from the Start menu. However, if your computer is used by others, the 

administrator may limit some customization functions.

 To add a program to the pin area of the Start menu:

 1. Select the program you want to add to the pin list from the All Programs 

menu, and right-click it. A shortcut menu appears.

 2. Click Pin To Start Menu on the shortcut menu. The program will be 

added to the pin list in the left pane above the first separator line.

 To remove a program from the pin area of the Start menu:

 1. Select the program you want to remove from the pin list, and right-click. 

A shortcut menu appears.

 2. Click Unpin From Start Menu. The program will be removed from the 

pin list.

 To change the order in which programs are listed in the pin area:

 1. Point to the program icon.

 2. Drag the icon to the desired position.

Using the Taskbar
The taskbar at the bottom of your screen is one of the most important features 

in Windows Vista. The taskbar is divided into several segments, each dedicated 

to a different use. It shows programs that are running, and you can use the 

taskbar to switch between open programs and between open documents within 

a program. If your computer has the Aero interface, a thumbnail preview 

appears when you move the mouse over a button on the taskbar.

Figure 4
The Desktop with 

the taskbar and the 
Word window

Active window
Microsoft Office Button

Word button on 
the taskbar



xxii Windows Tutorial

 Windows displays a button on the taskbar for each opened program and 

document. Notice that there is a button for Word, showing the Word icon 

and the name of the program. Point to the Word button to view a thumbnail 

of the document window. Since the taskbar can become crowded, Windows 

combines access to documents or programs under single buttons. The button 

shows the name of the program (Microsoft Office Word) and the number of 

items in the group (9). The shape of the arrow varies, depending on what the 

button contains. Clicking the button opens the menu of available items.

Figure 5
Button contents for 
Word documents

List of open documents in Word

Taskbar button to open Word program

Taskbar Notification Area
The notification area is on the right side of the taskbar, where the current 

time is usually displayed. Along with displaying the time, tiny icons notify 

you as to the status of your browser connection, virus protection, and so 

forth. It is also known as the system tray. In the interest of 

removing clutter, the notification area hides most of the 

icons. Clicking the Show Hidden Icons button  “hides” 

or “unhides” the icons in the notification area. Click 

the left-pointing arrow next to the icons to expand the 

notification area. Click the right-pointing arrow to hide 

the notification area.

The Active Window
The window in which you are working is called the active window. The 

title bar for the active window is highlighted, and its taskbar button is also 

highlighted. The program window for Microsoft Word that you opened 

earlier should still be open. To examine additional features of the taskbar, 

open a second program, Microsoft Excel, a spreadsheet program in Microsoft 

Office.

 1. If Word is not open, click the Start button and then click All Programs, 

Microsoft Office, Microsoft Office Word 2007 from the Start menu. The 

Word window displays.

 2. Click the Start button and then click All Programs, Microsoft Office, 

Microsoft Office Excel 2007 from the Start menu. The Excel window 

displays. Notice how the Excel window covers the Word window, 

indicating that the window containing Excel is now active. Notice, too, 

that a new button for Excel has been added to the taskbar.

TIP

If you are not sure of what an item is 
or does, pointing to it without clicking 

displays a ScreenTip with a short 
description.
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 3. Click the button on the taskbar for Word, the first program you opened. 

Word reappears in front of Excel. Notice the change in the appearance 

of the title bar for each program.

 4. Click the button on the taskbar for Excel. Notice that you switch back to 

Excel.

 5. Click the button on the taskbar to return to Word.

 6. Locate the Quick Launch toolbar to the right of the Start button, and 

point to the Switch between windows button .

 7. Click the Switch between windows button, and notice the desktop view.

 8. Click the Excel window.

Changing the Size of the Taskbar
You can change the size of the taskbar using your mouse if your toolbar is 

crowded. It is usually not necessary, because of the multiple document style 

buttons and other hide/unhide arrows on the taskbar. Before you can change 

the size of the taskbar, it may be necessary for you to unlock it. To unlock the 

taskbar, right-click an open area of the taskbar and click Lock the Taskbar to 

remove the checkmark. A checkmark is a toggle command. Click to turn it 

off, and click a second time to turn it on.

 1. Move the pointer to the top edge of the taskbar until it changes from a 

pointer to a two-pointed arrow . Using the two-pointed arrow, you 

can change the size of the taskbar.

Figure 6
Excel (the active 

window) covering 
the Word window

The Excel window is now 
the active window

Quick Launch toolbar Taskbar button for 
open Excel program

Active title bar

Word window
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 2.  With the pointer displayed as a two-pointed arrow, hold down the left 

mouse button and move the arrow up until the taskbar enlarges upward.

 3.  Move the pointer to the top edge of the taskbar once again until the two-

pointed arrow displays. Hold down the left mouse button, and move the 

arrow down to the bottom of the screen. The taskbar is restored to its 

original size.

Using Menus
Windows uses a system of menus that contain a choice of options for working 

with programs and documents. Most Windows programs use a similar menu 

structure. These operations are either mouse or keyboard driven. They are 

called commands because they “command” the computer to perform functions 

needed to complete the task you, the user, initiate at the menu level.

Executing a Command from a Menu
In Windows, a program may display a menu bar, a row of descriptive menu 

names at the top, just below the title bar. You open a menu by clicking the 

menu name listed in the menu bar. When a menu is opened, a list of command 

options appears. To execute a particular command from an open menu, press 

the left mouse button and then drag down and release the chosen option 

(click and drag). You can also click the command once the menu is open.

Keyboard Menu Commands
For people who prefer to use the keyboard to a mouse, Windows has provided 

keyboard commands for many menu items. You can use the keyboard to 

open menus and choose menu options.

 Some menu items include not only the name of the command but a 

combination of keyboard keys. For example, under the File menu in WordPad, 

the Save command contains the notation Ctrl ⫹ S  to its right. This means that 

you can also execute the command by pressing the Ctrl  key together with the S

key to save a document.

Other Menu Symbols
Three dots following a menu option indicate that a dialog box is displayed 

when that menu option is chosen. (Dialog boxes, discussed later, are small 

windows requesting and receiving input from a user.) Some commands 

also display a check box. Click an empty check box to select the option. A 

checkmark will appear in the square and indicates the option is selected. To 

turn off the option, click the check box to remove the checkmark. Commands 

that appear gray or dimmed are currently not available.

Figure 7
Title and menu bars 
with the File menu 

Open

Command with three 
dots opens a dialog box

Command name

Keyboard shortcut

Menu bar
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Perform the following steps for keyboard command practice:

 1.  Open the Start menu, click All Programs, and click the Accessories folder. 

Click WordPad. The WordPad program opens, and a button appears on 

the Windows taskbar.

 2. Click File in the menu bar. The File menu displays. Click File to close the 

menu.

 3. Press Alt , and notice that the items in the menu bar display underlined 

letters (File, Edit). The underlined letters are a shortcut to open a menu. 

Press the letter “f” to open the File menu. Release Alt , and click outside 

the menu in a blank area to close the menu.

 4. Press Alt⫹ V , the keyboard shortcut for the View menu. The View menu 

displays.

 5. Notice the four check boxes. All are selected. Click the Options 

command. The Options dialog box opens.

 6. Click Cancel to close the dialog box.

 7. Click File in the menu bar. Click Exit. Click Don’t Save if prompted to save 

the document.

Displaying a Shortcut Menu
When the mouse pointer is on an object or an area of the Windows desktop 

and you right-click, a shortcut menu appears. A shortcut menu typically 

contains commands that are useful in working with the object or area of the 

desktop to which you are currently pointing.

 1.  Position the mouse pointer on a blank area of the desktop, and right-click. 

A shortcut menu appears with commands that relate to the desktop, 

including view and sort options.

 2. Click outside the shortcut menu to close it.

 3. Right-click the time in the bottom right corner of the taskbar. A shortcut 

menu appears.

 4. Click Adjust Date/Time on the shortcut menu. The Date/Time Properties 

dialog box appears. You can use this dialog box to adjust your 

computer’s date and time.

Figure 8
The Time shortcut 

menu
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 5. Click Cancel.

 6. Right-click an icon on the desktop to display its shortcut menu, and 

then close the shortcut menu.

Using the Ribbon
Microsoft Office 2007 applications include a Microsoft Office Button, a Quick 

Access Toolbar, and a Ribbon. The Microsoft Office Button displays the Office 

menu which lists the commands to create, open, save, and print a document. 

The Quick Access Toolbar contains frequently used commands and is positioned 

to the right of the Microsoft Office Button. The Ribbon consists of seven tabs 

by default, and each tab contains a group of related commands. The number 

of commands for each tab varies. A command can be one of several formats. 

The most popular formats include buttons and drop-down lists.

NOTE

A keyboard shortcut is available for the 
print dialog box: Press Ctrl ⫹ P  to open 

the Print dialog box.

Microsoft Office Button

Ribbon

Quick Access 
Toolbar Groups Tabs

 1. Activate the Excel program.

 2. Point to and click the Microsoft Office Button. Notice the commands and 

icons in the menu.

 3. Click a blank area of the window to close the menu.

 4. Locate the Quick Access Toolbar beside the Microsoft Office Button. 

Point to each button in the Quick Access Toolbar to identify it. Notice 

that a keyboard shortcut displays beside each button.

 5. Click the Page Layout tab. Notice the change in the groups and commands.

 6.  Click the Home tab.

Using Dialog Boxes
Windows programs make frequent use of dialog boxes. A dialog box is a 

window that requests input from you related to a command you have chosen. 

All Windows programs use a common dialog box structure.

 1. Click the Excel program button on the taskbar to make Excel the active 

window if necessary.

 2.  Click the Microsoft Office Button. The File menu 

displays.

 3. Click Print to display the Print dialog box.

 4.  The Print dialog box contains several types of dialog 

box options.
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 5. To close the Print dialog box, click Cancel, located in the lower right 

corner of the dialog box. The Print dialog box closes without applying 

any changes.

 Another type of dialog box uses tabs to display related options. Only one 

tab can display at a time. The Word Font dialog box offers many options for 

choosing character formatting.

 1. Make Word the active window.

 2. Click the Home tab, and click the small arrow that appears on the right 

of the Font group . The Font dialog box displays.

Figure 10
Print dialog box in 

Excel

Title bar. 
Drag to move box

Drop-down list box. 
Click arrow for more options

Option buttons.
Only one in a group can 

be selected

Text box.
Key text or click

OK command button.
Click to accept specified 
changes in dialog box

Help button.
Click for Help with dialog 

box options

Close button

Cancel command button.
Click to close without 

 applying changes

Check box.
Click to select or deselect

Figure 11
Font dialog box

List box.
Scroll to display; 

click to select

Tabs.
Click to display 

options

Scroll box.
Drag to scroll

Scroll bar.
Use to move up or down 

in a list box

Vertical scroll arrows.
Click to scroll up or down
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 The scroll boxes are used to specify a font by name, its style, and its 

size. When you select a paragraph in a Word document, you can select its 

typographic features using this dialog box. The Font list box at the top left 

displays a list of all the typefaces installed on your computer. By clicking the 

name of the font, you select it for your paragraph.

 The vertical scroll bar on the right side of a list box or a window indicates 

that there is more content to view. To view the hidden content, click the 

downward-pointing arrow or the upward-pointing vertical scroll arrow. You 

can also drag the scroll box on the scroll bar up or down to view all the 

content. The Character Spacing tab at the top of the Font dialog box displays 

additional character formatting options. Click the Character Spacing tab to 

view its contents, and then return to the Font tab.

 Use the Font dialog box to style a paragraph as follows:

 1. Type a very short paragraph in your Word document.

 2. Position the I-beam at the beginning of the text, and hold down the left 

mouse button.

 3. Drag the mouse to the end of the paragraph. The paragraph will change 

color, showing that it has been selected.

 4. Open the Font dialog box by pressing Ctrl ⫹ D .

 5. In the Font list box, click Verdana. You may need to scroll down to 

locate it.

 6. In the Font style box, click Bold.

 7. In the Size box, click 12.

 8. If you wish to change the color of your paragraph, move your pointer 

to the Font color drop-down list box and click the down-facing arrow. A 

color pallet appears. Point to the color you wish to use, and click.

 9. When you have completed your selections, click OK at the bottom of the 

Font dialog box and look at the paragraph you have styled. If you wish, 

you can try other font formats, while your paragraph is selected.

Changing the Size of a Window
You can change the size of any window using either the mouse or the sizing 

buttons. Sizing buttons are the small buttons on the right side of the title bar 

that allow you to minimize or maximize the window (see 

Figure 12). This can be especially useful when you would 

like to display several open windows on your desktop and 

see them simultaneously.

 1.   Make Excel the active window, if it is not already. Click 

the Maximize button on the Excel title bar if the Excel 

window does not fill the entire desktop.

Minimize Maximize

CloseFigure 12
Sizing buttons

NOTE

Notice that the window occupies the 
entire desktop, and the Maximize button 
has changed to a Restore Down button. 

This type of function is known as a 
toggle: When a button representing one 
state (Maximize) is clicked, an action is 
performed, the button toggles to the 
alternate state, and the other button 
(Restore Down) appears. A number of 
actions in Windows operate this way.
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TABLE 4 Sizing Buttons

BUTTON USE

Minimize Reduces the window to a button on the taskbar.

Maximize  Enlarges the window to fill the entire desktop (appears 

only when a window is reduced).

Restore Down  Returns the window to its previous size and desktop 

position (appears only when a window is maximized).

 2.  Click the Restore Down button on the Excel title bar. 

The Excel window reduces in size, and the Word 

window appears behind it. The Restore Down button 

has now changed to a Maximize button. Notice that 

the highlighted title bar of the Excel window indicates 

it is the active window.

 3.  Click the Minimize button. The Excel window 

disappears, and its button appears on the taskbar.

How to Display Two Program Windows 
Simultaneously
 1.  Open the Start menu, and click All Programs to open Excel and Word if 

they are not already open from an earlier section of the tutorial.

 2.  Click the Excel button on the taskbar to move its 

window to the front of the screen.

 3.  Click the Restore Down button if the Excel window is 

maximized.

 4.  Move the pointer to the right border of the Excel 

window. The pointer changes to a horizontal 

two-pointed arrow.

 5.  With the two-pointed arrow displayed , drag the 

border to the left to make the window narrower.

NOTE

You can double-click a window title bar to 
maximize or restore the window or 

right-click the program button on the 
taskbar and choose minimize, maximize, 

restore, or close.

TIP

Sometimes the borders of a window can 
move off the computer screen. If you 

are having trouble with one border of a 
window, try another border or drag the 
entire window onto the screen by using 

the title bar.

 Table 4 describes these buttons. To practice changing the size of a 

window, follow these steps:
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 6.  Click the title bar or any part of the Word window 

behind the Excel window. The Word window becomes 

the active window. The Excel window is still open, but 

it is now behind the Word window.

 7.  Click the Maximize button if the Word window does 

not fill the entire desktop.

 8.  Click the Minimize button on the title bar of the 

Word window. The Excel window becomes the active 

window.

 9.  Make the Word window the active window by clicking 

the Word button on the taskbar.

 10. Click the Restore Down button on the Word window. The Word window 

reduces in size. The Excel window might be partially visible behind the 

Word window. You can drag the two reduced windows so that parts of 

both can be seen simultaneously.

11.  Right-click the taskbar, and click Show Windows Side 
by Side. The windows display vertically.

12.  Press the Alt  key, and hold it down while pressing Tab . 

You can switch to the previous window by pressing this 

shortcut, or you can continue to press Tab  to switch to 

an open window on the desktop.

 13. Click the Show Desktop button  located on the Quick Launch toolbar 

to see the desktop. The Word and Excel programs are minimized.

 14. Click the Show Desktop button again to restore the programs.

 15. Click the Close buttons on the title bars of each of the two program 

windows to close them and to show the desktop.

Figure 13
Sizing a window

Two-pointed 
sizing arrow

NOTE

The taskbar contains options to Show 
Windows Stacked, Cascade Windows, and 

Show the Desktop.

NOTE

You can place the pointer on any part of 
the window border to change its size. To 
change both the height and width of the 
window, move the pointer to the bottom 
right corner of the window. The double-

pointed arrow changes its orientation 
to a 45-degree angle (see Figure 13). 
Dragging this arrow resizes a window 

vertically and horizontally.
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Using the Documents Command
Windows lets you open a recently used document by using the Recent Items 

command on the Start menu. This command allows you to open one of up to 

fifteen documents previously saved on your computer.

 1. Click the Start button on the taskbar to display the Start menu.

 2. Click Recent Items. The Recent Items submenu appears, showing you up 

to the last fifteen documents that were saved.

 3. Click a document. The program in which the document was created 

opens, and the document displays. For example, if the document you 

chose is a Word document, Word opens and the document appears in a 

Word program window.

 4. Click the program window’s Close button. The program window closes, 

and the desktop is clear once again.

Changing the Desktop
The Control Panel lets you change the way Windows looks and works. Because 

your computer in school is used by other students, you should be very careful 

when changing settings. Others might expect Windows to look and work the 

standard way. Having Windows look or work in a nonstandard way could 

easily confuse other users. (Table 5 describes how to access other settings.)

 To change the appearance of your computer, follow these steps. Talk to 

your instructor first, however, before changing any settings on your computer.

 1. Click the Start button on the taskbar.

 2. Click Control Panel on the right pane. The Control Panel window displays.

 3. Click the Appearance and Personalization link. The Appearance and 

Personalization window displays.

 4. Click Personalization and click Window Color and Appearance.

 5. Click Default and click OK.

 6. Close the Appearance and Personalization window.

 

TABLE 5 Setting Options

OPTION USE

Control Panel  Displays the Control Panel window, which lets you change 

background color, add or remove programs, change the date and 

time, and change other settings for your hardware and software. 

The items listed below are accessed from the Control Panel.

Network  Includes options to view the network status, connect to a 

and Internet  network, set up file sharing, change Internet options, and so on.

Hardware  Includes options to add a printer, change default settings 

and Sound  for AutoPlay, sound, mouse settings, keyboard, and so on.

Appearance and Includes options to change the desktop background, adjust 

Personalization   screen resolution, customize the Start menu and icons on the 

taskbar, and change sidebar properties.



xxxii Windows Tutorial

Using the Search Command
If you do not know where a file or folder is located, you can use the Search 

command on the Start menu to help you find and open it.

 1. Click the Start button on the taskbar. Notice the blinking insertion point 

in the Start Search box. You can start typing the name of a program, 

folder, or file immediately.

 2. Click Search in the right pane of the Start menu. The Search Results 

dialog box appears.

 3. Click Document in the Show Only section.

Figure 14
Search Results 

dialog box

Key file or 
folder name

 4. Type the name of the file or folder you want to find in the Search box. 

View the search results.

 To search for files by date, size, type, or other attributes, click Advanced 
Search.

 1. Click the arrow to the left of the Search Results text box to specify where 

you want Windows to search. The default location is the C drive.

 2. Click Search to start the search. Any matches for the file are shown in 

the right pane of the dialog box.

 3. Double-click any found item to open the program and view the file or 

folder Windows has located.

 4. When you are finished with your search, close all open windows and 

clear your desktop.
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Using the Run Command
Windows allows you to start a program by using the Run command and 

typing the program name. This command is often employed to run a “setup” 

or “install” program that installs a new program on your computer. It is best 

to use this command after you have become more familiar with Windows 

Vista.

 1. Click the Start button on the taskbar.

 2. Click All Programs, and click the Accessories folder.

 3. Click Run.

Figure 15
Run dialog box

 4. If you know the name of a program you want to run, type the name in 

the Open text box. Often you will need to click Browse to open a  

drop-down list of the disk drives, folders, and files available to you.

 5. Click Cancel to close the Run dialog box.

 6.  Open the Start menu, and locate the Start Search box.

 7. Key run, and notice that the Start menu displays the Run program.

 8.  Click the program name, and the Run dialog box displays.

 9. Close the Run dialog box.

Deleting Files Using the Recycle Bin
The Recycle Bin is the trash can icon on your desktop. To delete a file:

 1. Click its icon, and drag it to the Recycle Bin.

 2.  Double-click the Recycle Bin icon. A window opens 

listing files you have deleted.

 3.  To undelete a file, merely drag it out of the Recycle Bin 

window and place it on the desktop or right-click the 

file and click Restore.

 4. To empty the Recycle Bin and permanently delete files, click Empty 

Recycle Bin in the Recycle Bin dialog box, or right-click the Recycle Bin 

icon. The shortcut menu appears.

 5. Click Empty Recycle Bin.

NOTE

As a protection against deleting a file 
unintentionally, any file you have placed 
in the Recycle Bin can be undeleted and 

used again.



Exiting Windows
You should always exit any open programs and Windows before turning off 

the computer. This is the best way to be sure your work is saved. Windows 

also performs other “housekeeping” routines that ensure everything is ready 

for you when you next turn on your computer. Failure to shut down properly 

will often force Windows to perform time-consuming system checks the next 

time it is loaded. You can either log off the computer to make it available for 

another user, or shut it down entirely.

To Log Off
 1. Click the Start button on the taskbar.

 2. Click the arrow to the right of the Lock this computer button , 

and click Log Off.

To Shut Down
To exit Windows, use the Lock this computer command on the Start menu. 

This command has several shut-down options.

• Restart: Restarts the computer without shutting off the power. This is 

sometimes necessary when you add new software.

• Shut down: Closes all open programs and makes it safe to turn off the 

computer. Some computers will turn off the power automatically.

• Sleep: Puts the computer in a low-activity state. It appears to be turned 

off but will restart when the mouse is moved. Press the computer power 

button to resume work.

 1. Click the Start button on the taskbar.

 2. Click the arrow beside the Lock this computer button.

 3. Click the Shut Down option.

 4. Windows prompts you to save changes in any open documents. It then 

prepares the computer to be shut down.
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case study

There is more to learning an e-mail messaging client and time and management 

program like Microsoft Outlook than simply writing and replying to e-mail mes-

sages. Not only do you need to understand how to use Outlook’s e-mail feature, 

but you need to know how to use all the integrated features of Outlook in a real-

world situation. That’s why all these lessons relate to everyday business situations.

 As you work through the lessons, imagine yourself working as an intern for 

AllWood Mills, Inc., a furniture manufacturer based in Dubuque, Iowa.

AllWood Mills, Inc.
Starting with a table saw in his garage, Rob Connelly has grown his furniture-

making hobby into a chain of six retail furniture stores in five Midwestern 

states. Even as a teenager, Rob spent much of his free time building tables, 

desks, and bookcases. He continued his hobby through his college years, and 

he eventually left medical school to pursue his passion for making furniture. 

His period designs and attention to fine detail created a demand for his furni-

ture that stretched far beyond his first modest storefront in Dubuque, Iowa.

 AllWood Mills designs, manufactures, and sells custom-made furniture. 

As reflected in their name, AllWood makes only wood furniture.

 AllWood sells furniture for the bedroom, living room, and dining room. 

They also sell products for computer and media storage. Their furniture is 

available in four different styles: Mission, Shaker, Colonial, and Contemporary. 

In keeping with Rob’s earliest pieces, each AllWood product is individually 

crafted in the style of a fine antique. Over the years, AllWood has found great 

favor with customers who want hand-crafted furniture at affordable prices.

 In addition to their Dubuque store, AllWood also has retail outlets in 

Chicago, Minneapolis, Milwaukee, St. Louis, and Kansas City. AllWood’s 

strategy is to locate a retail outlet in a major metropolitan center because 

the company expects to draw most of its customers from an area within 

150 miles of its retail outlet. AllWood’s headquarters and manufacturing 

facility is located in Dubuque, a central location for the other retail outlets.

AllWood Mills, Inc. and You
In your work as an intern at AllWood, Inc., you will have a chance to meet 

many of the people who work at AllWood.

 All of the work you do with Microsoft Outlook in this course will relate 

to AllWood, Inc. You will also discover that your work in this course will 

involve e-mails sent to, and received from, your fellow classmates. For the 

purpose of this class, treat your classmates as interns at AllWood. As you 

work through the course, take the time to notice the following things:

• The types of e-mail and Outlook tasks required in a small business to 

carry on day-to-day business
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• The format and tone used for e-mail (see the “Guidelines for Using 

E-mail” on the next page)

• The types of business that are appropriately conducted using e-mail

• The way that a business can increase efficiency by using the integration 

available between the various Outlook components

 As you use this text and become more experienced with Microsoft 

Outlook, you will also gain an understanding of how small businesses actu-

ally use the integrated components of Microsoft Outlook.
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After completing this lesson, you will be able to:

1. Start Outlook and identify parts of the Outlook window.

2. Create, send, and reply to an e-mail message.

3. Manage e-mail message attachments.

4. View and print e-mail messages and close Outlook.

MCAS OBJECTIVES

In this lesson:

OL07 1.1.1

OL07 1.1.2

OL07 1.1.3

OL07 1.1.4

OL07 1.3.1

OL07 1.3.2

OL07 1.3.3

OL07 1.3.4

OL07 1.7.1

OL07 1.7.2

OBJECTIVES

Lesson 1

Introduction to 

Outlook and E-mail

OL1.1

Microsoft describes Office Outlook 2007 as a messaging client that is also 

a complete time and information manager. In this lesson you begin your 

work by becoming familiar with the Outlook environment. Then you learn 

how to send and receive e-mail messages, how to handle e-mail message 

attachments, and how to view and print e-mail messages.

Starting Outlook and Identifying Parts 
of the Outlook Window
There are several ways to start Outlook, depending on your system setup and 

personal preferences. You can use the Start button on the Windows taskbar, 

click the Outlook button on the Quick Launch toolbar , or double-click the 

Outlook shortcut  that might be on the desktop.

After you’ve started Outlook, you can familiarize yourself with the 

program’s environment and learn how to use the various controls it offers.

Exercise 1-1 START OUTLOOK

You can start Outlook by using the Start menu or by clicking an icon on the 

Windows desktop or on the Quick Launch toolbar.

 1. If necessary, turn on your computer and log on to your account.

 2. Click the Start button  on the taskbar and hover over All Programs.

 Estimated Time: 11/2 hours
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Figure 1-1
Starting Outlook 

from the Windows 
taskbar

 3.  Click Microsoft Office and then click Microsoft Office 

Outlook 2007. After a few moments the program will 

load and the Outlook window will appear.

 4. Maximize the window to fill the screen if necessary.

 5. Click the File menu and select Print.

Figure 1-2
Parts of the Outlook 

environment

NOTE

Your Outlook window may look different 
than the one in Figure 1-2. Your 

environment preferences are preserved by 
Outlook for the appearance of elements 
such as the Navigation pane and To-Do 

bar from session to session.
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Exercise 1-2  NAVIGATE IN OUTLOOK BY USING 
THE NAVIGATION PANE

Like most programs, Outlook offers a variety of 

menus and toolbars you can use to accomplish 

tasks. The Navigation pane is the primary tool 

in Outlook for switching between the program’s 

different components: Mail, Calendar, Contacts, 

Tasks, and others. The Navigation pane also 

provides access to different views and other 

features for each component.

 1.  If the Navigation pane is not displayed, 

you can display it by choosing View 

from the menu bar, then hover over 

Navigation Pane and choose Normal from 

the cascading menu. The Navigation 

pane appears as a column on the far left 

side of the Outlook window.

 2.  In Normal view, the Navigation pane 

displays a list of folders, views, or 

features for the current program 

component. To display the Navigation 

pane in minimized view, click the 

chevrons  at the top of the Navigation 

pane to minimize the pane to a narrow 

bar running down the left of the 

window. We will refer to this minimized 

view as the Navigation bar.

 3.  On the Navigation bar click the 

Navigation Pane tab. This temporarily 

opens the special features for the 

program component you are currently 

using. Click the chevrons on the 

Navigation Pane tab to return to the full 

Navigation bar.

 4.  Click the Calendar button  to display 

Outlook’s calendar component.

 5.  Click the Contacts button  to display Outlook’s 

contacts component. This view is likely empty at 

this time since you haven’t created any contacts.

 6.  Click the Tasks button  to display Outlook’s task 

tracking, or to-do, component. This view is likely 

also empty since you haven’t created any tasks.

Figure 1-3
Navigation pane in 

Normal view

TIP

The appearance of the Navigation pane 
can also be fully controlled from the 

View menu. Alternatively, you can use 
the keyboard shortcut Alt ⫹ F1  to cycle 

through the available settings.
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 7.  Click the Mail button  to return to the mail component of 

Outlook. By default this view displays a central pane for 

your Inbox, which is where new messages are displayed, and 

a pane to the right that displays the contents of the currently 

selected message.

 8.  Click the Navigation Pane tab to display the folder list. This 

list allows you to move from viewing your Inbox to other 

folders containing mail items. You can create additional 

folders as needed.

 9.  Click the chevrons on the Navigation Pane tab again to return 

to the Navigation bar.

Creating, Sending, and Replying 
to an E-mail Message
To send an e-mail message to someone, all you need is their 

address. An Internet e-mail address consists of the user’s name, the 

@ symbol (known as the “at” sign), and their domain name. The 

domain name consists of two or more parts, with periods between 

them, that identify the name of the server or servers that process 

the mail. Thus, a complete e-mail address may look something like: 

allwoodmills@gmail.com.

When sending e-mail messages, it is possible to send the message 

to more than one recipient and/or send copies of the messages to 

others. If necessary, messages that have already been sent can be 

resent, either to the original recipients or to new addresses.

When you receive messages, you can choose to reply to the 

sender, or to the sender and everyone else who received the message. 

You can also choose to forward the message to someone else.

Exercise 1-3 SEND AN E-MAIL MESSAGE

There are several ways to begin the process of sending an e-mail message in 

Outlook. You can:

• Press Ctrl ⫹ N  while viewing the Inbox.

• Press Ctrl ⫹ Shift ⫹M  while viewing any part of Outlook.

• Click the New button while viewing the Inbox.

•  Choose Mail Message from the drop-down list of the 

New button.

Figure 1-4
Navigation pane 

minimized to show 
the Navigation bar

NOTE

The New button creates a new object 
appropriate to the current component of 
Outlook you are using. When you’re using 

the calendar, the New button creates a 
new appointment. When you’re using the 

Inbox, it creates a new mail message.
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 1.  Verify that you are viewing the Inbox. Click the New button  

on the Standard toolbar. The blank e-mail message form opens.

 2.  In the To text box, key an e-mail address for the intended recipient. 

Be sure not to use any spaces.

 3.  Key a ; and type the address for a second recipient. 

When keying multiple addresses, use a semicolon to 

separate them.

 4.  Move to the Cc text box by pressing Tab . 

Addressees in this box will receive a copy of the 

message. Both the addresses in the To text box and 

the addresses in the Cc text box will be displayed 

to the message recipients. Leave this text box 

blank at this time.

 5.  By default, Outlook does not display the Bcc text 

box. Bcc is used to send copies of the message to 

recipients without revealing their addresses to those 

who receive the message. To turn the Bcc box on for 

this and future messages, click the Options tab 

above the Ribbon. Click the Show Bcc option on the 

Ribbon to display the Bcc text box.

NOTE

Your instructor will provide you with a list 
of e-mail addresses to be used with the 

exercises in this text.

NOTE

The Ribbon appears when you’re creating 
new items in Outlook. It is a replacement 
for menus and toolbars meant to give you 

easier access to program functions and 
features. In Outlook the Ribbon is only 
used when creating new items, such as 
new e-mails, contacts, or appointments.

Figure 1-5
E-mail message form 

with Bcc text box 
displayed



LESSON 1 Introduction to Outlook and E-mail
O

u
tlo

o
k
 2

0
0
7

7

 6. Click the Message tab above the Ribbon. Move to the Bcc text box by 

pressing Tab .

 7. Enter your own e-mail address in the Bcc text box.

 8. Press Tab  to move to the Subject text box.

 9. Key Sales Update for Last Month. Press Tab  to move to the body of the 

message.

 10. Key the text shown in Figure 1-6.

Figure 1-6

 11. Proofread your message and double-check the accuracy of the e-mail 

addresses you entered in the To and Cc text boxes.

 12. Click the Send button  to the left of the address text boxes. The 

message form will close and Outlook will return to the Inbox.

13.  The time it takes for your copy of the message to appear in your 

Inbox is dependent on your Internet service provider’s (ISP’s) mail 

server and other factors. When the message arrives, Outlook has 

several different methods of letting you know. 

Depending on your settings Outlook may play a sound, 

briefly change the mouse pointer, display an envelope 

icon in the notification area on the taskbar (near the 

time), and/or display a notification directly on the 

desktop. By default all of these settings are enabled.

Exercise 1-4 RESEND AN E-MAIL MESSAGE

E-mail messages you have sent using Outlook are stored in a folder called 

Sent Items. From this folder it is easy to review the content of past messages. 

You can also resend messages from here, either to the original recipients, or 

someone new.

 1. Click the Navigation Pane area on the Navigation bar.

 2. Click Sent Items in the list of Mail Folders.

 3.  Locate the message you sent in Exercise 1-3 and 

double-click it to open it.

NOTE

Outlook’s default setting is to send e-mail 
messages immediately when connected 

to the Internet.

NOTE

It is necessary to open a message in order 
to resend it.
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 4. Click Other Actions on the Ribbon and choose Resend This Message 

from the cascading menu.

 5.  A message form opens containing everything that was in your 

original message except the contents of the To text box. At this point, 

if you were going to resend the message, you would fill in the 

appropriate addresses and then click Send. Do not click Send at this 

time. Instead, close the message form by clicking the close button .

Exercise 1-5 RESPOND TO AN E-MAIL MESSAGE

There are several ways to respond to a received e-mail message. You can 

use:

• Reply, which sends a message back to the original sender.

• Reply to All, which sends a message back to the original sender and 

everyone else who received the message.

• Forward, which allows you to send the message on to a new recipient.

With each of these three options, the content of the original message is placed 

in the body of the new message with header information that includes who 

sent the original, when it was sent, and the subject line. You can edit all 

of this information, allowing you to remove anything that isn’t pertinent to 

your response. You can also add your own comments at the 

top of the message.

While the actual process for responding to a message 

is very simple, regardless of the type of response, it is very 

important to understand the difference between Reply and 

Reply to All. With Reply to All you will be sending your 

response to everyone who received the original message. 

This could include hundreds, if not thousands, of recipients. 

Additionally, because of the Bcc addresses, you may not 

even know who you are sending your response to! Because 

of this you should be very cautious when using Reply to All.

TIP

Reserve the use of the Reply to All 
feature for those times when you are 

absolutely sure about who received the 
original message and you actually want all 
recipients to read your reply. This feature 

can be useful in carrying on a sort of 
group discussion via e-mail.

TABLE 1-1 Options for Responding to an E-mail

Button Shortcut Purpose

 Ctrl ⫹ R  Reply to sender

 Ctrl ⫹ Shift ⫹ R  Reply to sender and all original recipients

 Ctrl ⫹ F  Send message to new recipient
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 1.  Display the Inbox by clicking Inbox on the 

minimized Navigation bar.

 2.  Locate the “Sales Update for Last Month” message 

you sent to yourself via Bcc in Exercise 1-3. If the 

message is not in the Inbox yet, click the Send/

Receive button  on the Standard toolbar 

to force Outlook to check for new messages. The 

keyboard shortcut for forcing Outlook to do a Send/

Receive is F9 .

 3.  Click the message to select it in the Inbox. It is not 

necessary to open messages to reply to them or 

forward them, although you can perform these 

operations from an open message.

 4.  Click the Forward button  on the Standard 

toolbar. A new message form opens with the original 

message headers and content beneath a horizontal 

line in the message body area. The original subject 

line appears in the Subject text box with “FW:” in 

front of it.

 5.  Enter an address to forward this message to in the 

To text box. Your instructor will provide this 

address.

 6.  Click in the message body area and key Please make 

sure that newly hired supervisors follow up on this 

with their employees.

 7.  Proofread the e-mail address and the text you just 

keyed. Click the Send button .

Managing E-mail Message Attachments
Sending files attached to an e-mail message is a common way of exchanging 

data, documents, and other types of information. Although there are some 

file types that are not supported, due to the risk of viruses 

or other malicious code, the vast majority of files can be 

attached and sent with messages easily.

When you receive a message with a file attachment, 

you have several choices. You can preview the attachment 

while viewing the message, you can open the attachment 

directly, or you can save the attachment to a location on 

your computer.

TIP

Messages you haven’t read yet are 
displayed in the Inbox in bold with a 
closed-envelope icon. Messages you 
have read are not bold and have an 

open-envelope icon. Additionally, the 
number of unread messages appears in 
parentheses next to the Inbox button on 
the Navigation pane or Navigation bar.

NOTE

Both Reply and Reply to All add the text 
“RE:” in front of the original message 
subject. In all cases you may edit the 

subject line, including removal of the new 
prefixes.

NOTE

If the message is still not in your 
Inbox after the Send/Receive process 

is complete, see your instructor for 
assistance.

TIP

Be very careful about opening 
attachments directly. You should only 

do so when the attachment not only has 
come from someone you trust, but also is 

something you were expecting.
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Exercise 1-6  ATTACH A FILE TO AN E-MAIL 
MESSAGE

 1.  Click the New button  to begin a new message.

 2. Key your own e-mail address in the To text box.

 3.  Key the subject Fall Catalog Cover in the Subject text 

box.

 4.  In the message body key John, and then hit Enter  

twice to insert a blank line and start a new 

paragraph.

 5. Key Please take a look at this picture and let me know if you think it 

would be a good choice for the cover of our Fall catalog.

 6. Click the Attach File button .

 7. When the Insert File dialog box opens, click Pictures under the 

Favorite Links pane.

 8. Locate the Sample Pictures folder in the right pane of the dialog box 

and double-click it to open it.

 9. Locate the picture Autumn Leaves and double-click it to attach it to 

the message.

 10. Right-click the attached file where it appears in the Attached text box. 

Note the ability to remove the attachment. This is useful if you 

inadvertently atta ch the wrong file. It is also useful when forwarding a 

message that contains an attachment, if you do not 

wish to send the attachment to the new recipient.

11.  Proofread your address and the body of your 

message. Verify that the Attached text box contains 

Autumn Leaves.jpg.

12. Click the Send button .

Exercise 1-7 PREVIEW AND OPEN AN ATTACHMENT

 1.  Locate the “Fall Catalog Cover” message you sent to 

yourself in Exercise 1-6. If the message is not in the 

Inbox yet, click the Send/Receive button  

on the Standard toolbar to force Outlook to check 

for new messages.

 2. Double-click the message to open it.

NOTE

Messages that contain attachments are 
displayed in the Inbox with a paper-clip 

icon.

TIP

You can forward messages as 
attachments. Choose Action, Forward as 

Attachment, or press Ctrl ⫹ Alt ⫹ F .

NOTE

If the message is still not in your 
Inbox after the Send/Receive process 

is complete, see your instructor for 
assistance.
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 3. To preview the attachment, click the button above the message body 

labeled Autumn Leaves.jpg. The image will appear in place of the 

message body.

 4. To return to the message, click the button labeled Message.

 5. To open the attachment, double-click the Autumn Leaves.jpg button. 

This will open the image in Windows Photo Gallery (or other 

software, if your computer is so configured).

 6.  Close the Windows Photo Gallery window (or the 

window of whatever program opened to display the 

picture). 

 7.  Right-click the Autumn Leaves.jpg button. Note the 

options that are available. Leave the message open 

for the next exercise.

Exercise 1-8 SAVE AN ATTACHMENT

Saving an attachment to a specified location on your computer is usually the 

best approach. This ensures that you will be able to find the file later when 

you need it.

Figure 1-7
E-mail message with 

attachment

TIP

Attachments can also be previewed, 
opened, and saved via the Reading pane, 
which appears by default to the right of 

the Inbox pane.
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 1. Right-click the Autumn Leaves.jpg button and choose Save As.

 2. The Save Attachment dialog box defaults to your Documents folder. 

Key Fall Cover.jpg in the File name text box.

 3. Click the Save button.

 4. Close the e-mail message.

Viewing and Printing E-mail Messages
By default, Outlook places the Reading pane to the right of the Inbox to 

facilitate the reading of messages without opening them. However, some 

users prefer to have the Reading pane placed at the bottom of the window 

or turned off entirely. When the Reading pane is turned off, 

Outlook provides a method to see a short preview of each 

message within the Inbox pane itself.

Outlook also provides several ways of organizing 

the Inbox, and other mail folder, displays, including 

your choice of how to sort and/or group your messages. 

Additionally, if you would like to keep a hard copy of your 

e-mail communications, Outlook allows you to print either 

individual messages or a listing of the messages contained 

in the current mail folder.

Exercise 1-9 CONTROL THE READING PANE

 You can resize, move, or hide the Reading pane.

 1. If the Reading pane is not currently displayed, click View and hover 

over Reading Pane. This is where you can control whether or not the 

Reading pane is visible and its position when visible.

 2. Select Right.

 3.  You can resize the Reading pane to take up more or 

less room in the Outlook window. This is useful for 

allowing you to see more columns in the Inbox or 

for easier reading of message text in the Reading 

pane.

 4. To resize the Reading pane, place your mouse pointer over the left 

border, between the Inbox and the Reading pane. When the pointer 

changes to left and right arrows , drag the border to the right until 

the Reading pane is approximately half its original width. Release 

the mouse when you have the size you want.

 5. To move the Reading pane to the bottom, click View and hover over 

Reading Pane. Click Bottom.

NOTE

Other than the Inbox, other mail folders 
include Deleted Items, Drafts, Junk E-

mail, Outbox, and Sent Items. Later in the 
text you will learn how to create your own 

mail folders.

NOTE

The body text of e-mail messages in the 
Reading pane will automatically wrap to 

accommodate the size of the pane.
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 6. You can also resize the Reading pane to be taller or shorter when 

displayed at the bottom, which allows you to control the number of 

messages you can see in your Inbox.

 7. To resize the Reading pane, place your mouse pointer over the top 

border, between the Inbox and the Reading pane. When the pointer 

changes to up and down arrows , drag the border down until the 

Reading pane is about half its original height. You may notice that 

the current message displayed in the pane has a vertical scrollbar for 

scrolling through the message text.

 8. To hide the Reading pane, click View and hover over Reading Pane. 

Click Off. Leave the Reading Pane off for the following exercises.

Exercise 1-10 USE AUTOPREVIEW

When the Reading pane is turned off, AutoPreview allows you to see the 

beginning of each message within the Inbox itself.

 1. To turn AutoPreview on, click View and click AutoPreview.

 2. Note that each message in your Inbox displays a few lines from the 

beginning of the message. To see the remainder of the message, it is 

necessary to either open the e-mail (by double-clicking) or turn the 

Reading pane back on.

Figure 1-8
Inbox with 

AutoPreview turned 
on and Reading 

pane off

 3. To turn AutoPreview off, click View and click AutoPreview.
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Exercise 1-11 SORT E-MAIL MESSAGES

Outlook’s default settings are to sort e-mail by date with the most recent 

messages at the top of the Inbox (or other mail folder) and to group messages 

together based on the time frame during which they were received. You can 

choose to modify these default settings in several ways.

 1. Hover over each of the column headings at the top of the Inbox and 

wait for a moment over each to see the ScreenTip that describes the 

sort that will be performed if you click that heading. Notice that the 

Received column (assuming default settings) displays a down arrow. 

This indicates that the current sort is by received date and is from 

most recent to oldest. This is known as a descending sort.

 2. Click the Received heading one time. This changes the sort so that 

messages are sorted from oldest at the top to newest at the bottom. 

This is known as an ascending sort. Notice also that messages are 

grouped by the time frame during which they were received.

 3. Click the minus sign  next to the topmost group (most likely for 

oldest messages). This button collapses a group, allowing you more 

room to focus on other messages.

 4. Click the plus sign  next to the topmost group to expand the group 

again.

 5. Click the Size column heading one time to sort the messages from 

largest to smallest, or in descending order. Messages with 

attachments will tend to appear at the top due to the size of the 

attached file. Note that the grouping categories have changed to 

groups that reflect the size range of the messages in the group.

Figure 1-9
Inbox with messages 
sorted and grouped 

by size
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 6. If you’d rather not see groups for a sort (regardless of the sort), you 

can remove the sorting option. Click View and hover over Arrange By. 

Click Show in Groups to deselect the option.

 7. Sorting options are also available from the shortcut menu. Right-

click any column header and hover over Arrange By. Click Show in 

Groups to restore the grouping feature.

 8. You can also expand or collapse all groups at once. Click View and 

hover over Expand/Collapse Groups. Click Collapse All Groups.

 9. To restore the groups to their default expanded state, click View and 

hover over Expand/Collapse Groups. Click Expand All Groups.

 10. Click the Received column header once to restore the default sort. 

Verify that messages are being sorted from most recent at the top to 

oldest at the bottom.

 11. To restore the other settings you’ve changed, click View and click 

AutoPreview if it is turned on. Click View again and hover over Reading 

Pane. Click Right to restore the Reading pane to its default position. You 

may resize the Reading pane to whatever size is comfortable for you.

Exercise 1-12  PRINT E-MAIL MESSAGES 
AND CLOSE OUTLOOK

You can print either the list of messages in your Inbox as they are displayed 

on the screen or the content of individual messages.

 1. Click the first message in your Inbox to select it.

 2. Click the File menu and select Print.

Figure 1-10
Outlook’s Print 

dialog box
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 3.  Note that there are two print styles available for 

e-mail messages: Table Style and Memo Style. Note 

also that for messages with attachments you can 

select Print attached files. However, attachments 

will only print to the default printer.

 4.  Click the Preview button to see what Memo Style 

looks like. Note that Memo Style prints the contents 

of the currently selected e-mail or e-mails.

 5. Click the close button  to leave print preview.

 6. Click the File menu and select Print.

 7. Change the print style to Table Style. Click the Preview button. Note 

that Table Style prints the current Inbox view.

 8. Click the close button  to leave print preview.

 9. Open the currently selected message in the Inbox by double-clicking 

it. Printing from an open message requires the use of the Office 

Button , which makes available many of the functions normally 

found in the File menu.

10.  Click the Office Button  in the open message and hover over Print.

11.  Click the first option, Print. Note that while in an open 

message your only available print style is Memo Style.

12.  Click Cancel to return to the open message. Close 

the message form by clicking the close button .

13.  Click the close button  to close Outlook. Outlook 

will perform a final Send/Receive operation before 

closing.

Using Online Help

Online Help is available in Outlook to assist you with various components of 

the program and problems you may run into. In this exercise you use Online 

Help to learn more about the file attachments Outlook blocks.

USE HELP TO LEARN ABOUT FILE ATTACHMENT LIMITATIONS

 1. Start Outlook if necessary.

 2. Locate the Search box  and key file attachments and 

press Enter .

 3. Locate and click the link Blocked attachments in Outlook.

 4. Review the information, paying close attention to the list of blocked 

file types. Also make note of the procedure for sending one of these 

files by changing the file extension. This technique can be very useful.

 5. Close the Outlook Help window when you are finished.

NOTE

If multiple e-mails are selected and 
printed in Memo Style, each will print on 

its own page or pages, depending on 
length.

TIP

Clicking the Print button  while viewing 
the Inbox assumes that you want to print 
the currently selected message to your 

default printer in Memo Style. This is the 
same thing as clicking the Office Button 
and choosing Quick Print from the Print 

menu while viewing a message.
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Lesson  Summary

• Start Outlook by clicking the Start button  and pointing to All 
Programs. Click Microsoft Office and then click Microsoft Office Outlook 
2007.

• Use the Navigation pane to navigate among Outlook’s components.

• When the Navigation pane is minimized to the Navigation bar using 

the , you can show the mail folders by clicking the area labeled 

Navigation Pane.

• To send an e-mail message, you need the recipient’s address, which 

consists of the user’s name, the @ symbol, and their domain name.

• Open the new message form by clicking the New button  while 

viewing the Inbox.

• Key the recipient’s address in the To text box. Recipients listed in 

the Cc text box will also receive the message and their addresses will 

be displayed in the message header. Multiple addresses should be 

separated by a semicolon.

• Turn on the Bcc text box by clicking the Options tab above the Ribbon 

and clicking the Show Bcc option. Addresses in the Bcc text box will not 

appear in the header of the message when it is received.

• To resend an e-mail message, open the message from the Sent Items 

folder. Click Other Actions on the Ribbon and choose Resend This 
Message.

• You can respond to e-mail messages by using the Reply, Reply to All, 

and Forward buttons either from the Inbox or from within an open 

message form.

• Reply sends a response to the original sender of the message.

• Reply to All sends a response to the original sender of the message and 

all original recipients.

• Forward sends the message to a new recipient or recipients you choose.

• Attach files to e-mail messages by clicking the Attach File button  on 

the Ribbon while in the message form.

• Preview attachments to received e-mails by clicking the button with the 

name of the attachment on it in either the open message form or the 

Reading pane.

• Open attachments to received e-mails by double-clicking the button 

with the name of the attachment on it in either the open message form 

or the Reading pane.

• Save attachments to received e-mails by right-clicking the button with 

the name of the attachment on it in either the open message form or the 

Reading pane. Choose Save As from the shortcut menu.

• You can position the Reading pane at the right or bottom of the Outlook 

window. It can also be closed. These options are available from the View 

menu. When the Reading pane is visible, you can also resize it with the 

mouse.

1
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• AutoPreview, which is available from the View menu, displays the first 

few lines of each e-mail directly in the Inbox. This is sometimes used 

when the Reading pane is turned off.

• Message sorting in the Inbox is controlled by clicking the column 

headings. Grouping of messages can be turned on or off from the View 

menu.

• Printing with Table Style prints the list of messages in the Inbox.

• Printing with Memo Style prints the contents of the selected e-mail 

message.

LESSON 1  Command Summary

Feature Button Task Path Keyboard

Attach File 

AutoPreview  View, AutoPreview

Forward as Attachment  Action, Forward as Attachment Ctrl ⫹ Alt⫹ F

Forward  Action, Forward Ctrl ⫹ F

Navigation pane  View, Navigation Pane Alt⫹ F1

New Message  File, New, Mail Message Ctrl ⫹ Shift ⫹M

Print  File, Print Ctrl ⫹ P

Reading pane  View, Reading Pane

Reply to All  Action, Reply to All Ctrl ⫹ Shift ⫹ R

Reply  Action, Reply Ctrl ⫹ R

Send   Ctrl ⫹ Enter

Send/Receive  Tools, Send/Receive,  F9

  Send/Receive All



Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 

choice by circling T or F.

 1. There is more than one possible way to start Outlook.

 2. The Reading pane is the primary navigational tool in Outlook.

 3. Addresses in the Cc text box do not appear in received messages.

 4. Multiple addresses should be separated with a semicolon.

 5. A message must be open to be resent.

 6. It is wise to use Reply to All cautiously.

 7. Attachments cannot be previewed from the Reading pane.

 8. Table Style is used to print the contents of a single message.

Short Answer Questions
Write the correct answer in the space provided.

 1. Describe some of the possible methods for starting Outlook.

 2.  How do you display the folder list when the Navigation pane has been 
minimized to the Navigation bar?

 3.  What are the two keyboard shortcuts for starting a new mail message 
and when are they used?

 4. How do you display the Bcc text box if it is not displayed?

 5.  What are some of the indications that a new message has been received?

 6. Why should you be careful in using Reply to All?
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 7. What does the Attach File button look like?

 8. What are your options for displaying the Reading pane?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 

answers. Support your answers with examples from your own experience, 

if possible.

 1. Why might you want to think carefully before sending very large file 

attachments?

 2. When might you want to turn off the Reading pane and the 

AutoPreview feature?

Skills Review

Exercise 1-13
Start Outlook. Create and send an e-mail message.

 1. Start Outlook by following these steps:

 a.  Click the Start button  on the Windows taskbar.

 b. Hover over All Programs.

 c. Click Microsoft Office and then click Microsoft Office Outlook 2007.

 2. Start a new e-mail message by following these steps:

 a.  Verify that you are viewing the Inbox. If not, click the Inbox tab on 

the Navigation pane if the pane is minimized. If the Navigation pane 

is not minimized, click the Inbox folder in the folder list.

 b. Click the New button  on the Standard toolbar.

 3. Address and enter the message by following these steps:

 a. In the To text box enter your instructor’s e-mail address.

 b. In the Cc text box enter your own e-mail address.

 c. In the Subject text box key Open Enrollment Reminder.

 d. For the body of the message, key the text shown in Figure 1-11.
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 4.  Proofread your addresses and message. Send the message by clicking 

the Send button .

Exercise 1-14
Forward an e-mail message; add an attachment to an e-mail message.

 1.  Verify that you are viewing the Inbox. If not, click either the Inbox tab or 

folder on the Navigation pane.

 2.  Open the message with the subject “Fall Catalog Cover” by double-

clicking it.

 3.  Begin forwarding the message by following these 

steps:

    a. Click the Forward button .

    b.  Key your instructor’s e-mail address in the To text 

box.

    c. Key your e-mail address in the Bcc text box.

    d.  In the body of the message key That picture looks 
great. I’d like to suggest this picture for our spring cover. 

 4.  Add an attachment to the message by following these 

steps:

    a. Click the Attach File button .

    b.  When the Insert File dialog box opens, click Pictures 

under the Favorite Links pane.

    c.  Locate the Sample Pictures folder in the right pane of 

the dialog box and double-click it to open it.

    d.  Locate the picture Creek and double-click it to 

attach it to the message.

 5.  Remove the original attachment by right-clicking the file Autumn Leaves 

where it appears in the Attached text box. Choose Remove.

 6.  Proofread your address and message. Send the message by clicking the 

Send button .

Figure 1-11

NOTE

This exercise makes use of an e-mail you 
created in Exercise 1-6. If you do not have 

this message (subject line “Fall Catalog 
Cover”) in your Inbox, please complete 

Exercise 1-6.

NOTE

If the Bcc text box is not visible, follow the 
instructions in Exercise 1-3 to display it.
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Exercise 1-15
Preview and save a message attachment.

 1.  Verify that you are viewing the Inbox. If not, click 

either the Inbox tab or folder on the Navigation pane.

 2.  Open the message with the subject “FW: Fall Catalog 

Cover” by double-clicking it.

 3.  Preview the attachment by clicking the button labeled 

Creek.jpg.

 4.  Return to the message by clicking the button labeled 

Message.

 5. Save the message attachment by following these steps:

 a. Right-click the button labeled Creek.jpg.

 b. Choose Save As.

 c.  Click Documents under Favorite Links to be sure you are in your 

Documents folder.

 d. In the File name text box key Spring Cover.jpg.

 e. Click Save.

 6.  Close the open e-mail form by clicking the close button .

Exercise 1-16
Print the body of an e-mail message in Memo Style with attachment; print 

the contents of the Inbox in Table Style.

 1.  Verify that you are viewing the Inbox. If not, click either the Inbox tab or 

folder on the Navigation pane.

 2.  Open the message with the subject “FW: Fall Catalog Cover” by double-

clicking it.

 3. Print the e-mail message by following these steps:

    a.  Click the Office Button  in the open message and 

hover over Print.

    b. Click the first option, Print.

    c.  Verify your printer selection and click OK to print 

the message.

    d.  Close the message form by clicking the close 

button .

 4.  While viewing the Inbox, print a listing of the messages it contains by 

following these steps:

 a. Click the File menu.

 b. Select Print.

 c. In the section labeled Print style, choose Table Style.

 d. Verify your printer selection and click OK to print the Inbox listing.

NOTE

This exercise makes use of an e-mail you 
created in Exercise 1-14. If you do not 

have this message (subject line “FW: Fall 
Catalog Cover”) in your Inbox, please 

complete Exercise 1-14.

NOTE

This exercise makes use of an e-mail you 
created in Exercise 1-14. If you do not 

have this message (subject line “FW: Fall 
Catalog Cover”) in your Inbox, please 

complete Exercise 1-14.



Lesson Applications

Exercise 1-17
Create and send an e-mail message; use Reply to All to respond to an 

e-mail message.

 1. Open Outlook and display the Inbox if it is not already displayed.

 2.  Create a new e-mail message. Address the message to your instructor 

and send a blind carbon copy to yourself.

 3.  Key the subject of the message as Manufacturing Error Rate Report 
Request.

 4. For the body of the message, key the text in Figure 1-12.

Figure 1-12

 5.  Proofread your addresses and the message and send 

the e-mail.

 6.  Force Outlook to do a send/receive. You may need 

to do this more than once before your copy of the 

message appears in your Inbox.

 7.  Select the Manufacturing Error Rate Report Request 
e-mail and click the Reply to All button.

 8.  In the body of the message key The error rate report for all departments 
will not be available online until midday Tuesday due to database 
maintenance.

 9. Send the message.

Exercise 1-18
Create an e-mail message; add an attachment; save an attachment; print a 

message.

 1. Open Outlook and display the Inbox if it is not already displayed.

 2.  Create a new e-mail message. Address the message to your instructor 

and send a carbon copy to yourself.

 3. Key the subject line Spring Cover Concerns.

 4. For the body of the message key the text in Figure 1-13.

REVIEW

You can use the F9  key to force Outlook 
to perform a send/receive.
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 5.  Attach the file Forest Flowers to the message. You will find this message 

in the Sample Pictures folder in the Pictures folder on your computer.

 6. Send the message.

 7.  When the Spring Cover Concerns message arrives in your Inbox, 

open it.

 8.  Save the attachment to your Documents folder as Alternate Spring Cover.
jpg (be sure to type the jpg extension).

 9. Print the e-mail in Memo Style. Do not print the attachment.

 10. Close the message.

Exercise 1-19
Manipulate the Reading pane, switch mail folders; sort mail folders, print 

the contents of mail folders.

 1. Close the Reading pane so you can see all of the columns in the Inbox.

 2.  Sort the Inbox messages by size in descending order (with the largest 

messages first).

 3. Print the contents of the Inbox using Table Style.

 4.  Restore the sort of the Inbox to descending by date received. This is the 

default sort and puts the most recent messages at the top.

 5. Restore the Reading pane to its previous position and/or size.

 6.  If the Navigation pane is minimized to a bar, click the area labeled Sent 
Items to display the Sent Items folder. If the Navigation pane is not 

minimized, you can click this folder directly in the Mail Folders list.

 7.  Close the Reading pane so you can see all of the columns in the Sent 

Items folder.

 8.  Sort the Sent Items folder in ascending order by size. This puts the 

smallest messages at the top.

 9. Print the Sent Items folder using Table Style.

10.  Restore the sort of the Sent Items folder to descending 

by date received. This is the default sort and puts the 

most recent messages at the top.

Figure 1-13

TIP

Clicking a column header a second time 
reverses the order of the sort.
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 11. Restore the Reading pane to its previous position and/or size.

 12. Return to the Inbox.

Exercise 1-20  Challenge Yourself
Send an e-mail message to multiple recipients; attach multiple 

attachments, print e-mail message with attachments to default printer.

 1.  Open Outlook and display the Inbox if it is not already 

displayed.

 2.  Create a new e-mail message. Address the message to 

your instructor, yourself, and one classmate. All three 

addresses should be in the To text box.

 3. Key the subject Final Opinions on Catalog Covers.

 4. Key the message body text from Figure 1-14.

NOTE

This exercise requires the files Fall Cover.
jpg and Alternate Spring Cover.jpg, 

which were saved during Exercises 1-8 
and 1-18, respectively. Please complete 
those exercises before doing this one. 
Additionally, this exercise requires your 

lab printer to be your default printer. See 
your instructor if you need assistance in 

configuring this.

Figure 1-14

 5.  Attach the files Fall Cover.jpg and Alternate Spring Cover.jpg that are 

saved in your Documents folder.

 6. Send the e-mail.

 7.  When the e-mail arrives in your Inbox, open it and 

print it to your default printer, being sure to check the 

checkbox to include the message attachments.

 8. Close the message form.

TIP

When the Print Pictures window appears, 
simply click the Print button to print each 
picture as a full size page. You will need 

to do this once for each picture.

On Your Own

In these exercises you work on your own, as you would in a real-life work 

environment. Use the skills you’ve learned to accomplish the task—and be 

creative.

Exercise 1-21
Open Outlook and experiment with the settings for the Navigation pane, the 

Reading pane, the AutoPreview feature, and the sorting of messages. Write 
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an e-mail to your instructor that explains your preferences for working with 

these settings in Outlook. Be sure to explain your reasoning. Return the 

settings to their defaults when you are done.

Exercise 1-22
Create a new e-mail message. In the body of this message key the True/False 

and Short Answer questions from the end of the lesson and your answers to 

them. Send this message to your instructor with an appropriate subject line. 

To print the message, open it from your Sent Items folder and print it in 

Memo Style for your own reference.

Exercise 1-23
Ask a friend who has access to a digital camera, or other source of digital 

images, to send you an e-mail with an attached image file. When you receive 

the e-mail, preview the attachment. If you like, save the attachment to your 

Pictures folder. Be sure to reply to your friend’s e-mail to let them know you 

received it and how you liked the picture.
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After completing this lesson, you will be able to:

1. Create and modify contacts.

2. Edit and use an electronic business card.

3. Create and modify distribution lists.

4. Create a secondary address book.

5. View and print contacts.

MCAS OBJECTIVES

In this lesson:

OL07 4.1.1

OL07 4.1.2

OL07 4.1.3

OL07 4.1.4

OL07 4.1.5

OL07 4.2.1

OL07 4.2.2

OL07 4.3

OL07 4.4.1

OL07 4.4.2

OBJECTIVES

Lesson 2

Contact Management

OL1.2

Outlook’s powerful contact management component goes far beyond simply 

tracking e-mail addresses, mailing addresses, and phone and fax numbers. In 

addition to those important pieces of information, Outlook allows you to record 

just about anything else about a contact you might wish to keep track of.

Outlook also gives you an easy way to exchange contact information 

with others and create and manage customized lists of contacts for sending 

e-mail to groups. It also gives you extensive control over how you store and 

view your contacts.

Creating and Modifying Contacts
Contacts in Outlook are created by filling in a form with fields for the 

information that describes the contact. You can create new contacts by first 

opening a blank form, or you can create new contacts based on the company 

information for an existing contact. You can also begin the process of creating 

a contact from the header information of an e-mail message.

Once you have created a contact, it is easy to modify or add to the 

information when updates are necessary. Additionally, contacts that are no 

longer valid or needed can easily be removed from your address book.

 Estimated Time: 11/2 hours
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Exercise 2-1 CREATE A NEW CONTACT

There are several ways to begin the process of creating a contact in Outlook. 

You can:

• Press Ctrl ⫹ N  while viewing the contacts.

• Press Ctrl ⫹ Shift ⫹ C  while viewing any part of Outlook.

• Click the New button while viewing contacts.

• Choose Contact from the drop-down list of the New button.

 1. Minimize the Navigation pane, if it is not already minimized, by 

clicking the chevrons  at the top of the pane. Working with the 

minimized Navigation bar leaves more room available to view your 

contacts.

 2. Switch to Outlook’s Contacts component by clicking the Contacts 

button  on the Navigation bar.

 3. Click the New button  to open a new contact form.

Figure 2-1
The New Contact 

form
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 4.  In the Full Name text box, key your instructor’s full 

name.

 5.  Press Tab  one time to move to the Company text 

box. Key your school’s name.

 6.  Press Tab  one time to move to the Job title text box. 

Key your instructor’s title (i.e. Instructor, Professor, 

Teaching Assistant, etc.).

 7.  Note that the File as text box already contains your 

instructor’s name with the last name first. This 

standard method of filing contacts makes finding a 

particular person much easier. However, you do 

have other options.

 8.  Click the drop-down arrow  to the right of the 

File as text box. Note the other choices you have 

for filing this contact. Click the drop-down arrow 

 again to close the list without making any 

changes.

 9.  Press Tab  one time. Note that the blinking insertion 

cursor is not in the next text box, E-mail. Instead 

there should be an outline around the Add Contact 

Picture button . This button can be used to 

associate a picture with a contact. Do not click this 

button at this time.

10.  At this point, using Tab  to move from field to field 

can be awkward. Press Tab  three times to move to 

the E-mail text box. Note that the first two key 

presses moved to the E-mail button  and 

the drop-down arrow  beside it. You’ll explore 

the function of these buttons later in this lesson.

 11. Verify that the blinking insertion cursor is in the E-mail text box. 

Key your instructor’s e-mail address.

 12. Press Tab . Outlook fills in the Display as text box with your 

instructor’s name followed, in parentheses, by the e-mail address 

you just entered.

 13. Use your mouse to click in the text box to the left of the Business 

button  in the Phone numbers section of the form. When 

keying a telephone number you only have to key the numbers. Key 

your school’s telephone number, including the area code, like this: 

5555551212.

TIP

You can use Tab  to move to the next 
text box and Shift ⫹ Tab  to move to the 
previous text box. Alternatively, you can 

also click in any field you wish.

TIP

It’s a good idea to be consistent with your 
filing approach for contacts. Outlook will 
allow you to choose different methods 

for different contacts, but this can lead to 
difficulty when searching for information.

NOTE

If you accidentally click the Add Contact 
Picture button, just close the dialog box 
that opens to return to the contact form.
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Figure 2-2
Partially completed 

contact form

 15. Use your mouse to click in the text box in the Addresses section of 

the form. Enter the address for a contact in much the same way you 

would address an envelope, each part of the address appearing on its 

own line.

16.  Key the address number and street name for your 

school and press Enter .

17.  Key the city and state/province your school is in 

using the format: City, State/Province. Do not key the 

Zip or postal code.

 14. Press Tab  one time to move out of the Business text box. Note that 

Outlook automatically formats the telephone number with 

parentheses around the area code and a hyphen between the 

exchange and the rest of the number after the information is 

entered. 

TIP

You can open a dialog box to enter 
information by clicking the appropriate 

button (Full Name, E-mail, Business, 
etc.) instead of keying information in the 

contact form’s text boxes.
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18.  Press Tab  to move out of the address field. Note that a Check Address 

dialog box appears with the insertion cursor in the Zip/Postal code 

field. Outlook displays a dialog box similar to this whenever the 

information you enter is unclear or incomplete.

 19.  Key your Zip or postal code and click the OK button  to return 

to the contact form. Leave the contact form open for the next 

exercise.

Exercise 2-2  SAVE A CONTACT AND CREATE A 
NEW CONTACT FROM THE SAME 
COMPANY

After entering information for a new contact, you can save it and close the 

form, save it and open a new blank form, or save it and begin a new contact 

for another person in the same company.

 1. To begin the process of creating a new contact for a person from the 

same company as your current contact, click the drop-down arrow on 

the Save & New button on the Ribbon . Select New Contact 

from Same Company. This opens a new contact form with some of 

the fields already filled in with the company information from the 

previous contact.

 2. Click the Full Name button  to open the Check Full Name 

dialog box. You can use this dialog box to enter name information if 

you prefer. Outlook will also display this box whenever the information 

you enter in the Full Name text box is incomplete or unclear.

Figure 2-3
Check Address 

dialog box
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Figure 2-4
Check Full Name 

dialog box

 3.  Using information from your instructor, key 

information in at least the First and Last text boxes 

and click the OK button .

 4. Key an e-mail address in the E-mail text box.

 5.  Click the Save & Close button  to save the new 

contact and close the form. Click the Save & Close 

button again  to close the form for your original 

contact. You should now be viewing the contacts 

screen, which is displaying the business cards for 

the contacts you have created.

NOTE

Your instructor will provide you with the 
necessary information for this contact.

NOTE

Your list of contacts may be different from 
those displayed in the figures.

Figure 2-5
Microsoft Outlook 

contacts displayed as 
business cards
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Exercise 2-3  CREATE A CONTACT FROM 
A MESSAGE HEADER

Creating contacts from message headers is a good way to keep your list of 

contacts up to date as you receive messages from people you may want to 

communicate with later. In this exercise you’ll use this technique to begin 

creating a contact for yourself from one of your sent messages.

 1. Click the Mail button  to return to the Inbox.

 2. If the Navigation pane is not minimized, click the Sent Items folder. If 

the minimized Navigation bar is displayed, click the Sent Items tab.

 3. Double-click the first message in Sent Items to open it.

 4. Locate your name and/or e-mail address in the From field in the 

message header.

 5. Right-click your address and select Add to Outlook Contacts.

 6. Click in the text box next to the Home button  in the Phone 

numbers section. Enter your home phone number with area code 

(feel free to use a made-up number).

 7. Click in the Addresses text box and enter the address of your school, 

as you did for your instructor. Uncheck the checkbox labeled This is 

the mailing address.

 8.  Click the drop-down arrow  next to the Business button  

and select Home.

 9.  Enter your home address (feel free to use a made-up 

address) in the text box. Click the checkbox labeled 

This is the mailing address to indicate that this is the 

mailing address for this contact.

10.  Click the Save & Close button . You will open and 

edit this new contact in the next exercise. Close the 

e-mail message.

11. Return to contacts by clicking the Contacts button .

Exercise 2-4 MODIFY AN EXISTING CONTACT

You can edit contacts after creation to add or change information. In this 

exercise you will edit your own contact and explore some of the many pieces 

of information that can be associated with a contact.

 1. Double-click the business card for your contact to reopen the 

contact form.

 2. So far you have only worked with information in the General 

category. To switch to the Details category for your contact, click the 

Details button  in the Show group on the Ribbon.

TIP

The drop-down buttons next to the 
E-mail, Phone, and Address buttons on 
the contact form allow you to designate 
up to three different e-mail and mailing 
addresses and up to 19 different phone 

numbers for each contact.
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 3. Click in the Birthday text box and replace None with your birth 

date. Use the format MM/DD/YY. You can also use the drop-down 

arrow to select your birth date from a calendar, but keying it is 

typically much faster.

 4. Click the Activities button  in the Show group on the Ribbon. 

This view displays other Outlook items, such as appointments and 

e-mails, that are related to the current contact. You do not enter 

these here; Outlook makes the connection automatically. Because 

this is a relatively new contact, it’s likely that nothing is displayed 

here as of yet.

 5. Click the Certificates button  in the Show group on the 

Ribbon. Here you can import certificates, which are used to digitally 

encrypt e-mail messages to recipients. Certificates will be addressed 

further in Lesson 5.

 6. Click the All Fields button  in the Show group on the Ribbon. 

As the name implies, this gives you access to all available fields for a 

contact, including custom fields you can create.

 7. Click the Save & Close button  to return to viewing contacts.

Figure 2-6
Details fields for a 

contact
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Editing and Using Electronic 
Business Cards
Electronic business cards are more than just the default way to view your 

contacts in Outlook. They can also be edited to display information in a 

format you prefer. Business cards can also be sent to and received from other 

Outlook 2007 users to make the sharing of contact information easy. In these 

cases, only the information you have chosen to display on the business card 

is actually available to the recipient.

In cases where you want to exchange full contact information with 

others, you can send or receive in either a special Outlook-compatible format 

or as a vCard, which can be understood by most e-mail applications.

Exercise 2-5 EDIT A BUSINESS CARD

 1. Double-click the business card you created for your instructor to 

open it.

 2. Click the Business Card button  to open the Edit Business Card 

dialog box.

Figure 2-7
Edit Business Card 

dialog box
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 3. This dialog box allows you to make many changes to the current 

business card, including which fields to display, the graphics on the 

card and their position, and many other elements. For this exercise, 

you are going to make a few minor changes to the information 

displayed and the card’s overall appearance.

 4. In the Fields area, select Business Address and click the Remove 

button .

 5. In the Card Design area, set the Layout to Image Left if it is not 

already Image Left by clicking the button labeled Image Left 

.

 6. In the Edit area, add the italics effect to the instructor’s name by 

selecting the Instructor’s name and clicking the italics button .

 7. Click the OK button  to close the dialog box and return to the 

contact form.

 8. Click the Save & Close button  to return to viewing your contacts.

Exercise 2-6 SEND A BUSINESS CARD

 1. Right-click the business card for your instructor that you just edited. 

Select Send as Business Card.

 2. Before addressing and sending the e-mail, double-click the link in 

the Attached text box to see what the recipient will receive. Note that 

the address will not be included with this contact, since you removed 

it from the business card. Close the contact form.

 3. Key your instructor’s e-mail address in the To text box. Key your own 

e-mail address in the Cc text box.

 4. Key Instructor’s Business Card in the Subject text box.

 5. Click the Send button  to send the e-mail.

Exercise 2-7  ADD A CONTACT FROM A BUSINESS 
CARD OR CONTACT RECORD

 1. Click the Mail button  to go to the Inbox. If the message sent in 

the last exercise has not yet arrived, try pressing F9  to force a send/

receive operation.

 2. When the message arrives, double-click it to open it.

 3. The most common way to add a contact from a business card is to 

right-click the business card itself. Right-click the card and select 

Add to Outlook Contacts. This will open the contact form. Note that 

the address for the contact is not included since it does not appear 

on the card.
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 4. Close the contact form without saving changes, since this is a 

contact you already have.

 5. Another method for adding the contact is frequently used when the 

recipient is not running Outlook. Right-click the attachment button 

labeled with the name of the contact. Select Add to Contacts.

 6. Since this is still a contact you already have, close this contact form 

without saving changes. Close the message form as well.

 7. Return to Outlook’s Contacts component by clicking the Contacts 

button .

Exercise 2-8 SEND A FULL CONTACT

If you want to exchange all of the information recorded for a contact, you 

typically need to move beyond business cards. In these cases you want 

to send a full contact, and there are two different formats to use; one for 

Outlook users and one known as Internet format for most other e-mail 

clients. Only use the Outlook format if you are sure the recipient is using 

Outlook. Although the Internet format may lose some formatting and 

attached pictures, at least you know your contact information will make it 

to the recipient in a readable form.

 1. Right-click your instructor’s contact and select Send Full Contact. 

Select In Internet Format (vCard). This is the same format used by the 

attachment that was included with the business card in the previous 

exercises.

 2. When the message form opens, double-click the attachment to view 

the contact form. Notice that now the address appears for the 

contact, even though it is not on the business card. Sending a full 

contact includes all information you have recorded for that contact.

 3. Close the contact form. Also close the e-mail form without saving 

changes.

Creating and Modifying 
Distribution Lists
A distribution list is nothing more than a named group of e-mail addresses. 

Distribution lists add convenience by allowing you to send a message to 

multiple recipients by simply entering the name of the list. There are several 

ways to begin creating a distribution list:

• Press Ctrl ⫹ Shift ⫹ L  while viewing any part of Outlook.

• Right-click the contacts display area and select New Distribution List.

• Choose Distribution List from the drop-down list of the New button.



LESSON 2 Contact Management
O

u
tlo

o
k
 2

0
0
7

39

Exercise 2-9  CREATE AND MODIFY 
A DISTRIBUTION LIST

 1. Click the drop-down arrow next to the New button  and select 

Distribution List.

 2. The first step of creating a distribution list is giving it a name. In the 

Name text box key All Contacts.

 3. To add members to the list, click the Select Members button  in 

the Members group on the Ribbon.

Figure 2-8
Select Members: 

Contacts dialog box

 4. Double-click each of your contacts to add each to the Members text 

box at the bottom of the dialog box. Click the OK button  

when you are done.

 5. Click the Add New button in the Members group on the 

Ribbon. This opens the Add New Member dialog box, which 

is used to add addresses to your list that are not currently in 

your contacts.
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 6. Key the information in the Display name and E-mail address text 

boxes as shown in Figure 2-9. Note, but do not check, the Add to 

Contacts checkbox. You would use this if this were a real contact 

and you wanted to make it a part of your contacts list, as well as part 

of this distribution list. You will delete this contact in the next step, 

which is why you are using the information from the figure. Click 

the OK button  to add the new member to the list.

 7.  Select the New Contact entry from the list. To 

delete this member from the list, click the Remove 

button .

 8.  Click the Save & Close button  to complete the 

distribution list. Note that the distribution list has 

its own business card displayed in the contacts area.

Creating a Secondary Address Book
Many users find it convenient to maintain a separate address book, or folder, 

for personal contacts and business contacts. Doing this in Outlook is easy. 

Additionally, creating a secondary address book gives you the chance to 

explore the ability to export and import contacts, which is another way to 

exchange contact information with other users.

Exercise 2-10  EXPORT CONTACTS 
AS AN EXCEL FILE

 1. Verify that you are currently viewing your contacts.

 2. Click the File menu and select Import and Export.

 3. Choose Export to a file and click the Next button .

 4. Choose Microsoft Excel 97-2003 and click the Next button .

NOTE

When sending e-mail messages to 
distribution lists, you only need to type 
the name of the list. Because of this, it 

is wise to keep the names short, easy to 
remember, and easy to type.

Figure 2-9
Add New Member 

dialog box
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 5.  Verify that the Contacts folder is currently selected 

in the Select folder to export from hierarchy. Click the 

Next button .

 6.  Key My Contacts.xls into the Save exported file as: 

text field. Click the Next button  to accept the 

default location (your documents folder) for the 

exported contacts.

 7.  Click the Finish button  to complete the export.

Exercise 2-11  CREATE A NEW FOLDER TO USE 
AS A PERSONAL CONTACTS 
ADDRESS BOOK

 1.  While viewing contacts, click the File menu and choose New and 

then Folder.

NOTE

The amount of time it takes to export 
depends on the number of contact 

records being exported.

Figure 2-10
Create New Folder 

dialog box

 2.  In the Name text box of the Create New Folder 

dialog box, key Personal Contacts. Click OK to create 

the folder and close the dialog box.

NOTE

You cannot create subfolders on IMAP 
accounts.
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 3.  To see the Personal Contacts folder, expand the Navigation bar 

to display the entire Navigation pane by clicking the chevrons 

button . Click Personal Contacts under the My Contacts header. 

Since this is a new address book, it currently has no contacts.

Exercise 2-12  MOVE AND COPY CONTACTS 
BETWEEN FOLDERS

Once you have more than one Contacts folder, you may want to move or 

copy existing contacts between folders.

 1. Switch to your normal Contacts folder by clicking its name in the 

Navigation pane. Locate the business card for your instructor’s 

contact you created earlier and click it once to select it.

 2. Click the Edit menu. Select Move to Folder.

 3.  In the Move items dialog box, locate the Personal 

Contacts folder. If it isn’t visible, you may need to 

click the plus sign  next to the Contacts folder in 

the hierarchy listing. Click the Personal Contacts 

folder to select it once you can see it.

 4. Click the OK button  to move your instructor’s contact to the 

Personal Contacts folder. Switch to the Personal Contacts folder by 

clicking it in the Navigation pane. Verify that your instructor’s 

contact is there.

 5. Select your instructor’s contact in the Personal Contacts folder, if it is 

not already selected. Click the Edit menu and select Copy to Folder.

 6.  In the Copy Items dialog box, select the Contacts 

folder and click the OK button . Switch to 

the Contacts folder using the Navigation pane and 

verify that your instructor’s contact is once again 

in that folder.

 7.  Switch back to the Personal Contacts folder. Right-click the copy of 

your instructor’s contact in this folder and select Delete.

Exercise 2-13  IMPORT CONTACTS FROM 
AN EXCEL FILE

 1. While viewing the empty Personal Contacts address book, click the 

File menu and select Import and Export.

 2. If necessary, choose Import from another program or file and click the 

Next button .

TIP

The keyboard shortcut for Move to Folder 
is Ctrl ⫹ Shift ⫹ V .

TIP

The keyboard shortcuts for Delete are 
either Delete  or Ctrl ⫹ D .
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 3. Select Microsoft Excel 97-2003 and click the Next button .

 4. Since the Personal Contacts address book is empty, you don’t have 

to worry about dealing with duplicate records. However, if you 

import records into an address book with existing contacts, you 

may want to control how duplicates would be handled at this 

point. Click the Next button  to accept the default file and 

options.

 5. Verify that Personal Contacts is selected in the Select destination 

folder hierarchy. Click the Next button  to move to the 

final step.

 6. Click the Finish button  to complete the process. Note 

that all of your contacts from the original address book have 

now been imported into your Personal Contacts address book. 

Leave the Personal Contacts address book open for the next 

exercise.

Viewing and Printing Contacts
Outlook provides many options for viewing contacts. Additionally, you can 

choose from many different print formats that allow you to easily carry your 

contacts with you when away from your computer.

Exercise 2-14 VIEW CONTACTS

 1. If the Navigation pane is minimized, restore it by clicking the 

chevrons button . Working in the full Navigation pane gives you 

easier access to the various contact view options.

 2. Click the Address Cards option button under the Current View 

heading on the Navigation pane. It’s likely that the cards are not 

quite wide enough to display all the information they contain. To 

adjust the width of the display column, hover your mouse pointer 

over the dividing line to the right of the address cards. When it 

becomes a double-headed arrow , drag the border out to the 

right until you can read all of the information.

 3.  Click the Detailed Address Cards option. Note 

that the width of the display column for this 

view also needs to be adjusted. Use the same 

technique from the previous step to make the 

adjustment.

TIP

Double-clicking the column divider causes 
each card to take up the entire width 

of the contact display area. It does not 
autofit the address cards.
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 4. Click the Phone List option. This view can be sorted using the same 

technique you used in Lesson 1 for sorting the Inbox. By clicking a 

column header you sort by that column. Clicking the same column 

header again changes the sort from ascending to descending. The 

default sort is ascending by the File As column.

 5. Click the By Category option. Note that all of your contacts appear 

under the group Categories: (none). You will learn how to assign 

categories to contacts, e-mail, and other Outlook components in 

Lesson 6.

 6. Click the By Company option. This view is very useful when 

searching for contacts from a particular company as it groups them 

together, with the entire list sorted first by company name and then 

by the File As column.

 7.  Click the By Location option. This view allows you to 

easily see where your contacts are located, grouped 

by their country.

 8.  Click the Business Cards option to return to the 

default view.

Exercise 2-15 PRINT CONTACTS

 1. Click the File menu and select Print. The default print style for 

contacts is Card Style. Note the ability to print only the selected 

contact by clicking the option Only selected items under Print Range. 

Leave All items selected for now.

Figure 2-11
Detailed Address 

Cards view

TIP

The number and letter buttons down the 
right-hand side of the window can be 

used to quickly navigate your contacts list 
when you have more than one screen full.
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 2.  Both Small and Medium Booklet Style (which is just larger pages) 

should ideally be duplexed, or printed on both sides of a sheet of 

paper. Click the Preview button  and Outlook will display a 

message to that effect. Click the Yes button  to clear the 

message and display the Print Preview screen.

TIP

You can select multiple contacts prior to 
printing by clicking the first contact and 
then holding down Ctrl  while selecting 

others.

Figure 2-12
Small Booklet Style 

print preview

 3.  Note that the booklet styles are designed to be 

folded into booklets and include blank contact 

forms for you to record new contact information 

while away from the computer.

 4.  Click the Print button  to return to the Print 

dialog box.

 5. Select the Card Style print style and click the Preview button . 

This style matches that of the Address Cards view. Click the Print 

button  to return to the print dialog box.

 6. Select the Memo Style and click the Preview button . This 

option prints each contact on an individual sheet of paper. This is 

the only style that does not allow you to restrict the printout to the 

currently selected contacts by clicking the option under Print Range. 

Instead, you could choose to only print certain pages and restrict the 

contacts printed in that fashion. Click the Print button  to 

return to the Print dialog box.
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 7. Select the Phone Directory Style and click the Preview button . 

As implied by the name, this style prints only the names of contacts 

and their phone numbers. Click the Close button  to leave print 

preview without printing.

Exercise 2-16 DELETE AN ADDRESS BOOK

Deleting a Contacts folder, or address book, also deletes all of the contacts 

it contains. However, it does not affect contacts stored in any other address 

book.

 1. If the Navigation pane is minimized, restore it by clicking the 

chevrons button .

 2. Right-click Personal Contacts under the My Contacts heading. 

Choose Delete “Personal Contacts”.

 3. Outlook asks you to confirm the deletion. Click the Yes button  

to confirm.

 4. Note that you are once again viewing your normal contacts list.

Using Online Help

Outlook allows many options beyond those explored in this lesson for 

customizing your contacts view. One useful option is the ability to change 

the size of business cards so as to display more on the screen at one time.

USE HELP TO LEARN HOW TO CHANGE BUSINESS CARD SIZE

 1. Start Outlook if necessary.

 2. Locate the Search box and key change business card size and press Enter .

 3. Locate and click the link Change the card size in Business Cards view.

 4. Review the information, paying close attention to the procedure 

for changing the size of business cards. Note that this change will 

persist until you change it back.

 5. Close the Outlook Help window when you are finished.

Lesson  Summary

• You create new contacts by filling in a new contact form.

• You can choose alternate methods for filing your contacts.

• Outlook automatically formats telephone numbers for you in the 

contact form.

2
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• Outlook will ask for clarification if information you enter is unclear or 

incomplete.

• You can choose to save a contact and close the form, save a contact 

and start a new contact from scratch, or save a contact and start a new 

contact for another individual from the same company.

• You can create a contact from a message header by using the shortcut 

menu.

• You can edit business cards as to what information they display and 

how they look.

• You can send business cards via e-mail. Only the information displayed 

on the card will be available to the recipient.

• You can create a new contact from a business card you receive by using 

the shortcut menu.

• You can also create a new contact from an attached vCard file by using 

the shortcut menu.

• Full contact records can be sent in either an Outlook-only format or 

vCard or Internet format.

• The first step in creating a distribution list is to give it a name. You 

may then add existing contacts, add new contacts, or remove contacts 

already on the list.

• Contacts exported as an Excel file may be easily imported by another user.

• To create a secondary address book create a new Contacts folder.

• Outlook offers many different views for contacts, including: Business 

Cards, Address Cards, Detailed Address Cards, Phone List, and more.

• You can print contacts in a variety of ways, including booklets and lists.

LESSON 2 Command Summary

Feature Button Task Path Keyboard

Copy to Folder  Edit, Copy to Folder

Delete  Edit Delete Delete , Ctrl ⫹

Export Contacts  File, Import and Export

Import Contacts  File, Import and Export

Move to Folder  Edit, Move to Folder Ctrl ⫹ Shift ⫹ V

New Contact Folder  File, New, Folder

New Contact  File, New, Contact Ctrl ⫹ Shift ⫹ C

New Distribution List  File, New, Distribution List Ctrl ⫹ Shift ⫹

Print Contacts  File, Print Ctrl ⫹ P
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Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 

choice by circling T or F.

 1. You cannot create new contacts while viewing the Inbox.

 2. The default filing for contacts is lastname, firstname.

 3. It is possible to change the appearance of business cards.

 4. An e-mailed business card contains all contact information.

 5. You cannot add addresses to a distribution list that aren’t contacts.

 6. The Import and Export operation is available from the Tools menu.

 7. You can create new contact folders in Outlook.

 8. Some contact printing options work best printed double-sided.

Short Answer Questions
Write the correct answer in the space provided.

 1. Describe some of the possible methods for creating a contact.

 2. Describe two methods for moving from field to field in a contact form.

 3. Under what conditions would the Check Address dialog box appear?

 4. How do you create a contact from an e-mail message header?

 5. How do you get to the Birthday field for a contact when editing?

 6. What are some of the things you can change on a business card?

 7. When wouldn’t you use the vCard file format to send a contact?

 8. What is the default contact view?
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Critical Thinking
Answer these questions on a separate page. There are no right or wrong 

answers. Support your answers with examples from your own experience, 

if possible.

 1. What folders, or address books, would you create for your contacts?

 2. Why wouldn’t you want to send a full contact to someone?

Figure 2-13

 5. Click the Save & Close button .

 6. Print the contact by following these steps:

 a. Verify that the new contact is selected. Click it to select it if it is not.

 b. Click the File menu and select Print.

 c. Select the Card Style print style.

 d. Click the option button labeled Only selected items.

 e.  Verify your printer selection and click the OK button  to print.

Exercise 2-18
Create a contact; send a business card via e-mail.

 1.  Minimize the Navigation pane, if it is not already minimized, by 

clicking the chevrons  at the top of the pane.
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Exercise 2-17
Create and edit a contact; print a contact using Card Style.

 1.  Minimize the Navigation pane, if it is not already minimized, by 

clicking the chevrons  at the top of the pane.

 2.  Switch to Outlook’s Contacts component by clicking the Contacts 

button  on the Navigation bar.

 3.  Click the New button  to open a new contact form.

 4.  Key the information from Figure 2-13 for this contact. Treat the address 

and phone number as business information.



 2.  Switch to Outlook’s Contacts component by clicking the Contacts 

button  on the Navigation bar.

 3.  Click the New button  to open a new contact form.

 4.  Key the information from Figure 2-14 for this contact. Treat the 

addresses and phone numbers as indicated.

Figure 2-14

 5. Click the Save & Close button .

 6.  Send the business card for this contact to your instructor by following 

these steps:

 a.  Right-click the contact you just created and select Send as Business 
Card.

 b. Key your instructor’s e-mail address in the To text box.

 c. Key Exercise 2-18 Business Card in the Subject text box.

 d.  Click the Send button  to send the e-mail with the business card to 

your instructor.

Exercise 2-19
Create a distribution list; send distribution list as a full contact in Outlook 

format.

 1.  Create a new distribution list by following these steps:

    a.  Click the drop-down arrow next to the New button 

 and select Distribution List.

    b.  Key New Prospects as the name of the distribution 

list.

    c.  Click the Select Members button  in the Members 

group on the Ribbon.

 d.  Double-click the listings for Edward Tamm and Melissa Hill to add 

them to the distribution list.

 e. Click the OK button .

 f. Click the Save & Close button.

 2. Send the distribution list to your instructor by following these steps:

 a. Right-click the business card for the distribution list you just created.

 b. Select Send Full Contact.

NOTE

This exercise uses the contacts created 
in Exercises 2-15 and 2-16. Add these 
contacts first if you don’t have them in 

your contact list.
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 c. Select In Outlook Format.

 d. Key your instructor’s e-mail address in the To text box.

 e.  Click the Send button  to send the e-mail with the full contact to 

your instructor.

Exercise 2-20
Create a new Contacts folder; add contacts from the same company; print 

contacts in Card Style.

 1.  While viewing contacts, click the File menu and choose New and then 

Folder.

 2.  In the Name text box of the Create New Folder dialog box, key ISP 
Contacts. Click OK to create the folder and close the dialog box.

 3.  To see the ISP Contacts folder, expand the Navigation bar to display 

the entire Navigation pane by clicking the chevrons button . Click 

ISP Contacts under the My Contacts header. Since this is a new address 

book, it currently has no contacts.

 4.  Create a new contact using the information in Figure 2-15. Leave the 

contact open after you’ve entered the information.

Figure 2-15

 5.  Create a second contact from the same company by following these steps:

 a.  Click the drop-down arrow on the Save & New button on the Ribbon 

. Select New Contact from Same Company.

 b. Key Pat Penrose in the Full Name text box.

 c. Key President in the Job title text box.

 d.  Click the Save & Close button  to save the new contact and close 

the form.

 6.  Click the Save & Close button again  to close the form for your 

original contact.

 7. Print the contacts by following these steps:

 a. Verify that you are viewing the ISP Contacts address book.

 b. Click the File menu and select Print.

 c. Select the Card Style print style.

 d.  Verify your printer selection and click the OK button  to print.
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Lesson Applications

Exercise 2-21
Create contacts; edit contacts; edit electronic business cards; print 

contacts.

 1.  Create the contacts shown in Figure 2-16 in your normal Contacts 

folder. The addresses and phone numbers should be entered in the 

business fields for both contacts.

Figure 2-16

 2.  Edit the contact for Tom Hoover. Key Hoover’s Hardwoods in the 

Company text box. Key President in the Job title text box.

 3.  Switch to the Details fields for Tom Hoover. Key your name in the 

Assistant’s name text box.

 4.  Edit the business card for Tom Hoover to move the phone number under 

the e-mail address. Do this by clicking the entry for Business Phone in the 

Fields list and clicking the Move Field Down button  one time.

 5. Save and close the Tom Hoover contact.

 6.  Edit the contact for Jody Kirk. Key Fine Furniture Finishes in the 

Company name text box. Key Sales Manager in the Job title text box.

 7.  Switch to the Details fields for Jody Kirk. Key your name in the 

Assistant’s name text box.

 8.  Edit the business card for Jody Kirk to move the phone number under 

the e-mail address. Use the same method you used for the other contact.

 9. Save and close the Jody Kirk contact.

 10.  Select the business cards for both contacts. Do this by clicking one of 

the cards and then hold down  while clicking the other. The order in 

which you do this is not important.

 11.  Print the selected contacts in Memo Style. Each will print on its own page.

Exercise 2-22
Create and modify contacts; create a distribution list; send a full contact 

record.

 1.  Create the contacts shown in Figure 2-17 in your normal Contacts 

folder. The addresses and phone numbers should be entered in the 

home fields for both contacts.



 2. Create a distribution list named Media Buyers.

 3.  Add both of the contacts you created in Step 1 to the Media Buyers 

distribution list.

 4. Save and close the Media Buyers distribution list.

 5.  Right-click the Media Buyers distribution list business card and select 

Send Full Contact. Select the Outlook format.

 6. Address the e-mail to your instructor and send it.

 7. Add the job title Media Buyer to both contacts from Step 1.

 8.  Select the business cards for the two contacts created in Step 1. 

Remember to use the ⫹click method to select the second contact.

 9.  With both contacts selected, right-click one and select 

Send Full Contact. Select the Outlook format.

10.  Address the e-mail to your instructor with the subject 

line Media Buyer Contacts. Verify before sending that 

both contacts are listed as attachments. Send the e-mail.

Exercise 2-23
Create contacts; create a secondary address book; move contacts; create a 

distribution list; print contacts.

 1.  Create the contacts shown in Figure 2-18 in your normal Contacts 

folder. The addresses and phone numbers should be entered in the 

business fields for both contacts.

Figure 2-17

TIP

Instead of right-clicking, you can access 
Send Full Contact from the Actions menu 
after both contacts have been selected.

Figure 2-18

 2.  Create a distribution list named All Independent Dealers. Add both of the 

contacts from Step 1 to this list.

 3. Create a new Contacts folder named Independent Dealers.

 4.  Move the two contacts you created in Step 1 into the Independent 

Dealers folder. Move the distribution list you created in Step 4 to the 

same folder.
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 5.  While viewing the Independent Dealers folder, print all items in Small 

Booklet Style. (Hint: Click Yes when prompted about double-sided 

printing.)

 6. Return to viewing your normal Contacts folder.

Exercise 2-24  Challenge Yourself
Create contacts; create a distribution list; print contacts.

You’ve been asked to create contacts for six key employees of AllWood Mills, 

Inc. from the existing phone and e-mail directory information. Once you 

have the contacts created, you are also to create a distribution list for those 

employees and print out their contact information in the form of a booklet.

 1.  Create contacts in your normal Contacts folder for 

the six individuals listed in the telephone and e-mail 

directory in Figure 2-19. All employees are located at 

the same address, but each has a unique telephone 

number and e-mail address. Be sure to include the 

company name and their job titles in their contact 

information.

Figure 2-19

 2.  Create a distribution list for the six contacts you just created named 

Executive Staff. Send this list to your instructor as a full contact using 

the Outlook format.

 3.  Select the six contacts (hint: use the ⫹click method) and print the 

selected items using the Small Booklet Style.

TIP

Use the drop-down arrow beside the 
Save & New button in the contact form to 
select New Contact from Same Company 

after you create the first contact.
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On Your Own

In these exercises you work on your own, as you would in a real-life work 

environment. Use the skills you’ve learned to accomplish the task—and be 

creative.

Exercise 2-25
Create contacts for each of your other instructors in the same manner you 

did in the lesson for your instructor in this class. Create a distribution group 

with an appropriate name that includes your instructors as members. Use 

the distribution list to send a brief greeting to your instructors, explaining 

that it is for a class assignment.

Exercise 2-26
Create contacts for friends and family you would be likely to send a mass 

e-mail to (holiday greetings, party invitations, etc.). Create a distribution list 

for these contacts. Create a new Contacts folder with an appropriate name 

and move both the contacts you’ve created and the distribution list into this 

new folder. Use the distribution list to send a brief note to these contacts.

Exercise 2-27
Open the contact you created for yourself earlier in the lesson. Experiment 

with the various options you have for customizing your electronic business 

card. Use Outlook Help if necessary to further explore these options. 

Customize your business card to make it unique and attractive. Send the 

customized business card to your instructor.

LESSON 2 Contact Management 55
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Unit 1 Applications

Unit Application 1-1
Create and send a new e-mail message with a file attachment and print 

the new e-mail message.

Bob Michols, AllWood’s president, needs some information e-mailed to him 

quickly. He wants a list of all the living-room pieces in this year’s Mission 

collection, plus the Excel file of Mission sales data for the fourth quarter.

 1. Create a new e-mail message, addressing it to your instructor.

 2. For the subject, key Mission Collection information.

 3. In the message area, key:

  Bob:
  Here is a list of Mission living room pieces for the 2007 

season. Note that it includes the three new items. I am 
setting aside time in my calendar next week to meet 
with you. Attached you will find the sales figures for the 
fourth quarter.

 4. Open the Word file Mission1 and copy the list of the living-room pieces to 

the Clipboard. Close the Word file and Word, and paste the contents of the 

Clipboard into the message area below the text you keyed in Step 3.

 5. Add the following items to the list:

Computer workstation
CD storage rack
Writing desk

 6. Attach the Excel file MSalesQ4.

 7. Send the message.

 8. Display the Sent Items folder, and select the message you just sent. 

Print out the message using a Memo Style as the print style.

 9. Hand in the printout to your instructor.

Unit Application 1-2
Create a contact, send a new e-mail message using the contact in the 

Cc field, attach a business card, and print the e-mail message.

You recently met Jon Lopez, the Vice President of Widget Inc. Jon wants 

to collaborate with your company and asked you to e-mail your company 

president to introduce him.

 1. Create a new contact with the following information:

Full Name: Jon Lopez
Company: Widget Inc.
Job title: Vice President

NOTE

Your instructor will provide you with an 
appropriate e-mail address.

UNIT 1 Outlook Basics
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E-mail:  Your instructor will provide you with an 

appropriate e-mail address.

Display as: Jon Lopez, Vice President
Business phone number: 555-6698
Mobile phone number: 555-1123
Address: 55-559 Honolulu St. 

 2.  Create a new e-mail message, addressing it to your instructor.

 3. In the Cc field, key Jon Lopez’s e-mail address.

 4. For the subject, key Collaboration Opportunity.

 5. In the message area, key:

 President Barnes:
  I recently met Jon Lopez, Vice President of Widget Inc., 

and he is carbon-copied on this e-mail message. He is 
hoping that you will contact him regarding potential 
collaboration opportunities. Attached you will find Jon’s 
business card.

 6. Attach Jon Lopez’s business card (contact).

 7. Send the e-mail.

 8. Display the Sent Items folder, and select the message you just sent. Print 

out the message using a Memo Style as the print style.

 9. Hand in the printout to your instructor.

Unit Application 1-3
Send new e-mail messages, forward a received e-mail message, and create 

contact information.

Bob Michols, AllWood’s president, has asked his Vice President of Design to 

create a line of office furniture. The line will use some existing pieces from each 

of the existing collections, as well as new pieces. You’ve been asked to join the 

team working on this project. Your initial tasks will be to exchange information 

with other team members, define responsibilities, and set up meeting times.

 1. Create a new e-mail message, addressing it to your teammate. The 

subject of the message is My contact information.

 2. In the message area, key:

  Here is my contact information for your contact list. I’ve 
included my home address and phone number.

 Name: 
 Address: (Home) 
 Phone: (Home) 
 Phone: (Word, if applicable)

 3. Send the e-mail message.

 4. Display the Sent Items folder, and select the message you just sent. Print 

the message using a Memo Style as the print style.

NOTE

Your instructor will provide you with an 
appropriate e-mail address.

NOTE

This exercise is a team effort. Your 
instructor will assign a classmate to work 
with you as a team member. You will be 
required to exchange e-mail messages 
with your teammate to complete this 
exercise. Your instructor will provide 
e-mail addresses for your teammate.
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 5. Create a new contact for Bob Michols, keying the information below:

Full Name: Bob Michols
Company: AllWood Mills Inc.
Job title: President
E-mail:  Your instructor will provide you with an 

appropriate e-mail address.

Display as: Bob Michols, President
Business phone number: 555-4400
Mobile phone number: 555-4401
Address: 55-580 Honolulu St. 

 6. Open the contact information e-mail message your received from your 

teammate. Forward the message to Bob Michols. Use the To button to 

address the message from your contact list.

 7. Above the original message, key For your records, here is the contact 
information I received.

 8. Send the e-mail message.

 9. Display the Sent Items folder, and select the message you just sent. Print 

the message using a Memo Style as the print style.

Unit Application 1-4  Using the Internet
Pick a friend or relative to whom you’d like to give a gift. The occasion could 

be a holiday or birthday. Think of that person’s hobbies or interests and locate 

Web sites that specialize in those products. For example, the gifts might 

be music CDs, computer games, jewelry, specialty coffees, books, sporting 

goods, and so on.

Choose at least three products, preferably in different price ranges. Do 

comparison shopping on at least four different Web sites selling the same 

or similar product. If possible, note the shipping costs associated with each 

online retailer. Find the contact information for each online retailer in the 

event that you have questions regarding the product. After you’ve obtained 

your information, use Outlook to do the following:

Compose an e-mail message describing the information you’ve obtained, 

addressing it to your instructor. Include the address of the Web site for 

each of the online retailers. Send the message and print a copy of the 

message from the Sent Items folder. Hand the printed copy in to your 

instructor.

Create a contact for each retailer with the information you found on 

the Internet for quick access. Include as much information as possible 

including phone numbers (if applicable).

•

•
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After completing this lesson, you will be able to:

1. Navigate within the Calendar.

2. Schedule appointments, meetings, and events.

3. Send, respond to, and manage meeting requests.

4. Customize your Calendar.

5. Share and view shared Calendars.

MCAS OBJECTIVES

In this lesson:

OL07 2.1.1

OL07 2.1.2

OL07 2.1.3

OL07 2.1.4

OL07 2.1.5

OL07 2.2.1

OL07 2.2.2

OL07 2.2.3

OL07 2.2.4

OL07 2.2.5

OL07 2.3.1

OL07 2.3.2

OL07 2.3.3

OL07 2.3.4

OL07 2.3.5

OL07 2.4.1

OL07 2.4.2

OL07 2.4.3

OL07 2.4.4

OL07 2.5.1

OL07 2.5.2

OL07 2.5.3

OL07 2.5.4

OL07 2.6.1

OL07 2.6.2

OL07 2.6.3

OBJECTIVES

Lesson 3

Managing Scheduling

OL2.3

When your workday is filled and requires managing your schedule, you can 

use Outlook’s Calendar to help you keep track of and plan everything you 

have to do. You can use the Calendar to schedule appointments and events. 

You can set up meetings and invite participants. You can even manage 

invitations and replies to your meetings.

You can set reminders for yourself and easily reschedule when your 

needs change. Outlook also allows you to publish your Calendar to share 

it electronically with others and in turn allows you to subscribe to others’ 

published Calendars.

 Estimated Time: 2 hours
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Navigating Within the Calendar
You can access Outlook’s Calendar from the Outlook menu bar as well as 

from the Navigation pane. As with other Outlook components, the Calendar 

has its own view, and you can access all items associated with the Calendar 

within this view.

Navigating within the Calendar is similar to navigating within other 

components of Outlook. You can use the mouse, keyboard shortcuts, or 

menus to access Calendar functions. You can display the Calendar in a 

variety of time frames, ranging from a single day to an entire month.

Exercise 3-1 NAVIGATE WITHIN THE CALENDAR

The Calendar is divided into several different areas. The Appointments 

Calendar occupies most of the right half of the screen. It divides the day into 

half-hour segments and shows any scheduled appointments, meetings, and 

events. The lower-right portion of the Calendar contains the TaskPad, which is 

a detailed list of current tasks. The upper-left half of the Calendar is the Date 

Navigator, which shows a complete month of the year and has navigation 

arrows for traversing through the Calendar. Just below the Date Navigator 

are two pop-up panes that allow organization by folder and Calendar. There 

is also a pane that shows helpful hints according to your activity.

LESSON 3 Managing Scheduling

Figure 3-1
The Calendar 

provides an easy way 
to track meetings 
and appointments 
to manage your 

schedule
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 1. Switch to Outlook’s Calendar component by clicking on the Calendar 

button  on the Navigation bar. The Calendar view 

appears.

 2. Drag the scroll bar on the right side of the Appointments Calendar to 

display the hours at the beginning and end of the day. The normal 

work hours are shown in white and are displayed by default. Hours 

outside of the normal workday are shown in grey.

 3. In the Date Navigator, click the date of the next business day. Notice 

that the Appointment Calendar changes to that date. The current date 

is shown in a red box. Click the Today button  on the Standard 

toolbar to return to the Appointments Calendar for the present day.

 4. Position the pointer over the current month title at the top of the 

Date Navigator. Click and hold briefly. Notice that you can adjust the 

month by using the displayed menu. You can also click the arrow 

keys next to the month titles to adjust the months sequentially.

 5. Click the Week tab  at the top of the Appointments 

Calendar. The Appointments Calendar displays in a Week view. In 

the Week view, two radio buttons also appear to the right of the Day/

Week/Month tabs in the Appointments Calendar. If the Appointments 

Calendar is in Week view, clicking a day in the Date Navigator will 

change the view to the week containing the date clicked. The view 

will automatically change to a particular Day view when you click 

any date column header in the Appointments Calendar.

 6. Click the Show work week radio button  to view 

the current week excluding weekend days. Click the Show full week 

radio button to view the current week including weekend days. 

Notice that the space available for the display of daily tasks in the 

TaskPad is necessarily limited in this view.

 7. Click on the Month tab  at the top of the Appointments 

Calendar. The Appointments Calendar displays in Month view. Notice 

that the space available for the display appointments is necessarily 

smaller than in previous views, and the TaskPad is no longer displayed.

 8. Click the Day tab  at the top of the Appointments Calendar to 

redisplay the Day view. You can also change the view of the 

Appointments Calendar by using the View menu command.

Creating Appointments, Meetings, 
and Events
An appointment is an activity occurring at a specific day and time that 

does not require inviting people to attend or reserving a room (or other 

resources). For example, a weekly activity with your supervisor could be 

considered an appointment. You can specify that an appointment should 

appear automatically in your Calendar at specified intervals. You can also 

have Outlook remind you of appointments.
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A meeting is an activity that requires inviting others and checking that 

others do plan to attend. For example, a group review activity could be 

considered a meeting. You can send and track invitations to meetings in your 

Calendar.

Exercise 3-2  CREATE A ONE-TIME APPOINTMENT, 
MEETING, OR EVENT

You can add a new appointment by using the Appointment form or by 

entering the appointment directly in the Appointments Calendar.

There are several ways to begin the process of creating an appointment 

in Outlook. You can:

• Press Ctrl  N  while viewing the Calendar.

• Press Ctrl  Shift  A  while viewing any part of Outlook.

• Click the New button while viewing the Calendar.

• Choose Appointment from the drop-down list of the New button.

 1. Switch to Outlook’s Calendar component by clicking on Calendar on 

the Navigation bar. The Calendar view appears.

 2. Click the date on the Date Navigator one week from the current date. 

Notice that the Appointment Calendar automatically displays this 

date.

 3. Click the New button  on the Standard toolbar. The 

Appointment form appears, using the date displayed in the 

Appointments Calendar as the default date for the appointment.

 4. In the Subject field, key Weekly Meeting with Dave.

 5. Press Tab , and in the Location field, key Dave’s Office.

 6. For the Start time, leave the date provided, but change the time to 

10:00 A.M. Notice that the End time is automatically set to 10:30 A.M. 

Leave this time for now.

 7. Click on the Save & Close button .

Exercise 3-3  CREATE A RECURRING APPOINTMENT, 
MEETING, OR EVENT

Appointments that occur repeatedly are recurring appointments. Examples 

of recurring appointments are a weekly status meeting or a monthly haircut.

You can specify a new appointment as a recurring appointment, or you 

can edit an existing appointment to make it recurring. When you create a 

recurring appointment, you define:

• The recurrence pattern, which specifies when the recurrence takes 

place (such as monthly or every Friday).

• The range of recurrence, which specifies how long or for how many 

times the recurrence takes place.

LESSON 3 Managing Scheduling
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 1. Click the next business day from the current date on the Date 

Navigator.

 2. Click the New button to create a new appointment. The Appointment 

form appears.

 3. In the Subject text box, key Dr. Payne.

 4. In the Location text box, key 21 East West Rd., Suite 100.

 5. Set the Start time as 1:00 PM and the End time as 1:30 PM.

 6. Choose None from the Reminder list box.

Figure 3-2
The Reminder list 
box gives quick 

access to the most 
common reminder 

times.

TIP

The reminder for a new appointment is 
preset to 15 minutes. You can choose 
a different reminder period, include a 

sound reminder, or choose no reminder 
at all from this list.

 7.  Click the down arrow on the Show As list box 

 and choose Out of Office. Outlook 

classifies your appointments in different ways, using 

colors and patterns to code the appointment type in 

various views. Out of Office displays a purple border 

on the left side of the appointment.

 8. Click the Recurrence button  on the Appointment form 

toolbar. The Appointment Recurrence dialog box appears.

 9. Under Recurrence Pattern, select the Monthly option, and select 

options so that it occurs the second Friday of every month (“of every 

1 month(s)”).

 10. Under Range of recurrence, select End after, and key 6 for the 

number of occurrences.
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 11. Click the OK button .

 12. Click the Save & Close button. The new appointment is scheduled as 

a monthly recurring appointment.

 13. Select the date in the Date Navigator of the first occurrence of this 

appointment. The appointment in the Appointments Calendar 

displays a recurrence icon on each instance of this event in the 

Calendar.

Exercise 3-4  CREATE AN APPOINTMENT, MEETING, 
OR EVENT FROM AN E-MAIL MESSAGE

Sometimes you may wish to create an appointment concerning the content 

of an e-mail that you receive.

 1. Click the Mail button  on the Navigation bar. The Mail 

view appears.

 2. If the To-Do Bar is not visible, then from the menu bar, click the View 

menu and then click the To-Do Bar menu item. From the submenu 

that appears next to the To-Do Bar menu item, click Normal. Click 

and drag one of the e-mails in the Inbox pane to the next business 

day in the To-Do Bar pane. The Appointment form appears.

 3. In the text area you will see information and content from the e-mail 

that was used to create this appointment.

 4. In the Location text box, key My Office.

 5. Set the Start time as 2:00 P.M. and the end time as 2:30 P.M.

 6. Click the Save & Close button. The e-mail is saved as a new 

appointment in your Calendar.

Exercise 3-5  CREATE AN APPOINTMENT, MEETING, 
OR EVENT FROM A TASK

Sometimes you may wish to create an appointment concerning a task to give 

the task some specified work time and place in your schedule. Let’s create a 

new task and then put it into our schedule.

 1. Click Calendar on the Navigation bar. The Calendar view appears.

 2. Click the arrow beside the New button in the Toolbar and choose 

Task from the menu that appears. The Task form appears.

 3. In the Subject text box, key Paint a still life.

 4. Change the start and end date to today’s date.

 5. Click the Save & Close button. The task appears in the task list for 

today. That means this task is due today, so you should schedule 

some time for it.
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 6. Click and drag the task from the task pane to the 3 P.M. slot in the 

Appointments View. A 30-minute appointment is scheduled for 

the task at 3 P.M. in your Calendar. At this point, you can open 

the appointment and make any necessary edits.

 7. Double-click the new appointment. The Appointment form appears. 

In the text area you will see information about the task that was 

used to create this appointment.

 8. In the Location text box, key The Park.

 9. Click the Save & Close button. The Calendar view appears.

Exercise 3-6  MARK AN APPOINTMENT, MEETING, 
OR EVENT AS PRIVATE

You can also mark appointments as private so that the subject of the 

appointment is hidden from individuals who have access to your Calendar. 

The word “Private” appears instead of the actual subject. You can mark an 

appointment as private by editing the appointment and selecting the Private 

button on the Appointment form toolbar.

 1. Click Calendar on the Navigation bar. The Calendar view appears.

 2. Click the date on the Date Navigator one week from the current date. 

Notice that the Appointment Calendar automatically displays the 

selected date. You should now see the appointment created in 

Exercise 3-2.

 3. Click once on the Appointment to select it. The border around the 

appointment changes to a thick black line with handles to show it is 

selected.

 4. In the menu bar, click the File menu and then click the Open menu 

item. From the submenu that appears next to the Open menu item, 

click Selected Items. The Appointment dialog box appears.

 5. Click to select the Private button  in the Appointments form 

toolbar. The Private button will be highlighted.

 6. Click the Save & Close button. The Calendar view appears.

 7. A lock icon appears on the Appointment indicating that the 

Appointment is private.

Sending Meeting Requests
A meeting is an activity that involves inviting other people or reserving 

resources. A resource might be a conference room, audiovisual equipment, 

or other shared organizational space or equipment used for meetings. You 

can use Outlook to plan your meetings and invite the meeting participants.

You can send and track invitations to meetings in your Calendar. 

Sometimes meetings should not be held unless some key individuals attend. 

Sometimes you may want to invite an individual, but the meeting will go on 
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whether they attend or not. You may also want to plan a meeting according 

to others’ availability. Outlook provides methods of scheduling these types 

of meetings and also methods of tracking the responses and scheduling the 

needed resources for a meeting. Let’s explore these methods.

Exercise 3-7  PLAN A MEETING AND INVITE 
MANDATORY ATTENDEES 
TO THE MEETING

Planning a meeting involves finding an available time in your schedule for the 

meeting and inviting the meeting attendees. Outlook notifies the individuals 

via e-mail of your meeting request.

 1.  Switch to Outlook’s Calendar component by clicking 

on Calendar on the Navigation bar. The Calendar 

view appears.

 2.  Display the Appointments Calendar for a business 

day your instructor has assigned for you within the 

next three weeks. Delete any previous appointments 

for that day.

 3.  Choose Actions, Plan a Meeting from the menu. The 

Plan a Meeting form appears. Appointments are color-

coded. You can use the scroll bar under the time grid 

to adjust the times and days shown on the grid.

NOTE

You will be using the names and e-mail 
addresses of your classmates to invite to 
your meeting. Your instructor will provide 

you with a list of names and e-mail 
addresses. Because you will be inviting 
each other to your meetings, you will 
need to select a day for your meeting 

that is not in conflict with other students’ 
meetings. Your instructor will assign a 

date for you to use.

Figure 3-3
The Plan a Meeting 

form allows 
comparison of free 

times across multiple 
Calendars

 4. Click various time blocks on the time grid. The shaded column with 

a green left-border and red right-border represents the selected 

meeting time for all attendees, and it moves in the time grid as you 
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click a different block. Notice that the times shown in the Meeting 

start time and Meeting end time fields change as you click locations 

in the time grid. You can also use these fields to manually specify the 

starting and ending times of the meeting.

 5. Click a time block under 2:00 so the meeting is set to run from 

2:00 P.M. to 2:30 P.M.

 6. Position the pointer over the red border of the shaded column and 

drag to expand the highlighted column to 3:00. The meeting is now 

1 hour long, from 2:00 P.M. to 3:00 P.M.

 7. In the All Attendees list, your name and e-mail address are listed as 

the first attendee because you are calling the meeting. The first row 

under your name contains the text “Click here to add a name.” Click 

on this row and key in your first invitee, Classmate 1 <[name]@[ISP]>.

 8.  There are two columns to the left of the attendees’ 

names in the All Attendees list. The first column 

contains a check box to send an e-mail about the 

meeting to the attendee. Clicking in the second 

column allows you to specify whether this row is a 

required attendee, optional attendee, or resource.

 9.  Click the column to the left of the row in which you keyed 

Classmate 1, and choose Required Attendee from the pop-up menu. 

Note that you can distinguish between required meeting attendees 

and optional ones, and between attendees and resources.

10.  In the All Attendees list, the next row under the one where you keyed 

Classmate 1 now contains the text “Click here to add a name.” Click on 

this row and key in your second invitee, Classmate 2 <[name]@[ISP]>.

11.  Click the column to the left of the row in which you keyed 

Classmate 2, and choose Required Attendee from the pop-up menu. 

There are two names in addition to yours in the All 

Attendees list. If you invite individuals who have made 

their Calendars available to others, you can see if they 

are free at the time you select. However, the individuals 

you’ve invited have not made their Calendars available, 

so their schedules show the No Information code.

 12. Click the Make Meeting button  in the Plan a Meeting 

form. The Meeting form appears. The attendees’ names appear in the 

To field automatically.

 13. In the Subject field, key Discuss conference topics.

 14. In the Location field, key My Office.

 15. In the large text box in the lower half of the form, key Go over major 

topics and discuss PowerPoint slide show material.

 16. Click the arrow beside the Reminder bell in the Meeting form and 

choose None.

NOTE

Use the e-mail address from the list of 
valid e-mail addresses your instructor 

has provided you. You will send meeting 
requests to your classmates via e-mail.

NOTE

Use an e-mail address from the list of 
valid e-mail addresses your instructor has 

provided you.
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 17. Connect to the Internet and click the Send button  on the Meeting 

form to send the invitations to the specified recipients.

 18. Click the Close button  to close the Plan a Meeting dialog 

box. The meetings is added to your Appointments Calendar.

Exercise 3-8  INVITE OPTIONAL ATTENDEES 
TO MEETINGS

You can invite an individual whose attendance is optional for the meeting to 

take place.

 1. Click once on the appointment you created in Exercise 3-7 in 

your Appointments Calendar to select it. The border around the 

Appointment changes to a thick black line to show it is selected.

 2. In the menu bar, click the File menu and then click the Open menu 

item. From the submenu that appears next to the Open menu item, 

click Selected Items. The Meeting form appears.

 3. Click the Scheduling button  in the Meeting form toolbar. The 

Meeting form will change to show the Attendees list and the 

Scheduling pane.

 4. In the All Attendees list, the next row under the one where you keyed 

Classmate 2 now contains the text “Click here to add a name.” Click 

on this row and key in your third invitee, Classmate 3 <[name]@[ISP]>.

 5.  Click the column to the left of the row in which you keyed Classmate 

3, and choose Optional Attendee from the pop-up menu. There are 

now three names in addition to yours in the All 

Attendees list. If you invite individuals who have made 

their Calendars available to others, you can see if they 

are free at the time you select. However, the individuals 

you’ve invited have not made their Calendars available, 

so their schedules show the No Information code.

 6. In the All Attendees list, click on the text Classmate 1.

 7. Press Delete . Classmate 1 is eliminated from the list of meeting 

attendees.

 8. Click the Send button above the attendees list. The Send Updates to 

Attendees dialog box appears. In this dialog box, you have the 

options of resending the request to all attendees or only to the ones 

that have been added or deleted.

 9. Select Send updates only to added or deleted attendees if it is not 

already selected, and then click OK. The Meeting form closes. 

Outlook sends a meeting request to Classmate 3 and notifies 

Classmate 1 that the meeting is canceled.

NOTE

Use an e-mail address from the list of 
valid e-mail addresses your instructor has 

provided you.
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Exercise 3-9  DETERMINE WHEN ATTENDEES 
ARE AVAILABLE TO MEET USING 
GROUP SCHEDULES

A group schedule gives you one place to track the Calendars of several people. 

To use group schedules, all the members of the group must be on a Microsoft 

Exchange network. In the Scheduling view of the Meeting form, you can use 

Smart Scheduling to find mutual meeting times.

 1. In the Calendar view, click the Actions menu and then click the 

View Group Schedules menu item. The Group Schedules dialog box 

appears.

Figure 3-4
The Group 

Schedules dialog 
box allows creation 
of common groups 

of individuals’ default 
Calendars

 2. Click the New button .

Figure 3-5
The Create New 
Group Schedule 

dialog box is used to 
name Groups
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 3. In the Create New Group Schedule dialog box, type a name for this 

group schedule, and click OK. A form appears for setting up your 

Group.

Figure 3-6
The Group settings 
form allows you to 
add contacts with 
shared Calendars

 4. Click the Add Others button  and click the Add from 

Address Book item to open the Select Members dialog box.

 5. Double-click the names you want in the group schedule.

 6. Click OK when you have chosen all the names you want.

 7. Click the Make Meeting button  and chose New 

Meeting.

 8. In the Subject field, key Invitation.

 9. Click the Scheduling tab  in the Show section of the 

Meeting form toolbar.

 10. Click the AutoPick Next button  to find the next 

available time among all the schedules included in the group. If the 

time chosen is not satisfactory, then continue to click AutoPick Next 

to find the next available time in the Group Schedules.

 11. Connect to the Internet and click the Send button  on the 

Meeting form to send the invitations to the specified recipients.

 12. Click the Save and Close button  to close the Group 

Settings dialog box. The meeting is added to your Appointments 

Calendar.
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Exercise 3-10  TRACK RESPONSES TO MEETING 
REQUESTS

As you have learned, you can send out invitations for a meeting. You can 

also track those responses and even allow or disallow new time propositions 

from your invitees.

 1. Click once on the appointment you created in Exercise 3-7 in 

your Appointments Calendar to select it. The border around the 

Appoint ment changes to a thick black line with handles to show it is 

selected.

Figure 3-7
A selected 

appointment in 
the Appointments 
Calendar appears 
with a thick border 

and handles

 2. In the menu bar, click the File menu and then click the Open menu 

item. From the submenu that appears next to the Open menu item, 

click Selected Items. The Meeting form appears.

 3. Click the Scheduling button in the Meeting form toolbar. The 

Meeting form will change to show the Attendees list and the 

Scheduling pane.
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 4. You should see an Attendees tab  in the toolbar of the Meeting 

form. This section of the toolbar contains the Responses tool. The 

Responses tool allows you to Request Responses and also Allow New 

Time Proposals from your invitees.

 5. Click on the Responses tool  and verify that Request Responses 

is checked.

 6. Click on the Responses tool  and uncheck Allow New Time 

Proposals.

 7. Click on the Responses tool  again to verify that Request Responses 

is checked and that Allow New Time Proposals is unchecked.

 8. Press Ctrl  S  to save your response changes.

 9. Close the window 

Exercise 3-11 SCHEDULE ATTENDEES AND 
MEETING RESOURCES FROM 
YOUR ADDRESS BOOK

If office resources are set up for reservations using Outlook, booking a 

resource is the same as requesting a meeting with an individual.

 1.  Using the skills you learned in Unit 1, Lesson 2, 

switch to the Contacts component and create contact 

cards with the names and e-mail addresses of your 

classmates from the list provided by your instructor.

 2.  Select a day in your Appointment Calendar roughly 

two weeks in advance of the current date.

 3. Select 4 PM.

 4.  In the menu bar, click the Actions menu and then 

click the Plan a Meeting menu item. The Plan a 

Meeting dialog box appears. (See Figure 3-3.)

 5. Click Add Others and then select Add from Address Book from the drop-

down menu. The Select Attendees and Resources dialog box appears.

NOTE

You will be using the names and e-mail 
addresses of your classmates to invite to 
your meeting. In previous exercises you 
have used direct entry. For this exercise, 
you will create contact cards for each of 
your classmates in the Outlook Contacts 
component. Your instructor will provide 

you with a list of names and e-mail 
addresses.

Figure 3-8
From the Plan 

a Meeting form 
you have access 
to functions like 

selecting attendees
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 6. Select the name of a resource (for example, a conference room) from 

your contact list.

 7. Click the Resources button  at the bottom of the Select 

Attendees and Resources dialog box to add this item as a resource to 

your meeting. Resources are much the same as contacts; they have a 

name and e-mail address and are listed in your Address Book. You 

can also schedule them in the same way as with attendees.

 8. Select the name of an attendee from your contact list.

 9. Click the Required button  at the bottom of the Select 

Attendees and Resources dialog box to add this item as a Resource 

to your meeting.

 10. Click OK and you are returned to the Plan a Meeting dialog. 

(See Figure 3-3.)

 11. Click the Make Meeting button  in the Plan a Meeting 

form. The Meeting form appears. The attendees’ names appear in 

the To field automatically.

 12. In the Subject field, key Discuss Expo.

 13. In the Location field, key My Office.

 14. In the large text box in the lower half of the form, key Go over major 

display ideas.

Figure 3-9
The Select 

Attendees and 
Resources: Contacts 

dialog box allows 
quick destination 

of contacts in your 
address book as 

required, optional or 
resources for your 

meetings
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 15. Click the Reminder list box  beside the Reminder bell in 

the Meeting form and choose None.

 16. Connect to the Internet and click the Send button  on the Meeting 

form to send the invitations to the specified recipients.

 17. Click the Close button  to close the Plan a Meeting dialog box. The 

meeting is added to your Appointments Calendar.

Updating, Canceling, and Responding 
to Meeting Requests
Once a meeting has been scheduled there are several ways to modify or 

cancel the meeting time. Even the attendees can request these changes to the 

meeting if you allow them.

Exercise 3-12 CHANGE A MEETING TIME

Planning a meeting involves finding an available time in your schedule, but 

you may wish to change a meeting time after it has been scheduled.

 1. Click the Calendar button  on the Navigation bar. The 

Calendar view appears.

 2. Using the Date Navigator, find the “Paint a still life” appointment 

created in Exercise 3-5.

 3. Click and drag this appointment to another place on your schedule. 

The appointment is now rescheduled for the new time slot.

Exercise 3-13  CHANGE A MEETING TIME AND SEND 
AN UPDATE TO ALL ATTENDEES

Planning a meeting involves finding an available time in your schedule, but 

you may wish to change a meeting time after it has been scheduled.

 1. Click the Calendar button  on the Navigation bar. The 

Calendar view appears.

 2. Click the date on the Date Navigator one week from the current date. 

Notice that the Appointment Calendar automatically displays the 

selected date. You should now see the appointment created in 

Exercise 3-2. Select this appointment.

 3. Click once on the appointment to select it. The border around the 

appointment changes to a thick black line to show it is selected.

 4. In the menu bar, click the File menu and then click the Open menu 

item. From the submenu that appears next to the Open menu item, 

click Selected Items. The Meeting form appears.
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 5. Set the Start time to one hour earlier. Note that the End time also 

changes to maintain the original meeting length.

 6. Click the Send Update button . The Calendar view appears.

Exercise 3-14  RESPOND TO AN INVITATION

Meeting invitations appear in the recipients’ Inboxes. The associated icon 

for the mail in the Inbox indicates it as a meeting request. You can reply to a 

meeting request in one of four ways:

• Accept: Outlook creates an item on your Calendar and marks the time 

as busy.

• Tentative: Outlook creates an item on your Calendar and marks the 

time as tentative.

• Decline: Outlook creates an item in your Deleted Items folder.

 1. Click on the Mail button  in the Navigation bar. The Mail 

view appears.

 2. Click the Send/Receive button  on the Standard toolbar 

to get your messages from your mail server. Meeting invitations 

appear in the Inbox like other mail items, but the icon for the item 

shows it as a meeting. (You might receive more than one meeting 

invitation, depending on how many of your classmates invited you to 

their meetings.)

 3. Open the message “Discuss conference topics.” The Meeting form 

appears. You can use the toolbar buttons to accept an invitation, 

tentatively accept, or decline.

 4. To send your response with no comments, click Send The Response 

Now. Click OK.

 5. To include comments with your response, click Edit The Response 

Before Sending.

 6. Type your comments and click Send.

 7. To send no response, click Don’t Send A Response, and click OK. The 

meeting is added to your Calendar.

Exercise 3-15 PROPOSE A NEW MEETING TIME

You may receive a meeting request that you wish to attend, but the current 

meeting time may not be agreeable. You may want to request another time 

for the meeting. The meeting organizer can accept or decline your proposal 

to reschedule the meeting.

 1. From the Mail view, open a meeting request in your Inbox. In the 

open meeting request, on the Message tab, in the Respond group, 

click Propose New Time.
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 2.  If you are in the Calendar view, open the meeting 

from the Calendar and on the Appointment tab, in 

the Respond group, click Propose New Time.

 3.  Click either Tentative and Propose New Time or 

Decline and Propose New Time. The Propose New 

Time dialog box appears.

 4.  Find a time in the schedule when all invitees are 

available.

 5. Click on Propose Time.

 6. Click Send.

Exercise 3-16  MODIFY ONE INSTANCE OF A 
RECURRING MEETING

You previously established a meeting that occurs on the second Friday of 

each month. Two months from now, you may have a conflict that requires 

rescheduling of the appointment for that month, but you will return to the 

normal schedule thereafter.

 1. Click the Calendar button  on the Navigation bar. The 

Calendar view appears.

 2. Use the Date Navigator to go forward two months from the current 

date and locate the recurring meeting for the second Friday of each 

month.

 3.  Double-click this appointment. The Open Recurring 

Item dialog box appears.

 4. Select the Open this occurrence option and click OK.

 5.  Set the Start time to three hours later. Note that the 

End time also changes to maintain the original 

meeting length.

 6. Click the Save & Close button . The Calendar view appears and the 

appointment is located three hours later on the schedule.

 7. Use the Date Navigator to go forward to the next month from the date 

you modified and locate the recurring meeting for the second Friday 

of each month. This appointment is at the originally scheduled time.

Exercise 3-17  ADD A MEETING ATTENDEE 
AND SEND AN UPDATE ONLY 
TO NEW ATTENDEES

Sometimes you may want to add someone to a meeting and notify them, but 

not send too many messages to the group as a whole.

 1. Click the Calendar button  on the Navigation bar. The 

Calendar view appears.

NOTE

The meeting creator must check Allow 
New Time Proposals as a Responses 
option when creating this meeting 

request for the Propose New Time option 
to appear.

NOTE

If you wish to modify every instance in 
the entire series with your changes, you 

would select Open the series.
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 2. Click the date on the Date Navigator one week from the current date. 

Notice that the Appointment Calendar automatically displays the 

selected date. You should now see the appointment modified in 

Exercise 3-8. Select this appointment.

 3. Click once on the appointment to select it. The border around the 

appointment changes to a thick black line to show it is selected.

 4. In the menu bar, click the File menu and then click the Open menu 

item. From the submenu that appears next to the Open menu item, 

click Selected Items. The Meeting form appears.

 5.  Click the Scheduling button  in the Meeting form 

toolbar. The Meeting form will change to show the 

Attendees list and the Scheduling pane.

 6.  In the All Attendees list, the next row under the one 

where you keyed Classmate 3 now contains the text 

“Click here to add a name.” Click on this row and key 

in your fourth invitee, Classmate 4 <[name]@[ISP]>.

 7. Connect to the Internet and click the Send button  on the Meeting 

form. The Send Update to Attendees dialog box appears.

 8. Click the Send updates only to added or deleted attendees option and 

click OK. The Calendar view appears.

Exercise 3-18  CANCEL A MEETING AND NOTIFY 
ATTENDEES

At some point you may want to cancel a meeting that you 

have scheduled.

 1.  Click the Calendar button  on the 

Navigation bar. The Calendar view appears.

 2.  Click the Today button  on the Standard toolbar.

NOTE

Use an e-mail address from the list of 
valid e-mail addresses your instructor has 

provided you.

NOTE

To quickly jump to a date and view 
a date other than today, use the key 

combination Ctrl  G  to get the Go To 
Date dialog box.

Figure 3-10
The Go To Date 

dialog box allows 
you to specify a 

date and a view for 
the Appointments 

Calendar.

 3. Click the date on the Date Navigator one week from the current date. 

Notice that the Appointment Calendar automatically displays the 

selected date. The Appointment Calendar shows the appointment 

created in Exercise 3-2.
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 4. Click once on the appointment to select it. The border around the 

appointment changes to a thick black line to show it is selected.

 5. In the menu bar, click the File menu and then click the Open menu 

item. From the submenu that appears next to the Open menu item, 

click Selected Items. The Meeting form appears.

 6. Click the Cancel Meeting button  in the Actions tab of the Meeting 

form toolbar. The Meeting form will change to show a Send 

Cancellation button.

 7. Click the Send Cancellation button . The Meeting form will close 

and the Calendar view will appear.

Customizing Calendar Settings
You can customize the Calendar to work better for you in many ways. You 

can change the way the Calendar displays time intervals, the way that it 

works with time zones, and you can add predefined holidays.

Exercise 3-19 DEFINE YOUR WORK WEEK

The Calendar allows you to define your normal work week in terms of the 

days it contains and when it starts, the normal start and end times of your 

working day, and what you consider the first week of the year.

 1. Click the Calendar button  on the Navigation bar. The 

Calendar view appears.

 2. In the menu bar, click the Tools menu and then click the Options 

menu item. The Options dialog box appears.

 3. Click the Calendar Options button  in the Options 

dialog box. The Calendar Options dialog box appears.

 4. Put checks in the boxes next to the days of the week that are your 

workdays and clear the checks from the boxes next to the days of the 

week that are not workdays.

 5. Click the down arrow next to First Day of the Week to select the day of 

the week you want considered as the first day of the week if it is other 

than Sunday. The weeks in the Date Navigator will begin with this day.

 6. Click the down arrow next to First Week of Year to choose a definition 

for the first week of the year if it does not begin January 1. If you turn 

on week numbering, week number 1 is defined in this manner.

 7. Click the down arrow next to Start Time to choose the normal start 

time for your working day if it is other than 8:00 A.M.

 8. Click the down arrow next to End Time to choose the normal end 

time for your working day if it is other than 5:00 P.M. In the Day and 

Week views, non-working hours are blue, while working hours are 

pale blue by default. You can set other options from this panel that 

affect the colors, prompts, and behaviors of your Calendar.
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 9. Click the OK button to apply your settings to your Calendar. The 

modified Calendar view appears.

Exercise 3-20 SETTING TIME ZONES

You can choose up to two time zones to display. You can define and name 

your current time zone, as well as an additional one, if you choose. This is 

helpful for moving appointments if you have moved to a new time zone.

 1. Click the Calendar button  on the Navigation bar. The 

Calendar view appears.

 2. In the menu bar, click the Tools menu and then click the Options 

menu item. The Options dialog box appears.

 3. Click the Calendar Options button  in the Options 

dialog box. The Calendar Options dialog box appears.

Figure 3-11
The Options dialog 
box is for setting 

options in all of the 
Outlook modules
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Figure 3-12
The Calendar 

Options dialog box 
is where you set 
options, such as 

defining your work 
week, time zone, and 

holidays.

 4. Click the Time Zone button  in the Calendar 

Options dialog box. The Time Zone dialog box appears.

Figure 3-13
The Time Zone 

dialog box allows 
you to set up an 

alternate time zone 
for your Calendar

 5. If you are going to use two time zones, click in the Label field, and 

type a name to identify the current time zone appearing in the Time 

Zone drop-down list.
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 6. Click the checkbox next to Show An Additional Time Zone to add a 

second time zone.

 7. Click in the Label text box, and type a name identifying this second 

time zone.

 8. Click the down arrow for the Time Zone list box to display a list of 

time zones from which you can choose.

 9. Click the checkbox next to Adjust For Daylight Saving Time if it 

applies to either time zone you have selected.

 10. Click the Change Calendar Time Zone button  to 

switch time zones, if you have permanently moved to a new time 

zone.

 11. Click the Swap Time Zones button  to swap which time 

zone is on the left.

 12. Click the OK button to apply your settings and close the Time Zone 

dialog box.

 13. Click the OK button to close the Calendar Options dialog box and 

click the OK button again to close the Outlook Options dialog box. 

Both times zones appear on your Calendar grid.

Exercise 3-21  ADD PREDEFINED HOLIDAYS 
TO THE CALENDAR

You can set up your Calendar to display the holidays that you observe.

 1. Click the Calendar button  on the Navigation bar. The 

Calendar view appears.

 2.  In the menu bar, click the Tools menu and then click the Options 

menu item. The Options dialog box appears.

 3.  Click the Calendar 

Options button 

 in the 

Options dialog box. The 

Calendar Options dialog 

box appears.

 4.  Click the Add Holidays 

button  in 

the Calendar Options 

dialog box. The Add 

Holidays to Calendar 

dialog box appears.

Figure 3-14
The Add Holidays to 
Calendar dialog box 
allows selection of 
various holiday sets 
for addition to your 

Calendar



LESSON 3 Managing Scheduling
O

u
tlo

o
k
 2

0
0
7

83

 5.  Click the checkbox for each of the country and/or religious 

holidays that you want added to your Calendar.

 6.  Click OK to close the Add Holidays to Calendar dialog box. 

A dialog box appears briefly showing that the holidays are being 

added.

 7. Click the OK button to apply your settings and close the Time Zone 

dialog box.

 8. Click the OK button to close the Calendar Options dialog box 

and click the OK button again to close the Outlook Options 

dialog box.

Sharing Your Calendar with Others
There are several ways to share your Calendar with others. You can send a 

Calendar via e-mail or share your default Microsoft Exchange Calendar with 

others on the same server. As you are choosing the Calendar to send, you can 

also set your privacy settings to better suit your needs.

Exercise 3-22  CONFIGURE FREE/BUSY PRIVACY 
SETTINGS

If you and your coworkers are part of a Microsoft Exchange network, are 

willing to share your schedules over the Internet, or can all access a common 

server, you can store your free/busy times and make them available to each 

other to schedule meetings and other times together. In this case, requests 

for meetings will be handled automatically. The request will be matched 

against the group’s free/busy schedule and meetings will be scheduled at 

available times.

 1. To set up the free/busy options in your Calendar, click the Calendar 

button  on the Navigation bar. The Calendar view 

appears.

 2. In the menu bar, click the Tools menu and then click the Options 

menu item. The Options dialog box appears.

 3. Click the Calendar Options button  in the Options 

dialog box. The Calendar Options dialog box appears.

 4. Click the Free/Busy Options button  in the 

Calendar Options dialog box. The Free/Busy Options dialog box 

appears.
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Figure 3-15
The Free/Busy 

Options dialog box 
allows you to set 
how far into the 

future your schedule 
is revealed when 
others check your 

free time.

 5. In the Publish field, type the number of months of free/busy 

information you want to store on the server.

 6. In the Update Free/Busy Information field, enter how often you want 

the server to update your information.

 7. Click the checkbox next to Publish at my location, and enter the URL 

of your Internet Calendar if that applies to your situation.

 8. In the Search location field, type the URL of the servers on which 

you want Outlook to find the free/busy information of others.

 9. Click OK to return to the Calendar Options dialog box.

Exercise 3-23  SHARE YOUR CALENDAR WITH 
OTHER OFFICE OUTLOOK 2007 
USERS ON YOUR NETWORK

If you and your coworkers are connected to a Microsoft Exchange server, 

you can share your Calendars with each other.

 1. On the Navigation bar, in the Calendar area, click the Share My 

Calendar link. The E-mail form appears.

 2. In the To field, type the name of the person to whom you are 

granting access to your calendar.

 3. In the Subject field, type a subject for your e-mail.

 4. Click the checkbox next to Allow Recipient To View Your Calendar.
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 5. Click the checkbox next to Request Permission To View 

Recipient’s Calendar, if you want to request access to their 

Calendar as well.

 6. In the e-mail body text area, type any additional information.

 7. Click Send.

 8. A confirmation dialog box will appear. If all of the information 

appears correct, click OK to close the dialog box.

Exercise 3-24  SEND YOUR CALENDAR 

INFORMATION IN AN E-MAIL 

MESSAGE

You can send any Calendar you own to another in the body of an e-mail 

message. The person receiving the Calendar will see a snapshot of your 

Calendar at a given moment in time. If the recipient uses Outlook 2007, he 

or she can open the Calendar snapshot as an Outlook Calendar and display it 

either side-by-side or as an overlay with any other Calendars. The downside 

of using a Calendar snapshot is, of course, that the Calendar you send is 

not automatically updated when you make changes. If the e-mail recipient 

needs a regularly updated Calendar, consider other publishing options, such 

as sharing via an Exchange server, if one is available at your office.

 1. On the Navigation bar, in the Calendar area, click the Send A 

Calendar Via E-mail link. The Send a Calendar via E-mail dialog box 

appears.

Figure 3-16
The Send a Calendar 
via E-mail dialog box 
allows you to select 
the kind of Calendar 
information that will 

be sent in your 
e-mail



UNIT 2 Managing Your Schedule and Tasks
O

u
tl

o
o
k
 2

0
0
7 86

 2. Click the arrow on the Calendar pop-up menu, and choose the 

Calendar that you want to e-mail.

 3. Click the arrow on the Date Range pop-up menu, and choose the 

time period for which you want to send the Calendar.

 4. Click the arrow on the Detail pop-up menu, and choose the type of 

Calendar information you want to send. You can choose Show 

Availability only, Limited Details, or Full Details.

 5. If your choice is Availability Only, click the checkbox labeled Show 

Time Within My Working Hours Only, if that is what you want.

 6. Click the Set working hours link to display the Calendar Options 

dialog box and change your working hours. Close the Calendar 

Options dialog box if you opened it. (See Figure 3-12.)

 7. For Advanced, click the Show button  and if you want 

these options, check the checkboxes for Include Details Of Items 

Marked Private and/or Include Attachments.

Figure 3-17
The Send a Calendar 

via E-mail dialog 
box with Advanced 

options showing

 8. Click the arrow on the E-mail Layout pop-up menu, and choose 

either the Daily Schedule or List Of Events format.

 9. Click OK to close the dialog box.
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 10. In the To field, type the e-mail address of the person to whom you 

are sending to your Calendar.

 11. Click the Send button .

Exercise 3-25  PUBLISH YOUR CALENDAR 
INFORMATION TO OFFICE ONLINE

Microsoft offers a publishing service for your Calendars. This method does 

not require Microsoft Exchange for either the user or the owner of the 

Calendar. The first time you use the service, you must register using your 

Microsoft Windows Live ID account. If you don’t yet have an account, you 

may follow the instructions on the screen to obtain one for free.

 1. On the Navigation bar, in the Calendar area, click the Publish My 

Calendar link. Go through the registration procedure, if needed. The 

Publish Calendar To Microsoft Office Online dialog box appears.

Figure 3-18
The Microsoft Office 
Online Registration 

assistant
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Figure 3-19
The Publish Calendar 
to Microsoft Office 

Online dialog 
box allows you to 
select what kind 
of information in 
your Calendar is 
published online

 2. Click the arrow on the Detail pop-up menu, and choose the type of 

Calendar information you want to send. You can choose Show 

Availability only, Limited Details, or Full Details.

 3. If your choice is Availability Only, click the checkbox labeled Show 

Time Within My Working Hours Only if that is what you want.

 4. Click the Set working hours link to display the Calendar Options 

dialog box (see Figure 3-12) and change your working hours. Close 

the Calendar Options dialog box if you opened it.

 5. Under Permissions, click either Only invited users can view this 

calendar if you want to allow access to your Calendar by invitation 

only. Click Anyone can view and search for this calendar on Office 

Online if you want to share your Calendar with anyone on the 

Internet.

 6. Click the Advanced button  to show the Published 

Calendar Settings dialog box.
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 7. Under Upload Method, click Automatic Uploads if you want Outlook 

to periodically update your published Calendar automatically. Click 

Single Upload if you do not want to have your Calendar updated 

automatically.

 8.  Under Private Items, click the checkboxes labeled 

Include Details Of Items Marked Private.

 9.  Under Update Frequency, check Update this Calendar 

to use the server’s recommended frequency for 

updates.

10.  Click OK to close the Published Calendar Settings 

dialog box.

 11. Click OK to close the Published Calendar to Microsoft Online dialog 

box and publish your Calendar.

 12. After your Calendar has been successfully published, a dialog box 

will appear asking if you wish to create an e-mail announcing your 

Calendar’s availability. Click Yes to create the e-mail or click No to 

close the dialog box.

Viewing Other Calendars
Calendars are available on the Web through Internet standards and within 

companies via Microsoft Exchange servers. There are many ways in which 

you can view and integrate other Calendars into your Calendar view to make 

your scheduling more efficient. You can choose multiple Calendars from the 

Navigation pane for view and you can switch from the standard side-by-side 

view to the overlay view.

Figure 3-20
The Published 

Calendar Settings 
dialog box allows 

you to set the 
frequency, upload 

pattern, and security 
for your online 

Calendar

NOTE

 If you choose Availability Only in the 
Detail section of the dialog box, then the 
Private Items section will not appear. For 

all other Detail choices, it appears.
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Exercise 3-26  VIEW A CALENDAR SHARED BY 
ANOTHER OFFICE OUTLOOK 2007 
USER ON YOUR NETWORK

If your business is using a Microsoft Exchange server and you have an 

account, you can quickly view another person’s shared default Microsoft 

Exchange Calendar from the Navigation pane.

 1.  On the Navigation bar, in the Calendar area, click 

the Open a Shared Calendar link. The Open a Shared 

Calendar dialog box appears.

 2.  In the Name field, type the name of the person’s 

Calendar you wish to view, or click the Name button 

and select a name from the Address Book dialog 

box.

 3.  Click OK to close the dialog box. The shared 

Calendar appears next to any Calendar that is 

already in the view. The shared Calendar will also 

appear in the Navigation pane for easy access the 

next time you want to view it.

 4.  To remove a Calendar from the Other Calendars 

list, right-click the Calendar, and then click 

Remove From Other Calendars.

Exercise 3-27  SUBSCRIBE TO AN INTERNET 
CALENDAR

Internet Calendars are Calendars that are shared through the Internet. These 

Calendars are based on an international Internet standard, or open standard, 

that allows Calendar information to be exchanged between people regardless 

of the application they are using to create and view Calendars. Internet 

Calendars use the iCalendar format and the .ics filename extension.

One type of Internet Calendars is the Internet Calendar Subscription. It 

is updated automatically and can be downloaded and viewed in Outlook.

These Calendars are usually hosted on Web sites that are dedicated to 

Calendars, but can also be found on a given organization’s Web site. You 

can click a link to download and subscribe to the Calendar, or someone can 

send you a link to download the Internet Subscription Calendar in an e-mail 

message. This link is an Internet Web address that begins with the protocol 

indicator webcal:// instead of http://, and ends with a filename that has the 

.ics file extension.

 1. Connect to the Internet and then on the Navigation bar, in the 

Calendar area, click the Search Calendars Online link. Your Web 

browser opens to a search page for finding online Calendars.

 2. From the Microsoft Calendar Search page, from a Calendars hosting 

Web site, or from an e-mail sent to you, click the link for the Internet 

Calendar Subscription.

NOTE

You may need to request permission to 
view the Calendar from its owner. If so, 
Outlook allows you to do so through a 
sharing request e-mail message form. 

You can also allow access to your default 
Calendar in this request.

NOTE

It is easy to schedule a meeting with 
those whose Calendars you can view. In 
the Actions menu, choose New Meeting 

Request With, and then click All or 
selectively choose the names from the list.

UNIT 2 Managing Your Schedule and Tasks
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 3.  A dialog box appears, asking you to add this 

Internet Calendar to Outlook and subscribe to 

updates. Click Yes. The Internet Calendar will open 

in the side-by-side view in the Outlook Calendar and 

is added to the Navigation pane in the Calendar 

view under the Other Calendars pane. Outlook will 

check periodically for any updates made by the 

Calendar publisher.

Exercise 3-28  VIEW MULTIPLE CALENDARS 

IN OVERLAY MODE

You can view a Calendar in a new window, side-by-side, or in a overlay mode 

that stacks transparent Calendars over each other to facilitate finding a 

common free time slot on several different Calendars.

 1. To open several Calendars side-by-side, click the Calendar button 

 on the Navigation bar. The Calendar view appears.

 2. On the Navigation bar, in the Calendar area, click to check the check-

boxes for each Calendar you want view. The Calendars will display 

side-by-side to each other in your Calendar grid.

NOTE

You may be prompted to permit the 
opening of the hyperlink. You should click 
Yes only if you know and trust the validity 

of the linked Calendar.

Figure 3-21
Viewing multiple 

Appointment 
Calendars in side-

by-side mode 
allows comparison 
and separation of 
Calendar events
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 3. To overlay your Calendars, on the tab of each Calendar you want to 

stack, click the left-pointing arrow . The Calendars are overlaid 

with transparency, allowing you to easily see any dates and times 

that may be free on all Calendars.

 4. To undo the overlay stack, click the right-pointing arrow  on the 

tab of each Calendar. The Calendars are once again displayed in the 

side-by-side view.

Figure 3-22
Viewing multiple 

Appointment 
Calendars in overlay 
mode allows efficient 

comparison of the 
intersection of free 
and active time in 

Calendars

Exercise 3-29 PRINT YOUR CALENDAR

Once you have your Calendar in a form you wish to share, you may want to 

publish it physically to take with you or to post on a door or bulletin board. 

You can even use this physical copy as a draft to jot new appointments when 

you are away from your computer. Outlook provides a number of printed 

formats to fit your needs.

 1. Click the Calendar button  on the Navigation bar. The 

Calendar view appears.

 2. On the date on the Date Navigator, select the day, week, or month 

you wish to print.
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 3. In the Appointments Calendar, choose the Day, Week, or Month tab.

 4. In the menu bar, click the File menu and then click the Page Setup 

submenu. In the Page Setup submenu, choose the layout style for 

your printout. Your choices are determined by the Calendar view 

you have chosen. Figure 3-23 shows an example of the daily style 

and the options that are available for that style.

LESSON 3 Managing Scheduling

Figure 3-23
You can flexibly set 

many options for the 
print preferences 

from the Page Setup 
dialog box including 

layout style, 
formatting, paper 
types, and more

 5. Click the Format tab, and make any changes in the Options and 

Fonts sections.

 6. Click the Paper tab and make any changes to set up your paper 

preferences.

 7. Click the Header/Footer tab to enter a header and/or footer for the 

pages of your Calendar.

 8. When you have all your print settings specified, click the Print 

Preview button  to see an on-screen preview of how your 

printed Calendar will look.

 9. Click Print  to print your Calendar.
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3Lesson Summary

• You can create an appointment, meeting, or event from scratch, from 

an e-mail you received, or from a task in your Calendar.

• You can send requests to invite attendees to a meeting you scheduled.

• You can use smart scheduling to find a free time for a meeting in group 

members’ schedules.

• You can track and manage responses to your meeting requests.

• You can schedule meeting resources.

• You can modify scheduled meetings by changing or proposing new 

times, inviting someone new, or accepting requested changes from your 

invitees.

• You can cancel scheduled meetings and send out notifications to the 

invitees.

• You can customize your Calendar to adjust your work week, your 

recognized holidays, and the time zones in which you are working or 

scheduling.

• You can share your Calendar and view others’ Calendars through an 

Outlook Exchange server, through Office Online, or even e-mail.

• You can configure your Calendar privacy settings to control what others 

receive and see in your Calendar.

• You can view multiple Calendars at the same time, either side-by-side or 

as transparent overlays.

LESSON 3  Command Summary

Feature Button Task Path Keyboard

Day View  View, Week Ctrl ⫹ Alt⫹ 1

Work Week View   View, Work Week Ctrl ⫹ Alt⫹ 2

Full Week View   View, Week Ctrl ⫹ Alt⫹ 3

Month View  View, Month Ctrl ⫹ Alt⫹ 4

New Appointment  File, New Ctrl ⫹ N

Open Selected   File, Open, Selected Items Ctrl ⫹O

Appointment

Go to Today  Go, Today 
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Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 

choice by circling T or F.

 1. By default, the Appointment Calendar divides the workday into one-

hour segments.

 2. If you create an appointment from a task, the body of the appointment 

will automatically contain the task information.

 3. The Week view allows you to toggle the display of work week or full 

week at the top of the Appointment Calendar.

 4. The current date appears in bold in the Date Navigator.

 5. If a date contains a scheduled appointment, that date appears in bold in 

the Date Navigator.

 6. By default, the reminder option is selected in a new appointment.

 7. You must open an appointment before you can reschedule it.

 8. The TaskPad is displayed below the Appointments Calendar in the 

Calendar view.

 9. You can subscribe to Internet Calendars by clicking a subscription link 

on a Web page.

 10. You cannot view more than one Calendar at the same time.

Short Answer Questions
Write the correct answer in the space provided.

 1. When you select the Week view, how does the Date Navigator change to 
reflect this?

 2. What surrounds an appointment when you select it in your 
Appointments Calendar?

 3. What do you call appointments that occur repeatedly?

 4. How can you view Internet Calendars from the Web?

 5. If you move from Los Angeles to New York and must adjust your 
scheduled meetings, how can Outlook help?

T    F 

T    F 
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 6. What is the file extension for Internet Calendar filenames?

 7. How do you mark an appointment as private?

 8. How can you quickly e-mail someone just when you are available over 
the next week?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 

answers. Support your answers with examples from your own experience, 

if possible.

 1. Why would it be useful to create and maintain separate business and 

personal Calendars?

 2. If you are conducting international business, how could the Add 

Holidays feature help you in scheduling meetings and events?

 3. When would private appointments be useful in your schedule?

Skills Review

Exercise 3-30
Navigate in the Calendar, schedule an appointment, and print an 

appointment.

 1.  Open the Calendar by clicking the Calendar shortcut in the Navigation 

pane.

 2. Change Calendar Viewing options by following these steps:

 a.  To display the Week view, click the Week tab  at the top of the 

Appointments Calendar, or press   .

 b.  Display the Work Week view by clicking the Work Week radio button 

 at the top of the Appointments Calendar.

 c.  Display the Day view by clicking the Day tab  at the top of the 

Appointments Calendar.

 d.  Click the date in the Date Navigator that is one week from the 

current date.

 3. Schedule an appointment by following these steps:

 a. Choose File, New Appointment from the menu, or press  .

 b. In the Subject text box, key Beginning of session orientation.

 c. In the Location field, key Conference Room.
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 d.  Set the date for the start time by clicking the Date list box. Select 

a date roughly one week from the current date, if that date is not 

already selected.

 e.  Set the time for the start time by clicking the Time list box and 

choosing 1:00 PM.

 f.  Clear the reminder, by clicking the Reminder list box and choosing None.

 g.  Click on the Save & Close button  on the Appointment Form.

 4. Print the appointment by following these steps:

 a.  Click the date in the Date Navigator of the appointment you 

scheduled in the previous step.

 b.  In the Appointments Calendar, double-click the “Beginning of session 

orientation” appointment. The Appointment form opens with your 

appointment.

 c.  Choose the Office button  on the Appointment form to display 

the Office menu.

 d. Choose Print, Print from the menu.

 e. Click on the OK button.

 f. Close the appointment without saving.

Exercise 3-31
Schedule an event, add a reminder, and print the Calendar.

 1.  Open the Calendar by clicking the Calendar pane in the Navigation pane.

 2.  Display the Calendar in Full Week view by clicking the Week tab and 

then clicking the Full Week radio button at the top of the Appointments 

Calendar.

 3.  Delete any existing appointments or events for this week by following 

these steps:

 a. Select the appointment or event.

 b.  Delete the appointment or event by clicking the Delete button  on 

the Standard toolbar.

 4. Create a new event by following these steps:

 a. Choose Actions, New All Day Event from the menu.

 b. In the Subject text box, key Family Reunion.

 c.  Set the date for the start time by clicking the Date list box. Select a 

date on the next Saturday from the current date, if that date is not 

already selected.

 d. Click the Reminder list box and select a reminder time of 1 day.

 e. Click on the Save & Close button on the Event Form.

 5. Print a Calendar by following these steps:

 a. Choose File, Page Setup, Weekly Style from the menu.

 b.  Click the Header/Footer tab and replace the User Name in the footer 

with your name if it is not already displayed.

 c. Click the Print button.

 d. Click the OK button.

 6. Display the Calendar in Day view.
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Exercise 3-32
Change the Calendar view, schedule appointments, set reminders, and 

print the Calendar.

Adam Parker has asked you to schedule time to work on the feedback he’s 

received from team managers in the local little league. You want to be sure 

you keep track of the appointments, because everyone has busy schedules 

and they are already volunteering their time.

 1.  Display your Calendar view if it is not already displayed, and change the 

view to Work Week view.

 2.  Create a new appointment with the subject Go over team managers 
input. Schedule it roughly two weeks from the current date, but do not 

schedule any meetings on a weekend or a Monday. Make it an hour-

long appointment, starting after 3 P.M. (Ignore any warnings that might 

appear, informing you of conflicts with other appointments.)

 3.  Key the location of the appointment as Adam’s office. In the body of the 

Appointment form, key Find out which suggestions Adam thinks are most 
important.

 4. Set a reminder to go off one hour before the appointment.

 5.  Schedule an hour appointment at 10 A.M. the day before the 

appointment you just scheduled with Adam. (Remember the previous 

scheduling rules.)

 6.  Key the subject of the appointment as Get final input from Marion. Key 

the location as Marion’s office, and set a reminder to go off one hour 

before the appointment.

 7.  Display the week for the appointments that you created in the previous 

steps. Delete any other appointments or events for this week that were 

not entered during this exercise, and then print the Calendar in Weekly 

Style. Include your name as a centered header

 8. Display the Calendar in Day view for the current date.

Exercise 3-33
Schedule a recurring appointment and an event, use reminders, and print 

the Calendar.

Your manager has asked you to coordinate the annual departmental staff 

meeting. You’ll need to schedule the event and time in your Calendar for 

preparation.

 1.  Using the Date Navigator, find a week in the coming month in which 

there are no appointments or events scheduled, or select a week and 

delete any existing appointments and events for that week. Schedule an 

appointment on the Monday of that week.

Lesson Applications
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 2.  Key the subject of the appointment as Preparation for annual staff 
meeting, and start the appointment at 2 P.M. and end it at 5 P.M. Specify 

the location as My office.

 3.  Set the reminder to 30 minutes, and in the body of the appointment, 

key Do not schedule any other appointments for this time!

 4.  Make this a recurring appointment, using a daily recurrence pattern, 

with a range of recurrence that is to end after four occurrences.

 5.  On the Friday of that same week, schedule an all-day event. For the 

subject of the event, key Annual staff meeting. For the location, key 

Conference center.

 6. Set the reminder to one day, and set the Show as option as Busy.

 7.  Print the Calendar for the week you scheduled the appointment and 

event, using a Weekly Style. Add your name as a centered header, if it 

does not appear in the header already.

Exercise 3-34  Challenge Yourself
Schedule an appointment, schedule an event, add reminders, and print 

the Calendar.

You have been asked to accompany your Research Advisor to an important 

conference to present a paper. You need to schedule appointments in 

preparation for the trip.

 1.  Use the Date Navigator to find a week in the period of roughly two 

months from the current month in which there are no appointments or 

events scheduled, or select a week and delete any existing appointments 

and events for that week.

 2.  On Monday of that week, schedule an appointment, keying the subject 

Discuss conference travel arrangements. Make the location of the 

appointment as Daniel’s office, starting at 10 A.M. and ending at 11:00 

A.M. Have the reminder go off 30 minutes prior to the appointment.

 3.  Schedule an all day event for Friday of that week, keying the subject as 

Interactive Learning Conference. Specify the location as Honolulu. Set a 

one-day reminder for the event, and show as Out of Office.

 4.  Create an appointment with the subject Review final presentation edits, 

on Monday of that same week, starting at 1 P.M. and ending at 2:00 P.M. 

In the body of the appointment, key the text Use this time to practice 
the final presentation and work out any flaws. Set a reminder for the 

preceding Friday. Set Show as to Tentative.

 5.  Create a new e-mail message, addressing the message to your instructor. 

Key the subject of the message as Presentation Review. For the body of 

the message, key This is a meeting to review our final presentation at the 
Interactive Learning Conference. I would like to give it a practice run.

 6. Connect to the Internet and send the message.

 7. Log off the Internet if your instructor tells you to do so.



 8.  Locate the message that you just sent in the Sent Items folder and print 

it. Use a Memo Style print style, with your name as a centered header.

 9.  Display the date for the Monday of the week that you scheduled the 

appointment and the event in the previous steps.

 10.  Print the Calendar, using a Weekly Style. Add your name as a centered 

header and the date as a centered footer.

On Your Own

In these exercises you work on your own, as you would in a real-life work 

environment. Use the skills you’ve learned to accomplish the task—and be 

creative.

Exercise 3-35

Plan an elaborate, catered surprise anniversary party for a friend or relative. 

Schedule appointments and meetings to plan and prepare for the event. 

Consider all elements for the party. Plan for food and entertainment. Plan to 

collect photos for a nostalgic slide show and invitations. Print the Calendar.

Exercise 3-36

Use the Internet to research a destination to which you need to travel for a 

business trip, sales call, or conference. Set up a detailed itinerary in your 

Calendar. Print the Calendar.

Exercise 3-37

Document your week. Use the Calendar to show all your work, school, and 

community related activities and personal errands. Print the Calendar.
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After completing this lesson, you will be able to:

1. Create tasks, modify tasks, and mark tasks as complete.

2. Work with assigned tasks.

3. Locate tasks.
MCAS OBJECTIVES

In this lesson:

OL07 3.1.1

OL07 3.1.2

OL07 3.1.3

OL07 3.1.4

OL07 3.1.5

OL07 3.2.1

OL07 3.2.2

OL07 3.2.3

OL07 5.4.3

OBJECTIVES

Lesson 4

Task Management

OL2.4

Outlook’s powerful task management component goes far beyond simply 

creating tasks and marking them as complete. In addition to those important 

pieces of information, Outlook allows you to assign tasks to others, accept or 

decline tasks, and keep up to date on the current status of tasks.

Outlook also gives you an easy way to generate task lists, assign work 

to others, and send status reports on assigned tasks. After you’ve created 

a task, you can update it in various ways, such as marking it completed, 

changing the due date, or marking it a recurring task. Recurring tasks can 

occur at regular intervals or at a date you set for completion. Examples of 

a recurring task include updating your computer’s software or creating a 

weekly meeting agenda.

Creating and Modifying Tasks 
and Marking Tasks as Complete
You can create tasks in Outlook by filling in a form with fields for the 

information that describes the task. You can create new tasks by first opening 

a blank form or you can create new tasks based on the information from an 

e-mail message. You can also begin the process of creating a contact from 

the header information of an e-mail message.

Once you have created a task, it is easy to modify or add to the 

information when updates are necessary. Additionally, you can easily remove 

tasks that are no longer valid or needed from your task list.

 Estimated Time: 11/2 hours
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Exercise 4-1 CREATE A NEW TASK

There are several ways to begin the process of creating a task in Outlook. 

You can:

• Press Ctrl ⫹ N  while viewing the tasks.

• Press Ctrl ⫹ Shift ⫹ K  while viewing any part of Outlook.

• Click the New button while viewing tasks.

• Choose Task from the drop-down list of the New button.

 1. Switch to Outlook’s Contacts component by clicking the Tasks 

button  on the Navigation bar.

 2. Click the New button  on the Standard toolbar to open a 

new Task form.

Figure 4-1 
The new Task form

 3. In the Subject text box key Copy Reports for Project Team.

 4. Click on the drop-down arrow  next to the Start 

date field. The date selection tool will appear.

 5. Click on the Today button.

 6. Click on the drop-down arrow  next to the Due 

date field. The date selection tool will appear.

 7. Click on the date for next Monday.
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 8.  Click on the drop-down arrow  

next to the Priority field and select High.

 9. Key 20 copies are needed in the task note area.

10.  Click on the Save & Close button  on the Task tab 

on the Ribbon.

Figure 4-2 
The completed Task 

Form

Exercise 4-2 CREATE RECURRING TASKS

You can create tasks that recur using the same methods that you use for 

creating other tasks.

 1. Click the New button  from the Standard toolbar to open a 

new Task form.

 2. In the Subject text box key Create Meeting Agenda.

 3. Click on the drop-down arrow  next to the Start 

date field. The date selection tool will appear.

 4. Click on the first Monday of the next month.

 5. Click on the drop-down arrow  next to the Priority field 

and select Low.

 6. Key Weekly Meeting Agenda in the task note area.

 7. Click on the Recurrence button  on the Task tab on the Ribbon. 

The Task Recurrence dialog box will appear.

TIP

You can quickly save and close tasks by 
using the keyboard shortcut Alt ⫹ S .
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 8. Click on the drop-down arrow  next to the End by field. The date 

selection tool will appear.

 9.  Click on a Monday approximately two months 

ahead of the start date.

10.  Click on the OK button  to close the Task 

Recurrence dialog box.

11.  Click on the Save & Close button  on the Task tab 

on the Ribbon.

Figure 4-3 
The Task Recurrence 

dialog box

Figure 4-4 
The completed 

recurring Task form

TIP

When working with recurring tasks, you 
can also end the task after a specified 

number of occurrences or set recurring 
tasks without end dates.
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Exercise 4-3 CREATE A TASK FROM A MESSAGE

You can create a task from a message by clicking and dragging a mail 

message to the Tasks button. 

 1. Click on the Mail button  in the Navigation pane to 

display your Mail.

 2. Click on the New button  in the Standard toolbar to create a 

new Mail message.

 3. Key your e-mail address into the To field.

 4. Click in the Subject field and key Status Report.

 5. In the message area, key Please send a revised copy of your Status 

Report.

 6. Click on the Send button .

 7. Click on the Send/Receive button  to receive the mail 

message.

 8. Click the Status Report message in the message list. Drag the 

message to the Tasks button  in the Navigation pane. 

A Task window containing the information from the message will 

open.

 9. Click on the drop-down arrow  next to the Due 

date field and click on the date for next week Monday.

 10. Click on the Save & Close button  on the Task tab on the Ribbon.

Exercise 4-4 MODIFY TASKS

There are several ways to modify a task in Outlook. You can:

• Press Ctrl ⫹O  while a task is selected.

• Right-click a task from your To-Do List and select Open.

• Double-click a task from your To-Do List.

 1. Double-click the Status Report task. The Status Report task will open 

in a Task window.

 2. Click on the drop-down arrow  next to the Status field.

 3. Click on In Progress.

 4. Click on the drop-down arrow  next to the Priority field 

and select High.

 5. Click in the % Complete text field and key 50%.
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 6.  Click on the Save & Close button .

 7.  Double-click the Status Report task. The Status 

Report task will open in a Task window.

 8.  Click on the drop-down arrow  next to 

the Status field.

 9. Click on Deferred.

10.  Click on the Save & Close button  on the Task tab 

on the Ribbon.

Figure 4-5 
The completed 

modified Task form

Exercise 4-5 MARK TASKS AS PRIVATE

You can mark tasks as private in Outlook to ensure that others on your 

network cannot see specific tasks. You can use the Private button on the 

Ribbon.

 1. Double-click the Status Report task. The Status Report task will open 

in a Task window.

 2. Click on the Private button  on the Task tab on the Ribbon.

 3. Click on the Save & Close button  on the Task tab on the 

Ribbon.

TIP

You can quickly modify tasks directly from 
the To-Do list by clicking on the different 
options available including Task Subject, 

Status, Due Date, % Complete, and 
Categories.
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Exercise 4-6 COMPLETE TASKS 

There are several ways to complete a task in Outlook. You can:

• Click on the drop-down arrow in the Status field and select Completed.

• Click on the Status drop-down menu in the To-Do List and select 

Completed.

• Click on the Mark Complete button on the Task tab on the Ribbon.

 1.  Double-click the Status Report task. The Status 

Report task will open in a Task window.

 2.  Click on the drop-down arrow  next to the 

Status field and select Completed.

 3.  Click on the Save & Close button  on the Task tab 

on the Ribbon. The Status Report task should no 

longer be listed in your To-Do List.

Working with Assigned Tasks

Exercise 4-7 ASSIGN TASKS TO OTHERS

Outlook enables you to assign tasks to others and to track their progress. If 

you are a supervisor, you could assign a task to a subordinate. Or, if you’re 

working on a project with a group, you might assign a task to a coworker.

You assign a task to someone in the form of a task request, which is an 

e-mail message asking the message recipient to complete a specific activity. 

The recipient can either accept or decline the sender’s request or delegate 

the task to someone else. When you delegate a task, you assign the task to 

someone else and you give up “ownership” of the task. This means you 

cannot change information in the task, such as the due date. However, you 

can keep an updated copy of the task in your task list, and you can receive 

status reports on its progress. You delegate tasks usually to a subordinate, 

occasionally to a coworker or equal, but never to a supervisor.

You can assign a task in various ways. You can:

• Click on the drop-down arrow next to New  and select Task Request.

• Click on the Assign Task button  from the Task window.

• Press Ctrl ⫹ Shift ⫹ U  while viewing any part of Outlook.

 1.  Click the Tasks shortcut in the Navigation pane to 

display the Tasks folder.

 2.  Click the down arrow next to the New button and 

select Task Request from the menu (or press Ctrl ⫹
Shift ⫹ U ). The Task form appears.

NOTE

Because this is a new task request rather 
than a new task, this form differs from 

the Task form you’ve seen previously. The 
toolbar includes additional buttons and 
various text boxes that relate to the task 

assignment.

TIP

You can quickly mark tasks as complete 
directly from your To-Do List by clicking 

on the task’s status and selecting 
Complete.
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You will need a student partner for this exercise, as you will be assigning 

tasks to each other. You and your partner will be referred to as “Student 1” 

and “Student 2” in the steps that follow. Decide which one of you is Student 

1 and which is Student 2.

 3.  Click on the To button . The Select Task Recipient: Contacts 

dialog box appears.

 4.  Select your partner and click the To button 

. If your partner’s information is not in 

the Select Task Recipient: Contacts menu, refer to 

Lesson 2 for details on inputting his or her 

contact information (you can also key your 

partner’s e-mail address in the To field).

 5.  Click the OK button . The Task form reappears, with your 

partner’s name in the To text field.

 6.  In the Subject field, key the following material for either Student 1 

or Lesson 2, depending on which you have chosen:

Student 1: Prepare handouts for conference presentation

Student 2: Request equipment for conference presentation

 7. Click on the drop-down arrow  next to the Due date 

field. Select a date approximately two weeks in the future.

 8. Set the Priority field to High.

Figure 4-6 
The Task form for a 
new task request

TIP

You do not need to select a member from 
your contacts to assign a task to. You can 

also assign tasks by typing their e-mail 
address directly into the To field.
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 9. If they are not already selected, select the options for keeping an 

updated copy on the task list and sending a status report when the 

task is completed.

10.  Click on the Send button  on the Ribbon (you 

must be connected to the Internet to complete this 

step). The To-Do List will list this task even though 

you are not the owner of the task because you 

selected the option for placing an updated copy of 

the task in your task list.

 11. Open the “Prepare handouts” task if you are Student 1; open the 

“Request equipment” task if you are Student 2. The Task form differs 

from other tasks in the To-Do List. This is a task request and you are 

not the owner of this task. You cannot change the details of the task, 

such as the status or the due date. Although your partner has not yet 

accepted the task assignment, your partner is the current owner of 

this task.

NOTE

Tasks cannot be assigned to others with 
Outlook Connector.

Figure 4-7 
Task form for sent 

task request

 12. Click on the Send button  (you must be connected to the Internet 

to complete this step).

Exercise 4-8 ACCEPT AND DECLINE TASKS

Just as you can assign tasks, you can be the recipient of a task request. When 

you receive a task request, you become the temporary owner of the task. You 

can accept the task, decline the task, or assign the task to someone else.
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If you accept the task, you assume ownership of the task and it is added 

to your task list. You are then the only person who can make changes to the 

task. When you decline a task, it is returned to the person who sent it to you. 

If you delegate the task to someone else, you can keep an updated copy of 

the task in your To-Do List, but ownership and the ability to make changes 

are transferred to the person to whom you delegate it.

Task requests appear in your Inbox as e-mail items, identified by the 

words “Task Request” in the Subject field. You open them as you would any 

e-mail message. They also appear in your task list.

 1. Click on the Inbox folder. Click on the Send/Receive button 

 on the Standard toolbar to retrieve the task requests 

sent to you, if you have not already received them.

 2. Locate the task request items in your Inbox.

 3. Open the “Request equipment” task if you are Student 1; open the 

“Prepare handouts” task if you are Student 2. The Task dialog box 

appears.

Figure 4-8 
Inbox containing task 

requests

 4.  If you are Student 1 (Student 2: continue at Step 6), 

click on the Accept button  on the Task tab on the 

Ribbon. A dialog box is displayed asking if you want 

to edit the message sent with the response.

 5.  Click on the OK button  to send the 

response. The response is sent and the task is added 

to your To-Do List.

 6.  If you are Student 2 (Student 1 is finished with this exercise), click 

on the Decline button  on the Task tab on the Ribbon. The 

Declining Task dialog appears, asking if you want to edit the 

message sent with the response.
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You can also accept and decline Assigned 
Tasks from the preview pane by clicking 
on the Accept or Decline buttons above 

the subject.
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 7. In the Declining Task dialog box, click the Edit the response before 

sending radio button and click on the OK button .

 8. In the Task window, key George already completed this task.

 9. Click on the Send button . Since you declined the task, it was not 

added to your To-Do List.

Exercise 4-9  SEND STATUS REPORTS ON ASSIGNED 
TASKS

After accepting tasks, you can also keep those who assigned the tasks to 

you informed of your progress with status reports. A status report sends an 

e-mail message to the individual who assigned the task with the updates 

that you made to the task.

 1. Student 1: Click on the Tasks button  in the Navigation 

pane to display your To-Do List (Student 2 cannot complete this 

exercise unless he or she accepted an assigned task).

 2. Double-click the “Request equipment” task. The Task window appears.

 3. Click in the % Complete field and key or select 75%.

 4. Click on the Send Status Report button  on the Task tab on the 

Ribbon. A message window appears. The name of the person who 

assigned the task is displayed in the To field. The contents of the 

message include the current status of the task.

 5. Click the Send button .

 6. Click the Save & Close button.

Locating Tasks

Exercise 4-10 SEARCH FOR TASKS

In many cases, individuals may have many tasks in their To-Do List. 

Therefore, rather than searching for tasks by looking through your To-Do 

List, you can search for tasks using Outlook’s Instant Search feature.

 1.  Click on the Tasks button  in the 

Navigation pane.

 2.  In the Instant Search text field , 

ensure that Search All Task Items is selected.

 3.  In the Instant Search text field, key equipment. 

Outlook will display the matching task items.

NOTE

Since Windows Vista indexes tasks, you 
may not find a task that you searched for 

if the task was not indexed yet.
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4Lesson  Summary

• You can create new tasks by filling in the Task window.

• Tasks include a subject, start date, due date, status, priority, 

% complete, and message.

• You can create recurring tasks for tasks that occur on a regular basis.

• You can specify the range of occurrence of a recurring task by number 

of occurrences, an end date, or no end date.

• You can click and drag mail messages to the Task icon to create a task 

from a mail message.

• You can modify tasks by double-clicking them from your To-Do List.

• You can ensure that other network users do not see specific tasks by 

marking them as private.

• When you are finished with a task, you should mark it as complete.

• When assigning tasks to others, Outlook sends the recipient a mail 

message, which he or she can accept or decline.

• You can keep a copy of the assigned task in your To-Do List by 

checking the option, Keep an updated copy of this task on my 

task list.

• You can send updates regarding tasks to the assignee by clicking the 

Send Status Report button on the Ribbon.

• You can find task items instantly with the Instant Search feature.

LESSON 4  Command Summary

Feature Button Task Path Keyboard

Create New Task  File, New, Task Ctrl ⫹ Shift ⫹

Create New Task Request  File, New, Task Request Ctrl ⫹ Shift ⫹

Open a Task  File, Open, Selected Items Ctrl ⫹O



Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 

choice by circling T or F.

 1. New tasks can be created from any view in Outlook.

 2. You cannot set a task to recur.

 3. It is possible to create tasks from mail messages.

 4. You can modify a task in your To-Do List.

 5. You can prevent other network users from seeing specific tasks.

 6. You can delegate work by assigning tasks to others.

 7. You can assign a task to yourself using the New Task Request window.

 8. When declining a task, you can send a message to the assignee with a 

reason.

 9. You can keep the task assignee up-to-date with Status Reports.

 10. If you have difficulty locating a task, you cannot search for it.

Short Answer Questions
Write the correct answer in the space provided.

 1. Describe some of the possible methods for creating a new task.

 2. What different priority levels exist for tasks?

 3. What range of recurrence options are available for recurring tasks?

 4. How do you create a task from an e-mail message?

 5. Describe some of the possible methods of opening a task to modify it.

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 
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6. What should you do when you finish a task?

7. Describe some of the possible methods of creating a new task request.

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 

answers. Support your answers with examples from your own experience, 

if possible.

 1. What types of tasks could be recurring tasks?

 2. What types of tasks would you mark as private?

 3. How often should you send status reports?

Skills Review

Exercise 4-11
Create a Task, Change a Task, and Update a Task

 1.  Click on the tasks button  in the 

Navigation pane if the task list is not already displayed.

 2.  Delete any existing tasks in your task list by right-

clicking on each task and clicking on the Delete option.

 3. Create a new task by following these steps:

 a. Click the New button  on the Standard toolbar.

 b. In the Subject field, key Revise Conference Worksheet.

 c.  Click on the drop-down arrow next to the Due Date field and click on 

the next business day.

 d.  Click on the Save & Close button  on the Task tab on the ribbon.

 4. Change a task by following these steps:

 a. Click on the task you created in the previous step.

 b. Move the insertion point to the end of the subject text.

 c.  Key the text for Maria. The subject of the task should now read 

“Revise Conference Worksheet for Maria.”

 d.  Click anywhere in the task list to deselect the “Revise Conference 

Worksheet for Maria” task.

 5. Update a task by following these steps:

 a. Double-click the Revise Conference Worksheet for Maria task.

 b.  Click the Mark Complete button  on the Task tab on the Ribbon.

NOTE

Your task list may already be empty.
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Lesson Applications

Exercise 4-12
Create recurring tasks.

You’ve decided to set your schedule for the next year. After reviewing your 

schedule, you decided to develop a list of recurring tasks that come up 

weekly and monthly. You need to create these tasks to ensure that you are 

ready for the next six months.

 1.  Display the task list and create a new task. In the Subject field, key 

Weekly Report. Make the due date roughly one week from today.

 2. Set the task to recur every week for the next six months.

 3. In the text area of the task, key Include updates and timeline.

 4. Save & Close the task.

 5.  Create a new task. In the Subject field, key Presentation for Department 
Meeting. Make the due date roughly one month from today.

 6. Set the task to recur every month for the next six months.

 7. In the text area of the task, key Use PowerPoint with visuals.

 8. Save & Close the task.

 9.  Create a new task. In the Subject field, key Joan’s birthday. Make the due 

date April 25 of the current year.

 10. Set the task to recur yearly with no end date.

 11. In the text area of the task, key Joan likes candy.

 12. Save & Close the task.

Exercise 4-13
Assign tasks.

For this exercise, you will need to work with a partner. You’ve decided to 

delegate some of your responsibilities to a coworker. You need to assign two 

tasks to a coworker and stay up to date on their progress.

 1.  Student 1: Assign a new task to your partner. In the Subject field, key 

Sales Charts. Make the due date roughly one week from today.

 2. Student 1: Set the priority to High. Send the task.

 3. Student 2: Check your e-mail and accept the task.

 4.  Student 1: Assign a new task to your partner. In the Subject field, key 

Copy Reports. Make the due date roughly one week from today.

 5.  Student 2: Check your e-mail and decline the task, giving the following 

reason: “Joan already copied the reports.”

 6.  Student 1: Check your e-mail to ensure that you received the accept and 

decline messages.
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 7.  Student 2: Send a status report to Student 1 indicating that the task is 

50% complete.

 8.  Student 1: Check your e-mail to ensure that you received the status report. 

Exercise 4-14
Locate and update tasks.

Joan’s birthday is coming up soon and you do not know what to get her. 

However, you remembered that you wrote down something that she likes in 

your Task list.

 1. Display the task list.

 2. Conduct an Instant Search to find Joan’s birthday.

 3. Send yourself an e-mail reminder of what to buy Joan for her birthday.

 4.  Update the task with items you should avoid getting for Joan. In the text 

area, key Joan does not like salty foods.

Exercise 4-15  Challenge Yourself
Schedule tasks.

You’ve been asked to accompany the staff of the Design Department to 

a furniture manufacturers’ conference. You need to schedule tasks in 

preparation for the trip.

 1.  Create a new task with the subject Work out travel budget, with a due 

date approximately one month from today. In the text area of the task, 

key Maria needs this budget before she will authorize the expenses. Set the 

status as In Progress. When finished, Save & Close this task.

 2.  Assign a new task to your instructor. In the subject area of the task, 

key Itinerary for Budget. For the message of the text, key Please send 
me the itinerary as soon as possible so I may complete the 
budget.

 3. Connect to the Internet and send the task.

 4.  Log off the Internet if your instructor tells you to do so.

NOTE

Your instructor will provide you with an 
e-mail address.

On Your Own

In these exercises you work on your own, as you would in a real-life work 

environment. Use the skills you’ve learned to accomplish the task—and be 

creative.

Exercise 4-16
Plan for an elaborate project that will last 6 months. Break the project 

down into a series of milestone tasks that highlight the deliverables at 

various stages of the project. Print the task list.
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Exercise 4-17
Look through your e-mail and choose an e-mail that is asking you for 

action. Get a friend to e-mail you a request if you do not already have one. 

Drag the e-mail to your task list to create the initial task. Develop a list of 

tasks to complete the request. Print the task list.

Exercise 4-18
Develop a list of recurring tasks for your work or school related activities. 

Plan so that you are ready for the next complete time cycle, such as a project 

milestone at work or a semester or term at school. Print the task list.
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Unit Application 2-1
Schedule a recurring appointment and an event, use reminders, create 

a task, and print the task and Calendar.

James Strickland, your manager, has asked you to coordinate a product 

launch. You’ll need to schedule the event and an appointment in your calendar 

for the preparations. Create tasks to manage preparation and print the tasks 

and Calendar for referral when you are away from your computer.

 1. Schedule the product launch as a new, all-day event in your Calendar, 

choosing a date three months after the current date. The subject of 

the event is Widget Product Launch. Key the location of the event as 

Municipal Hall. In the body of the Event form, key Product launch at 
Consumer Expo. Have a reminder set two days before the event. Mark 

the event as Out of office.

 2. On the day after the event, schedule a party as an appointment in your 

Calendar, from 3:30–5:30, with the subject of the appointment Post-Expo 
party. Specify the location as Magoo’s Grill. Set a reminder for one hour 

before the appointment. Mark the appointment as private. In the body 

of the Appointment form, key Employees are scheduled to arrive at 3:45 
PM Clients to arrive at 4:30 PM.

 3. Delete any existing tasks in the task list. Create a new task titled Prepare 
displays for Expo. Make the due date the week before the exposition, 

and set no reminder. Create a second task titled Invite top clients for 
post-expo party. Make the due date two weeks before the exposition, set 

no reminder, and make the status of the task In Progress. Create a third 

task, titled Assemble samples and product info bags and plan catering. 
Make the due date three days before the party, and set a reminder for 

the day before.

 4. Create a new contact, using a classmate’s name and e-mail address.

 5.  Create a new e-mail message from the Event, 

addressing it to your instructor. Cc the classmate you 

added as a contact in Step 4. Use the Cc button to add 

the classmate’s e-mail address to the Cc field from the 

Contact list. Make the subject of the message Visit our 
booth at the Expo! In the body of the e-mail, key We are 
launching an exciting new product.

 6. Connect to the Internet and send the message. Log off the Internet if 

your instructor tells you to do so.

 7. Display the Sent Items folder in the Mail view, and select the e-mail that 

you just sent. Print the message, using the Memo Style as the printing 

style. Add your name as a centered header, and delete any existing 

footer information.

Unit 2 Applications

NOTE

Your instructor will provide you with an 
appropriate e-mail address.
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 8. Print the task list, using the Table Style as the print style. Make sure all 

rows are included in the task list. Add your name as a centered header, 

and delete any existing footer information.

 9. Display the date of the event. Delete any Calendar items not entered in 

this exercise. Print the Calendar in Daily Style, adding your name as a 

centered header, and delete any existing footer information.

 10. Select the party item in the Calendar and print the Calendar again, this 

time using the Calendar Details Style as the print style and adding your 

name as a centered header.

 11. Hand in all printouts to your instructor.

Unit Application 2-2
Schedule a recurring appointment and an event, use reminders, create 

a task, and print the task and Calendar.

Your family has asked you to be in charge of an anniversary party for your 

grandparents. You’ll need to schedule the event and time in your Calendar for 

preparations.

 1. Display your Calendar.

 2. Schedule the party as a new, all-day event in your Calendar, choosing a 

date that is a Saturday one month from the current date. The subject of 

the event is 50th Wedding Anniversary. In the body of the Event form, 

key Anniversary party at the country club. Set a reminder for one week 

before the event.

 3. On the day of the event, schedule the party as an appointment in your 

Calendar, from 12:30–2:30 P.M., with the subject of the appointment 

as 50th Anniversary Party. Specify the location as Four Greens Country 
Club. Set a reminder for two hours before the appointment. In the body 

of the Appointment form, key Family is scheduled to arrive at 12:45, 
Grandmother and Grandfather at 1:30 PM.

 4. Delete any existing tasks in the task list. Create a new task titled Shop 
for anniversary present. Make the due date the week before the party, 

and set no reminder. Create a second task titled Invite guests for 
anniversary party. Make the due date two weeks before the party and 

set no reminder, and set the status to In Progress. Create a third task, 

titled Shop for drinks, hors d’oeuvres, and cake. Make the due date the 

day before the party, and set a reminder for the day before, and set the 

status to In Progress.

 5. Schedule an appointment on Monday of that week. Key the subject of 

the appointment as Party planning meeting, and start the appointment 

from 10–11 A.M. Specify the location as My house.

 6. Set no reminder for the appointment, and in the body of the 

appointment, key Sort through old family photos for slide show and 
assign speeches.
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 7. Make this a recurring appointment, using a daily recurrence pattern, 

with a range of recurrence that is to end after four occurrences.

 8. On the Friday of that same week, schedule an appointment from 8–12 

AM. For the subject of the event, key Make PowerPoint slide show of 
family photos. For the location, key Dave’s house.

 9. Set the reminder to one day, and set the Show as option as Busy.

 10. Print the task list, using the Table style as the print style. Make sure all 

rows are included in the task list. Add your name as a centered header, 

and delete any existing footer information.

 11. Print the Calendar for the week you scheduled the appointment and 

event, using a Weekly Style. Add your name as a centered header, if it 

does not appear in the header already.

 12. Display the date of the event. Delete any Calendar items not entered in 

this exercise. Print the Calendar in Calendar Details Style, adding your 

name as a centered header, and delete any existing footer information.

 13. Hand in all printouts to your instructor.

Unit Application 2-3  Using the Internet
Pick a destination that you would like to visit. The occasion is a holiday with 

family or friends. Think of the interests of those that will accompany you on 

this vacation and locate Web sites about interesting locations. For example, 

someone may be interested in exploring historical locations like the Mayan 

pyramids of Mexico or someone may want to relax on the golf courses of South 

Carolina, or enjoy hiking down into an extinct volcano in Maui, and so on.

Choose at least three destinations, preferably with different types of 

activities. Do comparison shopping on at least two different travel services 

Web sites selling the same or similar vacations. If possible, note the amenities 

(hotel, air, etc.) associated with each vacation package.

 1. Compose an e-mail message describing the information you’ve 

obtained, addressing it to your instructor. Include the address of the 

Web site for each of the vacation destinations. Send the message.

 2. Create a task from the e-mail and print a copy of the task in Memo 

Style. Center your name in the header.

 3.  Pick a date in your Calendar to take the vacation. 

Make that date an event, and set a reminder for the 

day before. Delete any other appointments or events 

for that day and print the Calendar for that Day, using 

a Daily Print Style. Center your name in the header.

 4. Create a task list with at least three more tasks associated with this 

project. You may mark any or all of them completed, if you wish. Delete 

any other tasks, except the one created above in this exercise. Print out 

the task list, using a Table Style for the print style. Center your name in 

the header.

 5. Hand in all printouts to your instructor.

NOTE

Your instructor will provide you with an 
appropriate e-mail address.
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After completing this lesson, you will be able to:

1. Create and manage your signature and automated settings.

2. Configure e-mail message sensitivity and importance settings.

3. Configure e-mail message security settings.

4. Configure e-mail message delivery options.

5. Organize mail folders.

6. Create, modify, and remove rules to manage e-mail messages.

7. Locate Office Outlook 2007 items by the search feature.

8. Customize your Office 2007 experience.
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Lesson 5

Managing E-mail 
Efficiently

OL3.5

 Estimated Time: 21/2 hours

After you’ve become accustomed to Outlook’s various components, you can 

further refine your skills by using Outlook’s advanced e-mail features to help 

you manage your e-mail efficiently. You can configure your e-mail settings 

to indicate to your recipient the importance level of the message and even 

automatically add a signature to all of your messages. 

To ensure that your e-mail messages are managed efficiently, you can 

save messages to different folders and even create rules to automatically 

organize the e-mail you receive. If you lose a message, you can instantly 

locate it with Outlook’s Instant Search feature.

Configuring E-mail Settings
Settings allow users to customize the behavior of Outlook. You can adjust 

the Outlook settings to affect how you interact with your e-mail. Some of the 

features you can affect are signatures, out of office messages, priority levels, 

and organizational categories.
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Creating and Managing Your Signature 
and Automated Settings 
A signature is text automatically added to any message that you send. For 

example, a signature can include your name, your job title, and your phone 

number. Signatures are flexible and can also include paragraphs informing 

recipients of how to respond to a message you send them or even where to 

reach you.

Exercise 5-1  CREATE AND MODIFY A PERSONAL 
SIGNATURE

You must create a signature before you can apply it to your messages. You 

can even create various signatures and choose the appropriate one to apply 

to your message.

 1. With the Inbox window displayed, click Tools on the menu bar and 

click the Options item from the drop-down menu. The Options 

dialog box appears.

Figure 5-1 
The Options dialog 

box

LESSON 5 Managing E-mail Efficiently



UNIT 3 Advanced Topics
O

u
tl

o
o
k
 2

0
0
7 126

 2. In the Options dialog box, click the Mail Format tab.

 3. Click on the Signatures button  in the Signatures 

area to manage your e-mail signatures. The Signatures and 

Stationery dialog box appears. Click the E-mail Signature tab if it is 

not already displayed.

 4. Click on the New button  in the E-mail Signature area. The 

New Signature dialog box appears.

 5. In the text box under Type a name for this signature, key your initials 

and click the OK button . You should now see your new 

entry selected in the Select a signature to edit list box.

 6. Click into the Edit signature text box and key your name and on a 

new line key WidgetWorks Intern. Click the Save button .

 7. In the Signatures and Stationery dialog box under Choose default 

signature, Outlook adds the new signature to the New Messages and 

Replies/forwards pop-up lists.

 8.  If your initials do not appear in the New Messages pop-up list, click 

the down arrow next to the list and choose the signature that you 

created in the previous steps.

 9.  Click the OK button . The Options dialog 

box reappears. Now that you have created a 

signature, you can have it automatically applied to 

any new message that you create.

10. Click the OK button . The Inbox reappears.

11.  Click the New button  and a message form appears. Outlook 

adds the signature text to the text area of the Message form. You key 

text above the signature, just as you would with any new message.

12. Close the message form without saving.

Exercise 5-2 EDIT A SIGNATURE

You can make changes to any signature you’ve created. For example, if 

your signature includes your phone number or job title, you can edit your 

signature if this information changes.

 1. Choose Tools on the menu bar and click the Options item from the 

drop-down menu. The Options dialog box appears.

 2. Click on the Signatures button  in the Signatures 

area of the Mail Format tab.

 3. Click to select the signature you want to edit in the Select signature 

to edit list box.

 4. Click into the Edit signature text box, delete “Intern” in the current 

signature text, and key Design Associate. Click the Save button 

. The signature now contains your modifications.

TIP

You can format your signature using the 
tools provided in the Signatures and 

Stationery dialog box. You can even add 
images and hyperlinks to your signature.
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 5. Click the OK button  to close the Signatures and Stationery 

dialog box and click the OK button  again to close the 

Options dialog box.

Exercise 5-3  ADD A SIGNATURE TO A SINGLE 
E-MAIL MESSAGE

If you decide that you do not want to include your signature in all outgoing 

messages, you can add the signature to specific e-mail messages that you 

select.

 1. Click on the New button  and a message form appears.

 2. In the To field, key your e-mail address.

 3. In the Subject field, key Signature Test.

 4. Click on the Signature button  and click on the signature you 

created earlier. Your signature will be added to your message.

 5. Click on the Send button  to send the test message to yourself.

Exercise 5-4  DISCONTINUE OR DELETE 
A SIGNATURE

If you decide you no longer want signatures automatically added to your 

messages, you can instruct Outlook to stop applying them. You can also 

delete a signature if it is no longer needed.

 1. Choose Tools on the menu bar and click the Options item from the 

drop-down menu. The Options dialog box appears.

 2. Click on the Signatures button  in the Mail Format 

Pane.

 3. In the Signatures and Stationery dialog box under Choose default 

signature, click the down arrow next to New messages and select 

(none). Do the same for Replies/forwards if needed.

 4. At this point you can click on the OK button  and click OK 

 again to apply your new preferences. You can also delete a 

signature completely.

 5. In the Signatures and Stationery dialog box under Select signature 

to edit, click the name of the signature you wish to remove and 

click the Delete button . A Microsoft Office Outlook alert 

box appears asking if you want to permanently remove the 

signature.

 6. Click Yes  and the signature is deleted.

 7. Click the OK button  to close the Signatures and Stationery 

dialog box and click the OK button  again to close the 

Options dialog box. The Inbox reappears.
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Exercise 5-5  USE AN ELECTRONIC BUSINESS CARD 
AS AN AUTOMATIC SIGNATURE 
IN MESSAGES

If you decide that you would like to use your business card in messages, you 

can add it in the Signatures and Stationery dialog box.

 1. With the Inbox window displayed, click Tools on the menu bar and 

click the Options item from the drop-down menu. The Options 

dialog box appears.

 2. In the Options dialog box, click the Mail Format tab.

 3. Click on the Signatures button  in the Signatures 

area of the Mail Format tab to manage your e-mail signatures. The 

Signatures and Stationery dialog box appears. Click the E-mail 

Signature tab if it is not already displayed.

 4. Click on the New button  in the E-mail Signature area. The 

New Signature dialog box appears.

 5. In the text box under Type a name for this signature, key business 

and click the OK button . You should now see your new 

entry selected in the Select a signature to edit list box.

 6. Click on the Business Card button . The Insert Business 

Card window appears.

Figure 5-2 
The Insert Business 

Card window
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 7. Click on one of your business cards and click on the OK button 

 to add it to your signature.

 8. In the Signatures and Stationery dialog box under Choose default 

signature, Outlook adds the new signature to the New Messages and 

Replies/forwards pop-up lists.

 9. If the text “business” does not appear in the New messages pop-up 

list, click the down arrow next to the list and choose the signature 

that you created in the previous steps.

 9. Click the OK button . The Options dialog box reappears. 

Now that you have created a signature, you can have it 

automatically applied to any new message that you create.

 10. Click the OK button . The Inbox reappears.

 11. Click the New button  and a message form appears. 

Outlook adds the business card as an attachment to your e-mail 

message.

 12. Close the message form without saving.

Exercise 5-6  CREATE AN INTERNAL OUT OF OFFICE 
MESSAGE

The Internal Out of Office Message feature can be useful, as it automatically 

replies to messages within your organization when you are out of the office. 

You can set up an internal out of office message by using the Tools, Out of 

Office Assistant task path.

 1.  Click on the Tools menu and click on the Out of 

Office Assistant option. The Out of Office Assistant 

window appears.

 2.  Click on the Send Out of Office auto-replies option.

 3. Click on the Only send during this time range option.

 4. Select 5:00 P.M. approximately one week from today as your start 

time.

 5. Select 8:00 A.M. approximately two weeks from today as your end 

time.

 6. Click on the Inside My Organization tab if it is not already selected. 

Key I am on vacation for a week and will read your message upon my 

return.

 7. Click on the OK button.

NOTE

You must be using a Microsoft Exchange 
server to complete this exercise.
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Exercise 5-7  CREATE AN EXTERNAL OUT OF OFFICE 
MESSAGE

The External Out of Office Message feature can be useful, as it automatically 

replies to messages outside of your organization when you are out of the 

office. You can set up an internal out of office message by using the Tools, 

Out of Office Assistant task path.

 1.  Click on the Tools menu and click on the Out of 

Office Assistant option. The Out of Office Assistant 

window appears.

 2. Click on the Send Out of Office auto-replies option.

 3. Click on the Only send during this time range option.

 4.  Select 5:00 P.M. approximately one week from today 

as your start time.

 5.  Select 8:00 A.M. approximately two weeks from 

today as your end time.

 6.  Click on the Outside My Organization tab if it is not 

already selected. Key I am on vacation for a week and 

will read your message upon my return.

 7. Click on the OK button.

Configuring E-mail Message Sensitivity 
and Importance Settings
Configuring e-mail message sensitivity and importance settings can help the 

recipient of your e-mail message to understand how to work with it. Therefore, 

the recipient will know whether or not to read an e-mail message in public or 

if an e-mail is important and needs to be addressed immediately.

Exercise 5-8 SET MESSAGE SENSITIVITY LEVEL

Sensitivity levels can be useful to recipients because they inform them how 

to work with the message. You can edit the sensitivity level of a message 

by clicking on the Options dialog box launcher on the Message tab on the 

Ribbon.

 1. Click on the Mail button  on the Navigation pane.

 2. Click on the New button  on the Standard toolbar.

 3. Click on the Options dialog box launcher  on the Message tab on 

the Ribbon. The Message Options dialog box appears.

NOTE

You must be using a Microsoft Exchange 
server to complete this exercise.

TIP

If you do not use a Microsoft Exchange 
server, you may be able to get similar 

results by using Rules, discussed later in 
this chapter.
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Figure 5-3 
The Message 

Options dialog box

Figure 5-4 
The message sent 
as confidential and 

important

 4. In the Message Settings section, select Confidential from the 

Sensitivity drop-down list.

 5. Click on the Close button .

 6. In the To field, key your e-mail address.

 7. In the Subject field, key Confidential Important Message.

 8. In the Message area, key Confidential Important Message.

 9. Click on the High Importance button .

10. Click on the Send button.

11.  Click on the Send/Receive button if the message did 

not arrive yet.

12.  Click on Confidential Important Message. You should 

notice that an information bar appeared indicating 

that the message was confidential and important.

NOTE

Importance levels can be set as High, 
Normal, and Low. High-importance 

messages have a red exclamation point 
next to them, as shown in Figure 5-4. 

Low-importance message settings have a 
blue down arrow next to them.
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Configuring E-mail Message 
Security Settings
When working with e-mail, you may want to increase your security. You 

can do so by using a digital ID, restricting permissions on a message, 

or encrypting a message. A digital ID allows the recipient to verify that a 

message is really from you. Restricting permissions can prevent recipients 

from forwarding messages to others. Encrypting a message scrambles it so 

that only the recipient with your digital ID can read it.

Exercise 5-9 DIGITALLY SIGN A MESSAGE

You can add a digital signature from the Message Options dialog box.

 1.  Switch to Outlook’s Mail component by clicking the 

Mail button on the Navigation bar.

 2.  Click on the New button on the Standard toolbar to 

create a new e-mail message.

 3. In the To field, key your e-mail address.

 4. In the Subject Field, key Testing Digital Signature.

 5. Click on the Options dialog box launcher on the Message tab on the 

Ribbon. The Message Options window appears.

 6. Click on the Security Settings button . The Security 

Properties window appears.

NOTE

You must have a digital ID to complete 
this exercise.

Figure 5-5 
The Security 

Properties window
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 7. Click on the checkbox next to Add digital signature to this message. 

Click on the OK button, then the Close button.

 8. Click on the Send button to send the message.

Exercise 5-10  RESTRICT PERMISSIONS 
TO A MESSAGE

You can restrict permissions to a message by using the Microsoft Office 

Button, Permission task path.

 1.  Switch to Outlook’s Mail component by clicking the 

Mail button on the Navigation bar. 

 2. Click on the New button to create a new message.

 3. In the To field, key your e-mail address.

 4.  In the Subject field, key Message with Restrictions.

 5. In the Message area, key Restricted Message (cannot forward).

 6. Click on the Microsoft Office Button  in the Message window.

 7. Click on the Permission option and click on Do Not Forward.

 8. Click on the Send button to send the message.

Exercise 5-11 ENCRYPT A MESSAGE

You can encrypt a message and its attachments from the Message options 

dialog box.

 1.  Switch to Outlook’s Mail component by clicking the 

Mail button on the Navigation bar.

 2.  Click on the New button on the Standard toolbar to 

create a new e-mail message.

 3.  In the To field, key the e-mail address of your partner 

with whom you exchanged digital IDs.

 4. In the Subject Field, key Testing Encryption.

 5. In the Message area, key This is a sample encrypted message.

 6. Click on the Options dialog box launcher on the Message tab on the 

Ribbon. The Message Options window appears.

 7. Click on the Security Settings button. The Security Properties 

window appears.

NOTE

You must have the Windows Rights 
Management Services Client installed. 

Windows Vista users will have this feature 
installed by default.

NOTE

You must have a digital ID to complete 
this exercise and exchange it with 

a partner.
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 8. Click on the checkbox next to Encrypt message contents and 

attachments. Click on the OK button, then the Close button.

 9. Click on the Send button to send the message.

Configuring E-mail Message 
Delivery Options
Among Outlook’s extensive mail features, you can flag e-mail messages. 

The flags bring specific messages to your attention or to the attention of 

your recipient(s) with optional reminders. Another useful delivery option 

is delaying the delivery of a message. This feature can be used to send a 

message that needs to be delivered on a specific date/time.

Since efficiently managing our e-mail is important with the volume that 

we receive, we can use delivery receipts and/or read receipts so that we know 

if a message that we sent was delivered and read.

Another useful feature in Outlook is creating e-mail polls to gather data 

quickly. We can even request that replies sent from our recipients be sent to 

another address, if we manage multiple e-mail accounts.

Exercise 5-12 ADD A FLAG FOR FOLLOW-UP

You can flag an e-mail message to draw the recipient’s attention to it. 

The flag icon appears in the Flag column of the Inbox, and a banner is 

displayed in the e-mail message. You can flag a message by clicking on the 

Flag button.

 1.  Switch to Outlook’s Mail component by clicking the 

Mail button on the Navigation bar.

 2.  Click on the New button on the Standard toolbar to 

create a new e-mail message.

 3. In the To field, key a partner’s e-mail address.

 4.  In the Subject text box, key Traditional Home photo 

shoot.

 5.  In the Message area, key Traditional Homes 

magazine is doing an article on AllWood for their May 

issue. Two members of their staff will be arriving next 

Friday. Could you let George’s staff know? They will 

have the shop in order.

 6.  Click on the Follow Up button  on the 

Message Tab on the Ribbon and click on the 

Flag for Recipients option. The Custom window 

appears.

NOTE

The Flag for Me checkbox flags the 
message for the author of the e-mail 

message. The Flag for Recipients 
checkbox flags the message for the 

recipient of the message.

TIP

It is a good idea to flag messages for 
recipients who receive a high volume of 
e-mail. Flags help to ensure that your 

message receives attention.
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 7.  Leave the default options and click on the OK button.

 8. Click on the Send button.

Exercise 5-13  DELAY DELIVERY OF A MESSAGE

There may be occasions when you want to delay the delivery of an e-mail 

message. An example could be a student who would like to e-mail his 

or her parents at the beginning of a school year, but wanted to write the 

message to remove it from his or her task list. You can delay the delivery of 

an e-mail message by clicking on the Delay Delivery button on the Options 

tab on the Ribbon.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the New button on the Standard toolbar to create a new 

e-mail message.

 3. In the To field, key a partner’s e-mail address.

 4. In the Subject text box, key Delayed Message.

 5. In the Message area, key Delayed message.

 6.  Click on the Delay Delivery button  on the Options 

tab on the Ribbon. The Message Options window 

appears with the Do not deliver before option checked.

 7.  Select tomorrow morning at 9:00 A.M. from the 

drop-down list.

 8. Click on the Close button.

 9. Click on the Send button.

Figure 5-6 
The Custom window

NOTE

If you are using a Microsoft Exchange 
server, you may close Outlook and the 
message will be sent. If you are using a 
POP3 or IMAP account, you must have 
Outlook open and be connected to the 

Internet to send the message.
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Exercise 5-14  REQUEST READ AND DELIVERY 
RECEIPTS

There may be occasions when you want to ensure that e-mail messages that you 

sent were delivered and read. In these cases, you can request that you receive a 

receipt of the e-mail by selecting it on the Options tab on the Ribbon. A delivery 

receipt informs you when a message is delivered to the recipient’s e-mail box 

and a read receipt tells you when the recipient read your e-mail message.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the New button on the Standard toolbar to create a new 

e-mail message.

 3. In the To field, key a partner’s e-mail address.

 4.  In the Subject text box, key Delivery and Read Receipt.

 5. In the Message area, key Delivery and Read Receipt.

 6. Click on the Options tab on the Ribbon.

 7.  Click on the checkbox next to Request a Delivery 

Receipt and Request a Read Receipt.

 8. Click on the Send button.

Exercise 5-15  CREATE E-MAIL POLLS USING 
STANDARD BUTTONS

There may be occasions when you want to poll your employees or coworkers 

regarding different company events or policies. You can use polls by clicking 

on the Use Voting Buttons button on the Options tab on the Ribbon.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the New button on the Standard toolbar to create a new 

e-mail message.

 3. In the To field, key a partner’s e-mail address.

 4. In the Subject text box, key Pizza Party.

 5.  In the Message area, key Will you attend the Pizza Party on Saturday?

 6. Click on the Options tab on the Ribbon.

 7.  Click on the Use Voting Buttons button  on the 

Options tab on the Ribbon. From the drop-down 

list, click on the Yes;No option.

 8. Click on the Close button.

 9. Click on the Send button.

NOTE

When you select a read receipt, the 
recipient is asked if they want to send 

a receipt. Therefore, you are not 
guaranteed to receive a receipt if they 

select the No option.

NOTE

When the recipient receives the message, 
they will have the opportunity to vote yes 

or no.
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Exercise 5-16  CREATE E-MAIL POLLS USING 
CUSTOM BUTTONS

There may be occasions when you want to poll your employees or coworkers 

regarding different company events or policies. You can be more creative 

and customize the buttons for your polls by clicking the Custom option from 

the Options tab.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the New button on the Standard toolbar to create a new 

e-mail message.

 3. Click on the Options tab on the Ribbon.

 4. Click on the Use Voting Buttons button  on the Options tab on the 

Ribbon. From the drop-down list, click on the Custom option. The 

Message Option window appears with the Use voting buttons option 

checked. Here, you can type the options you would like to use 

separated by a; (semicolon).

 5. Click on the Close button.

 6. Close the New Message window without saving or sending the 

message.

Exercise 5-17  REQUEST REPLIES TO BE SENT TO 
ANOTHER E-MAIL ADDRESS

There may be occasions when you want replies to messages to go to another 

e-mail address. In these cases, you can change the reply-to address by clicking 

on the Direct Replies To button on the Options tab on the Ribbon.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the New button on the Standard toolbar to create a new 

e-mail message.

 3. In the To field, key a partner’s e-mail address.

 4. In the Subject text box, key Direct Replies to Another E-mail Address.

 5. In the Message area, key Direct Replies to Another E-mail Address.

 6. Click on the Options tab on the Ribbon.

 7. Click on the Direct Replies To  button on the Options tab on the 

Ribbon. The Message Options window appears with the Have replies 

sent to: checkbox checked.

 8. In the Have replies sent to: field, key another partner’s e-mail address.

 9. Click on the Close button.

 10. Click on the Send button.
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Organizing Mail Folders
Outlook lets you create separate folders for specific types of messages. For 

example, you might want to create separate folders for your personal or work-

related messages. You can then move relevant Inbox items into those folders. 

You can also rename and move folders, placing them in various locations in 

the folder hierarchy. Older files can be archived for long-term storage.

Exercise 5-18 CREATE AND MOVE MAIL FOLDERS

When you create a new folder, it is typically created under the Inbox folder in 

the folder list. You can create a folder by:

• Clicking on the File, New, Folder task path.

• Clicking on the New button and New Folder.

• Right-clicking on your Inbox and selecting the New Folder option.

• Clicking on the New button in the Move Items window.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the New button on the Standard toolbar to create a new 

e-mail message.

 3. In the To field, key your e-mail address.

 4. In the Subject text box, key Creating Folders.

 5. In the message area, key This message will be moved.

 6.  Click on the Send/Receive button if you have not 

received the e-mail message.

 7.  Right-click on the Creating Folders message and 

click on the Move to Folder option. The Move Items 

window appears.

Figure 5-7 
The Move Items 

window

TIP

You can also move messages by clicking 
them and dragging them into existing 

folders.
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 8. Click on the New button . The Create New Folder window 

appears.

Figure 5-8 
The Create New 
Folder window

 9. In the Name field, key Lesson 5.

10.  Click on the OK button. The Lesson 5 

folder was created under the Inbox 

folder.

11.  Click on the OK button to move the e-

mail message.

12.  Click on the Lesson 5 folder and drag it 

into Personal Folders.

13.  Your Lesson 5 folder is on the same level 

as your Inbox.

Exercise 5-19  MOVE MAIL BETWEEN FOLDERS

There may be occasions when you move mail to an incorrect folder, so you 

may have to move it to another folder. You can:

• Press Ctrl ⫹ Shift ⫹ V  while an e-mail message is selected.

• Right-click on an e-mail message and click on the Move to Folder option.

• Use the task path Edit, Move to Folder.

Figure 5-9 
The Lesson 5 Folder 
at the same level as 

the Inbox in Personal 
Folders
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 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the Sent Items folder in the Mail folders pane.

 3. Right-click on the Creating Folders e-mail message and click on the 

Move to Folder option.

 4. Click on the Lesson 5 folder and click on the OK button.

Exercise 5-20  SPECIFY WHERE A COPY OF A SENT 
MESSAGE IS SAVED

There may be occasions when you want mail that was for specific purposes 

to be saved to a folder other than the default Sent Messages folder.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the New button on the Standard toolbar to create a new 

e-mail message.

 3. In the To field, key a partner’s e-mail address.

 4. In the Subject text box, key Sent Message Saved to Lesson 5 folder.

 5. In the message area, key Sent Message Saved to Lesson 5 folder.

 6. Click on the Options tab on the Ribbon.

 7. Click on the Save Sent Item button  on the Options tab on the 

Ribbon and click on the Other Folder option. The Select Folder 

window appears.

 8. Click on the Lesson 5 folder and click on the OK button.

 9. Click on the Send button.

Exercise 5-21  EMPTY THE DELETED MAIL FOLDERS

When you delete items in Outlook, they are not immediately deleted. Deleted 

items are moved to the Deleted Items folder. Therefore, you must empty the 

Deleted Items folder to permanently delete items in Outlook. The Deleted 

Items folder is similar to the Recycle Bin in Windows.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the Lesson 5 folder.

 3. Click on the Sent Message Saved to Lesson 5 folder item to select it and 

press Delete . The e-mail message appears in your Deleted Items folder.

 4. Right-click on the Deleted Items folder and click on the Empty 

“Deleted Items” Folder option. A prompt appears asking if you are 

sure you want to permanently delete all the items and subfolders in 

the “Deleted Items” folder.
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Figure 5-10 
The New Task form

 5. Click on the Yes button.

Exercise 5-22 MANAGE JUNK E-MAIL MESSAGES

Sometimes mail arrives in your Inbox that is unsolicited adverstisements or 

other unwanted messages. Outlook provides advanced filtering techniques to 

reduce the clutter caused by these types of messages.

 1.  Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2.  Click on Tools from the menu bar and click on the Options item. The 

Options dialog box appears.

 3.  Click on the Junk E-mail button . The Junk E-mail 

Options window appears. 

Figure 5-11 
The Junk E-mail 
Options window
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 4. Click on the Safe Senders tab.

 5.  Click on the Add button . The Add 

Address or Domain window appears.

 6.  Key a partner’s e-mail address into the text box and 

click on the OK button.

 7. Click on the Blocked Senders tab.

 8.  Click on the Add button . The Add 

Address or Domain window appears.

 9.  Key phishing@phishing.com into the text box and 

click on the OK button.

10. Click on the OK button.

Creating, Modifying, and Removing 
Rules to Manage E-mail Messages
Rules in Outlook allow users to automate many e-mail tasks. You can use 

rules to automatically move, delete, categorize, and forward messages. You 

create rules in Outlook following a few steps in the Rules Wizard. Rules 

have three parts: the condition, action, and exceptions. The condition refers 

to the characteristics used to determine which messages are affected by the 

Rule. The action refers to what will happen to e-mail messages that meet 

the condition. The exception refers to the characteristics used to exclude 

e-mail messages that meet the original condition(s).

Once you have created a rule, it is easy to turn it on or off. Additionally, 

you can delete rules that are no longer valid.

Exercise 5-23  CREATE A RULE TO MOVE E-MAIL 
MESSAGES

You can create a rule to move e-mail message to a specific folder by selecting 

Rules and Alerts from the Tools menu.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click the Personal Folders option.

 3. Click on the drop-down arrow next to the New button on the Standard 

toolbar and click on Folder from the drop-down menu. The New 

Folder dialog box is displayed.

TIP

You can use the Ctrl ⫹Alt⫹ J  shortcut to 
quickly mark a message as Not Junk E-mail.

NOTE

If you would like to empty your Junk  
E-mail folder, you can right-click on it and 
click on the Empty “Junk E-mail” Folder 
option. If you receive a message in your 
Junk E-mail folder that is not junk, you 

can right-click on the message and move 
your mouse over the Junk E-mail Option 
and click on the Mark as not Junk option.
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 4. Key the name,  Lesson 5 Conference. Click on the OK button to create 

the folder and close the New Folder dialog box.

 5. Click Tools on the menu bar and click the Rules and Alerts option 

from the drop-down menu. The Rules and Alerts dialog box 

appears.

 6. Click the New Rule button . The Rules Wizard will 

appear. 

Figure 5-12 
The Rules Wizard

 7.  In the Stay Organized category, click on the Move 

messages with specific words in the subject to a folder 

option.

 8.  Click on the specific words link under Step 2. The 

Search Text dialog box will appear. 

NOTE

You can see an example of what each 
rule does after selecting it by viewing the 

example in the Step 2 area.
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 13. Click the Lesson 5 Conference folder and click the OK button. 

Figure 5-13 
The Search Text 

dialog box

 9. Key conference into the Specify words or phrases to search for in the 

subject: text field.

 10. Click on the Add button . The word “conference” is 

enclosed by quotation marks and was added to the Search list.

 11. Click on the OK button. The Rules Wizard will be displayed with the 

text “conference” as the specified search text.

 12. Click on the specified folder link under Step 2. The Rules and Alerts 

dialog box will open for you to select the folder to move the 

message to. 

Figure 5-14 
The Rules and Alerts 

dialog box
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Figure 5-15 
The Rules Wizard 
after completing 

Step 2

14. Click on the Next button .

15.  The Rules Wizard will continue to the next step, 

asking which conditions you want to check. Since 

we will not make changes at this point, click on the 

Next button  to continue.

16.  The Rules Wizard will continue to the next step, asking what you 

want to do with the message. Since we will not make changes at this 

point, click on the Next button to continue.

17. The Rules Wizard will continue to the next step, asking if there are 

any exceptions. We will not specify any exceptions at this point, so 

click on the Next button to continue.

TIP

You can add more words to search for 
in this step if you forgot to add specific 

words earlier.
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18.  This is the last stage of the Rules Wizard. Key 

Lesson 5 Conference into the Step 1: Specify a name 

for this rule field.

19.  Click on the Finish button  to complete 

the rule.

20.  Click the OK button to close the Rules and Alerts 

dialog box.

21.  To test the Rule to ensure that it worked properly, 

click on the New button to create a new e-mail 

message.

22. In the To text field, key your e-mail address.

23. In the Subject field, key Lesson 5 Conference Test.

24. In the Body field, key Rule test.

25. Click on the Send button.

26.  Click on the Lesson 5 Conference folder. Your e-mail 

message should be automatically placed in this 

folder.

Exercise 5-24  CREATE A RULE TO DELETE ALL 
E-MAIL FROM A SENDER

You can create a rule to delete all e-mail messages from a specific sender by 

selecting Rules and Alerts from the Tools menu.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click Tools on the menu bar and click the Rules and Alerts option 

from the drop-down menu. The Rules and Alerts dialog box 

appears.

 3. Click the New Rule button . The Rules Wizard will 

appear.

 4. In the Start from a blank rule category, click on the check messages 

when they arrive option.

 5. Click on the Next button .

 6. Click on the checkbox next to the from people or distribution list 

option.

TIP

It is a good idea to examine the rule at 
this point to ensure it is correct.

NOTE

Rules have three basic parts: a condition, 
action, and exception. The condition 
refers to the characteristic(s) used to 

determine if the e-mail message will be 
affected by the rule. The action refers to 
what will happen to e-mail messages that 
meet the condition. The exception refers 

to the characteristics used to exclude 
e-mail messages that meet the original 

condition(s).
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 7.  Click on the people or distribution list link in the 

Step 2 area.

 8. In the From text field, key junk@isp.isp.

 9. Click on the OK button.

10. Click on the Next button.

 11. Click on the delete it option and click on the Next button.

 12. The Rules Wizard will continue to the next step, asking if there are 

any exceptions. We will not specify any exceptions at this point, so 

click on the Next button to continue.

13.  This is the last stage of the Rules Wizard. Key Delete Junk Mail into 

the Step 1: Specify a name for this rule field.

Figure 5-16 
The Rules Wizard at 

Step 1

TIP

You can also select an individual from 
your contacts list to save time if the 

individual or distribution list is one of 
your contacts.
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14.  Click on the Finish button  to complete 

the rule.

15.  Click the OK button to close the Rules and Alerts 

dialog box.

Exercise 5-25  CREATE A RULE TO CATEGORIZE 
E-MAIL

You can create a rule to categorize all e-mail messages by selecting Rules and 

Alerts from the Tools menu.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click Tools on the menu bar and click the Rules and Alerts option 

from the drop-down menu. The Rules and Alerts dialog box 

appears.

 3. Click the New Rule button . The Rules Wizard will appear.

 4. In the Start from a blank rule category, click on the check messages 

when they arrive option.

 5. Click on the Next button .

 6. Click on the checkbox next to the marked as importance option.

 7. Click on the importance link under Step 2.

 8. The Importance dialog box will appear. 

Figure 5-17 
The Importance 

dialog box

 9. Click on the drop-down arrow  next to Normal, and click on High.

 10. Click on the OK button.

 11. Click on the Next button .

 12. Click on the assign it to a category option.

 13. Click on the Category link under Step 2. The Color Categories dialog 

box appears. 

TIP

You can create rules to delete messages 
from e-mail lists that you are listed on and 

have difficulty unsubscribing from.
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14.  Click on the checkbox next to Blue Category and 

click on the OK button.

15. Click on the Next button to continue.

16.  The Rules Wizard will continue to the next step, 

asking if there are any exceptions. We will not 

specify any exceptions at this point, so click on the 

Next button to continue.

 17. This is the last stage of the Rules Wizard. Key High Importance 

Messages into the Step 1: Specify a name for this rule field.

 18. Click on the Finish button to complete the rule.

 19. Click the OK button to close the Rules and Alerts dialog box.

Exercise 5-26  CREATE A RULE TO FORWARD E-MAIL

You can create a rule to forward e-mail messages by selecting Rules and 

Alerts from the Tools menu.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click Tools on the menu bar and click the Rules and Alerts option 

from the drop-down menu. The Rules and Alerts dialog box appears.

 3. Click the New Rule button . The Rules Wizard will appear.

Figure 5-18 
The Color Categories 

dialog box

NOTE

If it is the first time you are using a color 
category, you will be asked to rename 

it. It is good practice to give categories 
descriptive names.
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 4. In the Start from a blank rule category, click on the check messages 

when they arrive option.

 5. Click on the Next button .

 6. Click on the checkbox next to the where my name is in the To box 

option.

 7. Click on the Next button.

 8. Click on the checkbox next to the forward it to people or distribution 

list option.

 9. Click on the people or distribution list link under Step 2. The Rule 

Address dialog box appears.

 10. In the To text field, key backup@isp.isp.

11. Click on the OK button.

12. Click on the Next button to continue.

13.  The Rules Wizard will continue to the next step, 

asking if there are any exceptions. We will not 

specify any exceptions at this point, so click on the 

Next button to continue.

 14. This is the last stage of the Rules Wizard. Key My Backup into the 

Step 1: Specify a name for this rule field.

 15. Click on the Finish button to complete the rule.

 16. Click the OK button to close the Rules and Alerts dialog box

Exercise 5-27 TURN OFF RULES

You can turn a rule off by selecting Rules and Alerts from the Tools menu.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click Tools on the menu bar and click the Rules and Alerts option 

from the drop-down menu. The Rules and Alerts dialog box appears.

 3. Uncheck the My Backup rule by clicking on the checkbox next to it.

 4. Click the OK button to close the Rules and Alerts dialog box.

Exercise 5-28 DELETE RULES

You can delete a rule by selecting Rules and Alerts from the Tools menu.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click Tools on the menu bar and click the Rules and Alerts option 

from the drop-down menu. The Rules and Alerts dialog box appears.

NOTE

You can enter another e-mail address 
that is located in your contacts. This 

feature is useful to back up specific e-mail 
messages.
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 3. Click on the High Importance Messages Rule to select it.

 4. Click on the Delete button  to remove the rule.

 5. When asked to confirm the deletion, click on the Yes button.

 6. Click the OK button to close the Rules and Alerts dialog box.

Locating Office Outlook 2007 Items 
by the Search Feature
Even though we can work with our e-mail efficiently by using folders and 

automatically manage e-mail with rules, it is possible that we may lose a 

critical e-mail. Outlook has an Instant Search feature that allows you to 

search through all of your e-mail folders instantly.

Exercise 5-29  SEARCH ALL E-MAIL FOLDERS 
IN A SINGLE SEARCH

You can search all e-mail folders in a single search by clicking 

on the All Mail Items option under the Mail Folders and 

keying your search text into the Instant Search text field.

 1.  Switch to Outlook’s Mail component by clicking the 

Mail button on the Navigation bar.

 2.  Click on the All Mail Items option under the Mail 

folders.

Figure 5-19 
The All Mail Items 

Instant Search

NOTE

The Instant Search feature provides fast 
results. However, the results are based on 
an index that is created. Therefore, items 

that are not indexed will not be found 
by the Instant Search feature. Outlook 
automatically indexes messages in the 

background while your computer is idle.
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 3. Key Conference into the Instant Search text field.

 4. Now, all of the items found will appear.

 5.  To clear the search, click on the clear search 

button .

TIP

You can be more specific in your search 
using the query builder. Expand the query 

builder by clicking on the Expand the 
Query Builder button . The All Mail 

Items Instant Search box appears.

Figure 5-20 
The All Mail Items 

Instant Search dialog 
box

Exercise 5-30  LOCATE ALL ITEMS RELATED 
TO A SPECIFIC PERSON

Even though you can search through all of your mail messages at once, there 

may be times when you know that you received an e-mail message from 

an individual, but are not completely sure what the specifics were. In these 

cases, it is good to search for all items that are related to a specific person.

 1. Switch to Outlook’s Folder List component by clicking the Folder 

List button  on the Navigation bar.

 2. Click on the Expand the Query Builder button .

 3. In the From field, key your name.

 4. Press Enter .

 5. All of the items related to an individual will be listed.

Exercise 5-31 CREATE A CUSTOM SEARCH FOLDER

When using the Instant Search feature, you have to enter your search criteria 

each time you want to find information. Therefore, you can use a Custom 

Search Folder so that you do not need to search each time you want to find 

information. The Custom Search Folder is a virtual folder, which does not 

contain any items, but indexes them for quick reference.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the arrow next to the New button on the Standard toolbar 

and click on the Search Folder option. The New Search Folder 

window appears. 
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 3.  Scroll down to the bottom of the Select a Search 

Folder list and click on the Create a custom Search 

Folder option.

 4.  Click on the Choose button . The Custom 

Search Folder window appears.

 5. In the Name field, key E-mail From Your Friend.

 6. Click on the Criteria button . The Search Folder Criteria 

window appears. 

Figure 5-21 
The New Search 
Folder window

NOTE

The Choose button will only be available 
after you click on the Create a custom 

Search Folder option.

Figure 5-22 
The Search Folder 
Criteria window
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 7. In the From field, key a friend’s e-mail address.

 8.  Click on the OK button to close the Search Folder 

Criteria window. Then click on the OK button to 

close the Custom Search Folder window. Click on 

the OK button to return to your mailbox.

Customizing Your 
Outlook Experience
Now that you have become accustomed to 

many of Outlook’s different features, you can 

also customize the appearance of Outlook 

to meet your needs. In many cases, this will 

help to make you more productive by having 

many different features on the screen at all 

times.

Exercise 5-32  WORK WITH 
THE TO-DO 
BAR

The To-Do bar is a new feature in Outlook 

2007. It keeps your upcoming appointments 

and tasks available at all times.

 1.  If your To-Do bar is not already 

visible on the right side of Outlook, 

click on the task path View, To-Do 

Bar, Normal. 

 2.  If you would like to minimize the 

To-Do bar, click on the task path 

View, To-Do Bar, Minimize.

 3.  If you would like to maximize the 

To-Do bar, click on the task path 

View, To-Do Bar, Normal.

 4.  Click on the task path View, To-Do Bar, 

Options. The To-Do Bar Options 

window appears. 

 5.  Uncheck the checkbox labeled Show 

Task List.

 6. Click on the OK button.

 7. View the difference in the To-Do bar.

NOTE

If you click on your newly created custom 
search folder, it will automatically display 

the results that meet the criteria specified.

Figure 5-23 
The To-Do bar

Figure 5-24 
The To-Do Bar 

Options window
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Exercise 5-33  SELECT THE DEFAULT 
FORMAT FOR MESSAGES

You can format your e-mail messages in HTML (HyperText 

Markup Language), RTF (Rich Text Format), or plain text. If 

you use HTML or RTF, you will be able to format your e-mail messages with 

colors, sizes, and styles.

 1. Click on Tools from the menu bar and click on the Options option. 

The Options dialog box appears.

 2. Click on the Mail Format tab. 

TIP

Customize the To-Do bar to maximize 
your productivity.

Figure 5-25 
The Mail Format tab 
in the Options dialog 

box

 3. In the Message Format area, click on the drop-down arrow next to 

the Compose in this message format: list. Click on the Rich Text 

option.

 4. Click on the Cancel button to keep the HTML format.
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Exercise 5-34 CONFIGURE RPC OVER HTTP

Configuring RPC over HTTP allows you to access your Microsoft Exchange 

account from anywhere on the Web using a browser. However, your system 

administrator must set up the Microsoft Exchange server and provide you 

with the appropriate options.

 1. Click on the Calendar button in the Navigation pane.

 2. Click on the task path Tools, Account settings. The Account Settings 

window is displayed.

 3. Click on More Settings.

 4. Click on the checkbox next to Connect to Microsoft Exchange using 

HTTP.

 5. Click on the Exchange Proxy Settings button.

 6. Key the URL provided by your system administrator.

 7. If your system administrator requires you to use SSL, click on the 

Connect using SSL only checkbox.

 8. If your system administrator requires you to do so, click on the 

checkbox next to Only connect to proxy servers that have this 

principal name in their certificate. If you were required to check 

this checkbox, key msstd: and the URL provided by your system 

administrator.

 9. Click on either Basic Authentication or NTLM Authentication as 

directed by your system administrator.

 10. Agree to the modifications made.

5Lesson  Summary

• You can create a personal e-mail signature that is automatically added 

to all of your e-mails.

• You can create and manage multiple signatures.

• You can use electronic business cards with or in place of signatures.

• The Internal Out of Office Messages feature helps others within your 

company know when you are away.

• The External Out of Office Messages feature helps those outside of your 

company know when you are away.

• E-mail sensitivity and importance settings help your recipient 

understand how to treat an e-mail message.

• Restricting permissions to a message can prevent users from performing 

certain actions on a message (i.e., forwarding it to other recipients).
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• You can delay delivery of messages so that they are sent at a specific 

date and time.

• Read and delivery receipts help the sender to know if a message was 

delivered and read.

• You can use e-mail polls to gather data.

• You can use mail folders to keep your data organized.

• Rules help to automate mundane tasks.

• The Instant Search feature helps you to find information quickly.

LESSON 5  Command Summary

Feature Button Task Path Keyboard

Personal Signature  Tools, Options, Mail Format, 

  Signatures 

Insert Signature  

Out of Office Message  Tools, Out of Office Assistant

Restrict Permissions  Microsoft Office Button, 

  Permissions

Follow-Up Flag 

Delay Delivery 

Voting Buttons 

Create a Folder  File, New Folder

Move Mail Messages  Edit, Move to Folder Ctrl ⫹ Shift ⫹ V

Empty Deleted Messages  Tools, Empty “Deleted Items” 

  Folder

Rules  Tools, Rules and Alerts

New Search Folder  File, New, Search Folder Ctrl ⫹ Shift ⫹ P

To-Do Bar Options  View, To-Do Bar, Options 



Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 

choice by circling T or F.

 1. You can only manage one signature in Outlook.

 2. You can use electronic business cards as signatures.

 3. You need a Microsoft Exchange server to use Internal and External Out 

of Office messages.

 4. Message sensitivity appears in the body of the message.

 5. Low-importance messages have a blue down arrow next to them.

 6. A digital ID is required to use the digital signature feature.

 7. The recipient of an encrypted message needs the sender’s digital ID to 

read the message.

 8. Windows Rights Management Services Client is needed to set 

permissions on messages.

 9. You cannot delay the delivery of a message.

 10. There are three parts to each rule.

Short Answer Questions
Write the correct answer in the space provided.

 1. How can you insert electronic business cards into e-mail messages?

 2. What is the difference between internal and external out of office 
messages?

 3. How do you modify the sensitivity level of an e-mail message?

 4. What do digital signatures and encrypting messages have in common?

 5. What do flags help with?
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 6. When delaying a message, what is a requirement if you are not 
connected to a Microsoft Exchange server?

 7. What are the three parts of a rule?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 

answers. Support your answers with examples from your own experience, 

if possible.

 1. What are the advantages and disadvantages of using a textual signature 

as opposed to an electronic business card as your signature?

 2. When would you use polls?

 3. What rules would you use to make your life easier? Why?

Skills Review

Exercise 5-35
Create a personal signature and set it as the default signature in all 

messages.

 1.  Click on the Mail button in the Navigation pane if the Mail list is not 

already displayed.

 2. Create a new Signature by following these steps:

 a.  Click Tools on the menu bar and click on the Options item from the 

drop-down list.

 b.  Click on the Signatures button in the Signatures area of the Mail 

Format tab.

 c. Click on the New button on the E-mail Signatures tab.

 d. Key Business 2 for the name of your signature.

 e.  Click on the drop-down lists next to New Messages and Replies/

forwards and set Business 2 to your default signature. 

 f.  Your instructor will provide any additional information for you to 

key in for this signature.

 g.  Click on the OK button to close the Signatures and Stationery 

window.
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Exercise 5-36
Create an internal and external out of office message.

 1. Click on the Mail button in the Navigation pane.

 2. Create a new internal out of office message by following these steps:

 a.  Click on the Tools menu and click on the Out of Office Assistant 
option.

 b. Click on the Send Out of Office auto-replies option.

 c. Click on the Only send during this time range option.

 d.  Select 5:00 P.M. approximately three weeks from today as your start 

time.

 e.  Select 8:00 A.M. approximately four weeks from today as your end 

time.

 f.  Click on the Inside My Organization tab if it is not already selected. 

Key I am on a business trip with minimal access to e-mail. I will check 
my e-mail periodically, but will be back in a week.

 g. Click on the OK button.

 3.  Create a new external Out of Office message by following these steps:

 a.  Click on the Tools menu and click on the Out of Office Assistant 
option. The Out of Office Assistant window appears.

 b. Click on the Send Out of Office auto-replies option.

 c. Click on the Only send during this time range option.

 d.  Select 5:00 P.M. approximately three weeks from today as your start 

time.

 e.  Select 8:00 A.M. approximately four weeks from today as your end 

time.

 f.  Click on the Outside My Organization tab if it is not already selected. 

Key I am on a business trip with minimal access to e-mail. I will check 
my e-mail periodically, but will be back in a week.

 g. Click on the OK button.
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Lesson Applications

Exercise 5-37
Send a message that is confidential and important.

You began working on a confidential project in your branch. However, 

your computer is in an open area, so you feel that you should inform your 

colleagues if an e-mail is confidential and if it needs immediate attention.

 1. Display your Mail Inbox.

 2. Create a new message.

 3. In the To field, key your instructor’s e-mail address.

 4. In the Subject field, key Project Update.

 5.  In the message area, key The project manager wants to finish the project 
one week early. I think I can make the deadline; can you?

 6. Change the importance setting to High Importance.

 7. Change the sensitivity level of the message to Confidential.

 8. Send the message.

Exercise 5-38
Set security settings and message flags.

Since you started working on the confidential project, you felt that you 

should digitally sign messages to the other team members so that they 

know the e-mail messages you send are from you. You also want to encrypt 

messages for added security and do not want the message to be forwarded. 

You also feel that flagging the message will indicate to your recipient that 

an action is needed.

 1. Display your Mail Inbox.

 2. Create a new e-mail message.

 3. In the To field, key your instructor’s e-mail address.

 4. In the Subject field, key Confidential Project.

 5.  In the message area, key Please submit the abstract of the project to the 
project manager by the end of the day tomorrow.

 6.  Click on the Options dialog box launcher on the Message tab on the 

Ribbon and click on the Security Settings button.

 7.  Click on the checkbox next to the Encrypt message contents and 

attachments option and the checkbox next to the Add digital signature 

to this message option.

NOTE

This exercise requires you to have a 
digital ID and have exchanged it with your 

instructor.
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 8.  Change the permissions of the e-mail message so that the recipient 

cannot forward it.

 9. Flag the message for follow-up with a due time of 4:00 P.M.

 10. Send the message.

Exercise 5-39
Create a folder and rules to automatically sort your e-mail.

While working on the confidential project, you want all e-mail messages from 

individuals on the project to be automatically sorted into a folder for you.

 1. Display your Mail Inbox.

 2. Create a new folder named Confidential Project.

 3.  Create a new rule to automatically move messages from your instructor 

into the Confidential Project folder.

 4.  Create a new rule to automatically move messages with the subject 

Confidential Project into the Confidential Project folder.

Exercise 5-40  Challenge Yourself
Delay the delivery of an e-mail message, request delivery and receipt of 

the e-mail message, and use polls.

While working on the confidential project, you found that you need to take 

a poll of the members who can make a Saturday morning meeting. Since 

this e-mail message is important, you decided that you want to receive both 

a delivery and a read receipt. However, the project manager instructed you 

to send this e-mail message tomorrow at 9:00 A.M.

 1. Display the Mail Inbox.

 2. Create a new message.

 3.  In the To field, key the e-mail address of three classmates and your 
instructor.

 4. In the Subject field, key Saturday Morning Meeting Poll.

 5.  In the message area, key Can you make it to a meeting on Saturday at 
9:00 A.M. for the Confidential Project?

 6. Add the Yes;No voting buttons to your message.

 7.  Change the settings of the e-mail message so that you receive both 

delivery and read receipts.

 8. Set the e-mail message to be sent tomorrow morning at 9:00 A.M.

 9. Send the e-mail message.
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In these exercises you work on your own, as you would in a real-life work 

environment. Use the skills you’ve learned to accomplish the task—and be 

creative.

Exercise 5-41
Open Outlook and experiment with the different signature options. Write 

an e-mail to your instructor that explains when it would be beneficial to use 

the different settings. Be sure to explain your reasoning.

Exercise 5-42
Open Outlook and review the different delivery options. Write an e-mail 

to your instructor that explains when it would be beneficial to use the 

different settings. Be sure to explain your reasoning.

Exercise 5-43
Create a rule to copy all incoming e-mail messages with attachments to a 

folder of your choice. Ask a friend to send you an e-mail message with an 

attachment. When you receive the e-mail, check your folder to ensure your 

rule worked. Be sure to reply to your friend’s e-mail to let them know you 

received the attachment and that your rule worked properly.

On Your Own
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After completing this lesson, you will be able to:

1. Work with categories.

2. Create a data file.

3. Add an Outlook data file to a mail profile.

4.  Remove an Outlook data file from a mail profile.

5. Change data file settings.

MCAS OBJECTIVES

In this lesson:

OL07 5.1.1

OL07 5.1.2

OL07 5.2.1

OL07 5.2.2

OL07 5.2.3

OL07 5.4.4

OBJECTIVES

Lesson 6

Categorizing and 

Managing Outlook 

Data Files

OL3.6

When you assign categories to Outlook items such as tasks and appointments, 

you select from the master category list, which is the Outlook-supplied 

set of categories for grouping, filtering, finding, or sorting items. Outlook 

enables you to create your own categories that you can add to the Master 

Category list. After creating your categories, you can categorize messages, 

appointments, meetings, contacts, and tasks.

Outlook keeps your data saved as a Personal Folder file, which has a 

.pst file extension. You can create multiple personal folder files to help 

you manage multiple e-mail accounts efficiently. Therefore, you can direct 

messages from one e-mail account to a personal folder file and messages 

from the other e-mail account to another personal folder file.

Working with Categories
Outlook enables you to create categories to categorize messages, 

appointments, meetings, and contact information. This helps individuals 

manage information better by assigning it to different color categories and 

names.

 Estimated Time: 1 hour
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Exercise 6-1  CREATE CUSTOM COLOR CATEGORIES 
AND ASSIGN CATEGORIES TO E-MAIL 
AND APPOINTMENTS

There are several ways to create a custom color category in Outlook. You can:

• Choose All Categories from the Categorize button.

• Use the task path: Edit, Categorize, All Categories

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click on the New button  on the Standard toolbar to create a 

new mail message.

 3. Key your e-mail address into the To field.

 4. Click in the Subject field and key Dentist Appointment.

 5. In the message area, key Tuesday, August 7 at 11:00 A.M.

 6. Click on the Send button.

 7. Click on the Send/Receive button to receive the mail message.

 8. Once you receive the message, click on it to select it.

 9. Click on Edit from the menu bar and mouse over Categorize and click 

on the All Categories option. The Color Categories window appears. 

Figure 6-1
The Color Categories 

window

 10. Click on the checkbox next to Blue Category.
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 11. Click on the Rename button .

 12. Key Home and press Enter .

 13. Click on the OK button .

 14. Switch to Outlook’s Calendar component by clicking the Calendar 

button on the Navigation bar.

 15. Click on the drop-down arrow next to the New button and click on 

the Appointment option.

 16. In the Subject field, key Meeting with Joan.

 17. In the Location field, key Office 101.

 18. Set the start time to August 7 at 1:00 P.M.

 19. Set the end time to August 7 at 2:00 P.M.

 20. Click on the Categorize button  and select All Categories. The 

Color Categories window appears.

 21. Click on the New button . The Add New Category window 

appears.

Figure 6-2
The Add New 

Category window

 22. In the Name field, key Business.

 23. Click on the drop-down arrow next to Color and select Red.

 24. Click on the OK button  in the Add New Category selection 

pane, and then Click on the OK button in the Color Category Pane..

 25. Click on the Save & Close button.

Exercise 6-2  ASSIGN CATEGORIES TO MEETINGS, 
CONTACTS, AND TASKS

There are several ways to assign a color category in Outlook. You can:

• Choose All Categories from the Categories button.

• Use the task path: Edit, Categorize, All Categories

 1. Switch to Outlook’s Calendar component by clicking the Calendar 

button on the Navigation bar.
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 2. Click on the drop-down arrow next to the New button and click on 

the New Meeting Request option. The New Meeting window 

appears.

 3. In the To field, key your e-mail address.

 4. In the Subject field, key Operations Meeting.

 5. In the Location field, key Office 102.

 6. Set the start time to August 8 at 1:00 P.M.

 7. Set the end time to August 8 at 2:00 P.M.

 8. Click on the Categorize button  and click on Green Category.

 8. Click on the Send button.

 9. Switch to Outlook’s Calendar component by clicking on the Contacts 

button on the Navigation bar.

 10. Click on the drop-down arrow next to the New button and click on 

the New Contact option. The New Contact window appears.

 11. In the Full Name field, key Student 3.

 12. In the Company field, key University.

 13. In the Job Title field, key Manager.

 14. In the E-mail field, key student3@isp.isp.

 15. In the Display as field, key Student 3.

 16. Click on the Categorize button  and click on Green Category.

 17. Click on the Save & Close button.

 18. Switch to Outlook’s Tasks component by clicking on the Tasks button 

on the Navigation bar.

 19. Click on the drop-down arrow next to the New button and click on 

the New Task option. The New Task window appears.

 20. In the Subject field, key Make Credit Card Payment.

 21. Set the Due date to August 9.

 22. Click on the Categorize button  and click on Home Category.

 23. Click on the Save & Close button.

Exercise 6-3  SORT ITEMS BY COLOR CATEGORY

You can sort items by color category by using the task path: View, Arrange 

By, Categories.

 1.  Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.



UNIT 3 Advanced Topics
O

u
tl

o
o
k
 2

0
0
7 168

 2.  Click on View from the menu bar, mouse over 

Arrange By, and click on the Categories option.

 3.  Click on View from the menu bar, mouse over 

Arrange By, and click on the Date option. Now, your 

messages are sorted by Date.

Creating and Managing Outlook 
Data Files
You can create Outlook data files to help you better manage your personal 

folders. Each new data file folder acts as a new set of folders at the top level, 

similar to the Personal Folders data file folder that is automatically created 

when you first start Outlook.

Exercise 6-4 CREATE A DATA FILE

To create an Outlook data file, you can click on the arrow next to the New 

button and click on the Outlook Data File option.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Click the arrow next to the New button  and click on the 

Outlook Data File option. The New Outlook Data File window 

appears.

Figure 6-3
The New Outlook 
Data File window

 3. Select the Office Outlook Personal Folders File (.pst) option if it is 

not already selected. Click on the OK button . The Create or 

Open Outlook Data File window appears.

NOTE

Messages without a color category will be 
listed at the top of your message list.
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Figure 6-4
The Create or Open 
Outlook Data File 

window

 4. In the File name field, key Conference. Click on the OK button 

 to continue. The Create Microsoft Personal Folders window 

appears.

Figure 6-5
The Create Microsoft 

Personal Folders 
window

 5. In the Name field, key Conference 2007. Click on the OK button 

 to continue. The Conference 2007 folder is displayed in the 

Navigation pane.

 6. Click on the + (plus) sign next to the Conference 2007 folder to 

display its contents.
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Exercise 6-5  ADD AN 
OUTLOOK 
DATA FILE TO A 
MAIL PROFILE

To add an Outlook data file to a mail profile, 

you can click on the Tools option from the 

menu bar and click on Account Settings.

 1.  Switch to Outlook’s Mail component 

by clicking the Mail button on the 

Navigation bar.

 2.  Click on the Tools option from the 

menu bar and click on Account Settings. 

The Account Settings window appears. 

Your e-mail account will be listed under 

the E-mail tab. If you receive messages 

from multiple accounts, they will also 

be listed.

 3. Click on your e-mail account.

 4. Click on the Change Folder button . The New E-mail 

Delivery Location window appears.

Figure 6-6
The newly created 
Outlook data file 

folder

Figure 6-7
The New E-mail 

Delivery Location 
window

 5. Click on the Conference 2007 folder.

 6. Click on the New Folder button . The Create Folder 

dialog box appears.
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 7. In the Folder name field of the Create Folder dialog box, key Inbox.

 8. Click on the OK button .

 9. Click on the Inbox folder in the Conference 2007 folder.

 10. Click on the OK button . In the Account Settings window, 

you will see that the new e-mail will be delivered to the 

Conference.pst Outlook data file.

Figure 6-8
The Account Settings 
window showing the 
new e-mail delivery 

location

11.  Leave the Account Settings window open for the 

next exercise.

Exercise 6-6  REMOVE AN OUTLOOK 
DATA FILE FROM A MAIL 
PROFILE

To remove an Outlook data file from a mail profile, you can click on the 

Tools option from the menu bar and click on Account Settings.

 1. The Account Settings window should be open from the previous 

exercise.

 2. Click on the Change Folder button . The New E-mail 

Delivery Location window appears.

 3. Click on the + (plus) sign next to the Personal Folders folder and 

click on the Inbox folder.

TIP

You can create a new Outlook data file 
each year to ensure it does not grow too 

large and degrade performance.
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 4. Click on the OK button . In the Account Settings window, 

you will see that the new e-mail will be delivered to the Outlook.pst 

Outlook data file.

 5. Click on the Close button  to close the Account Settings 

window.

Exercise 6-7 CHANGE DATA FILE SETTINGS

To change data file settings, you can right-click on a personal folder and click 

on the Properties option.

 1. Switch to Outlook’s Mail component by clicking the Mail button on 

the Navigation bar.

 2. Right-click on the Personal Folders folder and click on Properties for 

“Personal Folders”. The Outlook Today - [Personal Folders] 

Properties window will appear.

Figure 6-9
The Outlook Today- 
[Personal Folders] 
Properties window

 3. Click on the Advanced button . The Personal Folders 

window appears.
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 4. In the Name field, key First Data File.

 5.  Click on the Change Password button . 

The Change Password window appears.

 6. Click on the Cancel button .

 7.  Click on the Compact Now button . 

An alert window appears indicating that the data 

file is compacting.

 8.  Click on the Cancel button  to close the 

Personal Folders window.

 9.  Click on the Cancel button to close the Outlook 

Today - [Personal Folders] Properties window.

TIP

 You can edit the name of your Personal 
Folder, create a password, and even 

compact the file to save space.

NOTE

You can enter a password here to 
password-protect your data file.

Lesson  Summary

• You can create new custom color categories by renaming an existing 

color category.

• You can use categories to differentiate between home, work, and other 

categories.

• You can apply categories to messages, appointments, meetings, and 

contacts.

• You can assign categories to e-mail messages after they are received.

• You can assign categories to appointments, meetings, and contacts 

while you create the new item.

• When you’re sorting by color categories, items that are not categorized 

appear at the top of the list.

• Outlook data files are saved in Personal Folder File (.pst) format.

• Including multiple .pst files helps to keep multiple e-mail accounts 

organized.

• You can compact a .pst file in the Properties window of the data file.

6

LESSON 6  Command Summary

Feature Button Task Path Keyboard

Categories  Edit, Categorize, All Categories 

Sort by Categories  View, Arrange By, Categories 

Create an Outlook Data File  File, New, Outlook Data File 
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Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 

choice by circling T or F.

 1. You can create a new category by renaming an existing one.

 2. You can assign categories to e-mail as it arrives.

 3. You can assign e-mail, tasks, contacts, meetings, and appointments to 

categories as you create them.

 4. Items that are not categorized appear at the top of a list when sorting by 

categories.

 5. Each new Outlook data file acts as a new set of folders at the top level.

 6. The Outlook Data File option is available from the New button.

 7. You cannot compress Outlook data files.

 8. You must edit your settings to accept e-mail to a new Outlook data file.

 9. Outlook data files cannot be removed from e-mail profiles.

 10. You can password-protect your Outlook data file from the Home Page 

tab of the Outlook Data File Properties.

Short Answer Questions
Write the correct answer in the space provided.

 1. What is the task path to edit existing categories?

 2. How is e-mail different from appointments, meetings, contacts, and 
tasks when working with categories?

 3. What is the task path to sort items by category?

 4. What is the filename extension for a personal folder file?

 5. What does a + (plus) sign next to a folder in your mail folder indicate?

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 
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 6. What window includes the option to change the delivery location of 
e-mail?

 7. When working with the properties of a personal folder file, which 
button gives you access to compact your data file?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 

answers. Support your answers with examples from your own experience, 

if possible.

 1. What categories would be useful for you to create?

 2. How many Outlook Personal Folder files would you use and why?

 3. When would passwords be useful with Outlook Personal Folder files?

Skills Review

Exercise 6-8
Add a new category and assign a task to that category.

 1.  Click on the Tasks button in the Navigation pane if the Task list is not 

already displayed.

 2. Create a new task by following these steps:

 a. Click the New button on the Standard toolbar.

 b. In the Subject field, key Balance Checkbook.

 c.  Click on the drop-down arrow next to the Due date field and click on 

the date for next Friday.

 d. Click on the Categorize button and click on the All Categories option.

 e.  Click on the checkbox next to Green Category and click on the 

Rename button.

 f. Key Finances and press .

 g. Click on the OK button.

 h. Click on the Save & Close button on the Task tab on the Ribbon.

Exercise 6-9
Create a new personal folder file, add it to a mail profile, and remove it 

from the mail profile.

 1. Click on the Mail button in the Navigation pane.
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 2. Create a new Outlook data file by following these steps:

 a.  Click the drop-down arrow next to the New button on the Standard 

toolbar and click on the New Outlook Data File option.

 b. In the New Outlook Data File window, click on the OK button.

 c.  In the File name field of the Create or Open Outlook Data File 

window, key Home E-mail and click on the OK button.

 d.  In the Name field of the Create Microsoft Personal Folders window, 

key Home and click on the OK button.

 3. Add the Outlook data file to your mail profile by following these steps:

 a.  Click on the Tools option from the menu bar and click on Account 
Settings.

 b. Click on your e-mail account to select it.

 c. Click on the Change Folder button.

 d. Click on the Home folder.

 e. Click on the OK button.

 4.  Remove the Outlook data file from your mail profile by following these 

steps:

 a.  The Account Settings window should be open from the previous 

exercise.

 b. Click on the Change Folder button.

 c.  Click on the + (plus) sign next to the Personal Folders file and click 

on the Inbox folder.

 d. Click on the OK button.

 e. Click on the Close button to close the Account Settings window.
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Lesson Applications

Exercise 6-10
Create a business contact.

You’ve decided to start creating your contacts under categories to help you 

stay organized. You recently met a potential business partner while out to 

lunch. You exchanged information and would like to input it into your con-

tact list as a contact under the “Business” category.

 1. Display your Contacts and create a new contact.

 2. In the Full Name field, key Michelle Nichols.

 3. In the Company field, key Widget Incorporated.

 4. In the Job title field, key Supervisor.

 5. In the E-mail field, key michellenichols@isp.isp.

 6. In the Display as field, key Michelle.

 7. Change the category of this contact to Business.

 8. Save and close the contact.

Exercise 6-11
Create a home appointment.

You e-mailed yourself a reminder regarding your dental appointment in 

Exercise 6-1; however, you forgot to add it to your calendar as an appoint-

ment. Therefore, you will add your dentist appointment in your calendar 

under the Home category.

 1. Display your Calendar.

 2.  Create a new appointment from 11:00 A.M. to 

12:00 P.M. on August 7.

 3. In the Subject field, key Dentist Appointment.

 4. In the Location field, key Dentist Office.

 5. Set the Category to Home.

 6. Save and close the appointment.

Exercise 6-12
Create a new Outlook data file and compress it.

You noticed that the file size of your Outlook data file is large. Therefore, 

you decided to create a new Outlook data file and have all of your messages 

from this point forward sent there.

 1. Display the Mail list.

NOTE

This exercise requires you to have 
completed Exercise 6-1 to have the 
Business category. If you have not 

completed Exercise 6-1, complete it prior 
to beginning this exercise.

NOTE

This exercise requires you to have 
completed Exercise 6-1 to have the Home 

category. If you have not completed 
Exercise 6-1, complete it prior to 

beginning this exercise.
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 2. Create a new Outlook data file named Fiscal Year 2008.

 3. Set the folder name to Fiscal Year 2008.

 4.  Set all incoming e-mail messages on your account to go to the Inbox in 

this folder.

 5.  Rename the Inbox in your Personal Folders to Archive of Fiscal Year 
2007.

 6. Compress your Personal Folders data file.

Exercise 6-13  Challenge Yourself
Setting a default Outlook data file and categorizing messages sent to it.

You decided that your Outlook Inbox had not grown too large over time. 

In fact, you only had the Inbox for a few months. Therefore, you decided 

that it would be easier to work with one Inbox for the time 

being and categorize your messages.

 1. Display the Mail list.

 2.  Rename the Archive of Fiscal Year 2007 folder to 

Inbox.

 3.  Set all incoming e-mail messages on your account to 

go to the Inbox in the Personal Folders folder.

 4.  Send an e-mail message to yourself with the subject keyed as Grocery 
Shopping.

 5. Ensure that you receive the e-mail and set its category to Home.

 6.  Create a task out of the Grocery Shopping e-mail and set the due date to 

two weeks from today.

NOTE

This exercise requires you to have 
completed Exercise 6-12 to have Archive 
of Fiscal Year 2007 and Fiscal Year 2008 

folders. If you have not completed 
Exercise 6-12, complete it prior to 

beginning this exercise.

On Your Own

In these exercises you work on your own, as you would in a real-life work 

environment. Use the skills you’ve learned to accomplish the task—and be 

creative.

Exercise 6-14
Create a new e-mail message to your instructor. In the body of this message, 

key your answer to the first Critical Thinking question from the end of the 

lesson. Be sure to expand on your answer with reasons why you would use 

these categories. Send this message to your instructor with an appropriate 

subject line.
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Exercise 6-15
Create a new Outlook data file and add it to a mail profile. Ensure all in-

coming messages are delivered to an Inbox folder in your newly created 

data file. Ask a friend to e-mail you to ensure the incoming message is de-

livered to the correct folder. Change your settings back to default and delete 

your newly created Outlook data file.

Exercise 6-16
Open Outlook and experiment with the different Outlook data file settings. 

Write an e-mail to your instructor that explains when it would be beneficial 

to use the different settings. Be sure to explain your reasoning.
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Unit 3 Applications

Unit Application 3-1
Create a new signature, add your business card to your signature, send 

an e-mail message with your signature, and categorize your e-mail 

message.

You can categorize your contacts into logical workgroups to increase your 

productivity.

 1. Display your contacts and create a new contact.

 2. Insert your information into the contact.

 3. Save the contact.

 4. Create a new textual signature with your information.

 5. Add your business card to your signature.

 6. Set the signature you just created to be your default New Message and 

Replies/forwards signature.

 7. Create a new e-mail message, addressing it to your instructor.

 8. For the subject, key New contact information.

 9.  In the message area, key This is my new contact 
information as requested.

10. Send the message.

 11. Locate the message in your Sent Items folder.

 12. Create a new category named Contact using the yellow color.

 13. Assign the message you sent to the Contact category.

Unit Application 3-2
Delay delivery, flag for follow-up, request read and delivery receipts, 

vote, and create folders and rules.

You decided to e-mail your coworkers to determine whether they are available 

for the orientation session on Sunday. Therefore, you decided to use an 

e-mail poll to determine whether they will be able to make it or not. Since 

this is an important message, you decided to flag the message for follow-up 

and receive receipts of both delivery and read. You also decided to use your 

advanced Outlook skills to create a folder and have the replies automatically 

sorted into it.

 1. Display your Mail Inbox.

 2. Create a new e-mail message, addressing it to your instructor.

 3. In the subject field, key Orientation.

NOTE

Your instructor will provide you with an 
appropriate e-mail address.
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 4. In the message area, key Are you available for the Sunday orientation 
session?

 5. Add the Yes;No voting option to your e-mail message.

 6. Add a flag for follow-up. Set the reminder to tomorrow at 12:00 P.M.

 7. Check the options to ensure that you receive a read and delivery receipt.

 8. Send the message.

 9. Create a new folder named Orientation Poll.

 10. Create a rule to ensure that all replies to the Orientation e-mail are 

moved into the Orientation Poll folder.

Unit Application 3-3
Create and manage Outlook data files.

You noticed that the file size of your Outlook data file is large. Therefore, you 

decided to create a new Outlook data file and have all of your messages from 

this point forward sent there.

 1. Display the Mail list.

 2. Create a new Outlook data file named Home E-mail.

 3. Set the folder name to Home E-mail.

 4. Create an Inbox in the Home E-mail folder.

 5. Set all incoming e-mail messages on your account to go to the Inbox in 

the Home E-mail Inbox folder.

 6. Compress your Home E-mail data file.

 7. Change the properties of your Home E-mail data file to include a 

password of your choice.

 8. Remove the password from your Home E-mail data file.

 9. Set all of your incoming e-mail messages on your account to go to the 

Inbox in the Personal Folders Inbox folder.

 10. Delete the Home E-mail data file.

Unit Application 3-4  Using the Internet
Setting a Default Outlook Data File and Categorizing Messages Sent to It

Imagine that you’ve just won the lottery. Plan an elaborate European vacation 

for yourself and three friends to celebrate. You’ll be paying for all expenses 

yourself, but you want to be mindful of the costs. Although you’re paying for 

your friends, you’ll want to give them an idea of what everything will cost in 

case they would like to bring along a partner or spouse as well.

Plan your itinerary so that it includes at least three European cities. Make 

it at least a seven-day trip. Use the Internet to research airfares, hotel costs, 

meals, and other incidental expenses. For each city, select sights and points 
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of interests and create a daily schedule of activities. Develop an alternate plan 

for inclement weather. Research the local currency and current exchange 

rates and include those currencies in your daily budget.

After you’ve obtained your information, use Outlook for the following 

activities:

Add your instructor and your three traveling companions to your 

contact list and create a distribution list for all four names. Create a 

signature for yourself that adequately describes your newfound financial 

status.

Compose and send an e-mail message inviting your friends to join you 

in celebrating your good fortune, using the distribution list to address 

the message. Using the distribution list, send a second e-mail message 

describing the itinerary and the expenses for the trip. In both messages, 

use various message options.

Create rules to ensure that all of your travel e-mail messages are 

categorized as Travel under any specific color. Create a Travel folder and 

rules to automatically move messages to a Travel folder. Create a Search 

folder to automatically find messages related to the trip.

Pick a date on your calendar to schedule a pretrip meeting. Make your 

travel companions required attendees and your instructor an optional 

attendee. Set a reminder for the day before the meeting.

Schedule the trip on your calendar, filling in various time blocks as 

appointments. You do not have to account for the entire day, but show 

major activities. Display the calendar in the most appropriate way to 

view the trip.

Create a required task for each of your traveling companions. These 

might be such activities as getting a passport, buying traveling clothes, 

packing luggage, and so on. Assign a due date, a priority, and a 

reminder for each task, and include whatever task notes you think are 

appropriate. Create several tasks for yourself, as well.

•

•

•

•

•

•
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APPENDIX

Microsoft Office Objective Domain

TABLE A-1 Microsoft Office Outlook 2007 Activities Related to Lessons

Code Activity Lesson

1 Managing Messaging 1

1.1 Create and send an e-mail message 1

1.1.1 Send messages to multiple recipients 1

1.1.2 Reply to a message 1

1.1.3 Resend a message 1

1.1.4 Forward a message 1

1.2 Create and manage your signature and automated 

messages

5

1.2.1 Create and modify a personal signature 5

1.2.2 Create internal and external Out of Office Messages 5

1.3 Manage e-mail message attachments 1

1.3.1 Attach files and items to a message 1

1.3.2 Preview a message attachment in Office Outlook 2007 1

1.3.3 Save attachments to a specific location 1

1.3.4 Open a message attachment 1

1.4 Configure e-mail message sensitivity and importance 

settings

5

1.4.1 Set message sensitivity level 5

1.4.2 Set mail importance level 5

1.5 Configure e-mail message security settings 5

1.5.1 Digitally sign a message 5

1.5.2 Restrict permissions to a message 5

1.5.3 Encrypt a message 5

1.6 Configure e-mail message delivery options 5

1.6.1 Add or remove a flag for follow-up 5

1.6.2 Delay delivery of a message 5

1.6.3 Request read or delivery receipts 5

1.6.4 Create e-mail polls using standard or custom voting 

buttons

5

1.6.5 Request that replies be sent to a specific e-mail address 5

 A-1



Code Activity Lesson

1.7 View e-mail messages 1

1.7.1 Show, hide, or move the reading pane 1

1.7.2 Automatically preview messages 1

2 Managing Scheduling 3

2.1 Create appointments, meetings, and events 3

2.1.1 Create a one-time appointment, meeting, or event 3

2.1.2 Create a recurring appointment, meeting, or event 3

2.1.3 Create an appointment, meeting, or event from an e-mail 

message

3

2.1.4 Create an appointment, meeting, or event from a task 3

2.1.5 Mark an appointment, meeting, or event as private 3

2.2 Send meeting requests 3

2.2.1 Invite mandatory attendees to meetings 3

2.2.2 Invite optional attendees to meetings 3

2.2.3 Determine when attendees are available to meet 3

2.2.4 Track responses to meeting requests 3

2.2.5 Schedule meeting resources 3

2.3 Update, cancel, and respond to meeting requests 3

2.3.1 Change a meeting time 3

2.3.2 Add a meeting attendee 3

2.3.3 Modify one instance of a recurring meeting 3

2.3.4 Send meeting updates only to new attendees 3

2.3.5 Cancel a meeting 3

2.4 Customize Calendar settings 3

2.4.1 Define your work week 3

2.4.2 Display multiple time zones 3

2.4.3 Change time zones 3

2.4.4 Add predefined holidays to the Calendar 3

2.5 Share your Calendar with others 3

2.5.1 Configure Free/Busy privacy settings 3

2.5.2 Share your calendar with other Office Outlook 2007 users 

on your network

3

2.5.3 Send Calendar information in an e-mail message (send a 

calendar via E-mail)

3

2.5.4 Publish Calendar information to Office Online 3

TABLE A-1 (continued )
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2.6 View other Calendars 3

2.6.1 View a Calendar shared by another Office Outlook 2007 

user on your network

3

2.6.2 Subscribe to an Internet Calendar 3

2.6.3 View multiple Calendars in overlay mode 3

3 Managing Tasks 4

3.1 Create, modify, and mark tasks as complete 4

3.1.1 Create recurring tasks 4

3.1.2 Create a task from a message 4

3.1.3 Set the status, priority, and percent complete of a task 4

3.1.4 Mark a task as complete 4

3.1.5 Mark a task as private 4

3.2 Accept, decline, assign, update, and respond to tasks 4

3.2.1 Assign tasks to others 4

3.2.2 Respond to an assigned task 4

3.2.3 Send a status report on an assigned task 4

4 Managing Contacts and Personal Contact Information 2

4.1 Create and modify contacts 2

4.1.1 Create a contact from a blank contact 2

4.1.2 Create a contact from a message header 2

4.1.3 Create a contact from an electronic business card 2

4.1.4 Create a contact received as a contact record 2

4.1.5 Modify contact information 2

4.2 Edit and use an electronic business card 2

4.2.1 Edit an electronic business card 2

4.2.2 Send an electronic business card to others 2

4.2.3 Use an electronic business card as an automatic signature 

in messages

5

4.3 Create and modify distribution lists 2

4.4 Create a secondary address book 2

4.4.1 Create a secondary address book for personal contacts 2

4.4.2 Import a secondary address book from a file 2

5 Organizing Information 5, 6

5.1 Categorize Office Outlook 2007 items by color 6

Code Activity Lesson
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5.1.1 Categorize messages, appointments, meetings, contacts, 

and tasks by color

6

5.1.2 Sort Office Outlook 2007 items by color category 6

5.2 Create and manage Office Outlook 2007 data files 6

5.2.1 Create a data file 6

5.2.2 Add an Office Outlook 2007 data file to, or remove it 

from, a mail profile

6

5.2.3 Change data filer settings 6

5.3 Organize mail folders 5

5.3.1 Create and move mail folders 5

5.3.2 Move mail between folders 5

5.3.3 Specify where a copy of a sent message is saved 5

5.3.4 Empty the Deleted Mail and Sent items folders 5

5.3.5 Manage Junk e-mail messages 5

5.4 Locate Office Outlook 2007 items by the Search feature 5

5.4.1 Search all e-mail folders in a single search 5

5.4.2 Locate all items related to a specific person by searching 5

5.4.3 Locate tasks or contacts 4

5.4.4 Search Office Outlook 2007 items by category 6

5.4.5 Create a custom Search Folder 5

5.5 Create, modify, and remove rules to manage e-mail 

messages

5

5.5.1 Create a rule to move e-mail messages 5

5.5.2 Create a rule to categorize e-mail 5

5.5.3 Create a rule to forward e-mail 5

5.5.4 Create a rule to delete e-mail 5

5.6 Customize your Office Outlook 2007 Experience 5

5.6.1 Show, hide, or minimize the To Do bar 5

5.6.2 Customize the To Do bar 5

5.6.3 Select the default format for messages 5

5.6.4 Configure Office Outlook 2007 to be accessible through 

the Web

5

Code Activity Lesson
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Glossary

appointment An activity occurring on a specific day 
and time that does not involve inviting people to attend 
or reserving a room. (3)

AutoPreview An Outlook option that displays the first 
few lines of e-mail messages directly in the Inbox. (1)

categories Color categories can be assigned to 
messages, contacts, appointments, and tasks across 
the Outlook components. (6)

contact A person, business, or organization with 
whom you correspond. (2)

Date Navigator A small calendar that appears above the 
Navigation pane. It displays views of one or more months. 
Each date that contains a scheduled item is shown in bold 
in the calendar. Arrows at the top of the Date Navigator 
allow you to change the displayed dates. (3)

delegate To assign a task request to someone else. (4)

digital ID A file that can be attached to a message to 
digitally sign it or prove that you were the author or 
to digitally encrypt the message to hide it from others 
as it is being sent. Sometimes referred to as a digital 
certificate. (5)

distribution list A grouping of contacts that facilitates 
serving invitations and announcements by e-mail. (2)

electronic business card A view of one of the con-
tacts that you have stored in Outlook. This format can 
be attached to e-mails to make the information available 
to other Outlook users. (2)

encrypt A security method that cloaks a message by 
temporarily scrambling it into an unreadable form. (5)

event A Calendar activity that labels one or more days 
without any times being specified. (3)

Instant Search A new feature of Windows Vista and 
Microsoft Office 2007 that provides a fast, indexed 
searching tool. (5)

Internet Calendar An Internet standard for creating 
and sharing calendar information. (3)

Internet e-mail address An address that consists of 
the user’s name, the @ symbol (known as the “at” sign), 
and the user’s domain name. (1, 2)

mail profile An e-mail profile consists of e-mail 
accounts, data files, and information about where 
your e-mail is stored.

meeting A Calendar activity that involves inviting 
other people or reserving resources. (3)

meeting request An e-mail invitation that is sent to 
the Inbox of scheduled attendees allowing them to 
accept or decline or possibly propose new times. (3)

Microsoft Exchange Server A Microsoft server 
product that provides messaging and collaborative 
software services. Outlook is a client program to 
the Exchange server that will interchange messages 
among its users. (3)

Microsoft Office Online A free online service that 
integrates with the application’s Microsoft Outlook 
Calendar Sharing Service features. (3)

Navigation pane The pane displayed at the far left 
of the Outlook window used for navigating between 
the program’s different features and the folders used by 
those features. (1)

Online Help Outlook’s Help feature makes use of the 
Microsoft Office Web site and other Microsoft sites 
directly within the program through keying topics in 
the Help Search box. (1)

out-of-office message A message that you can turn 
on or off to automatically reply to those who send you 
messages. A useful feature when you are out of your 
office for a period of time, to let people know that you 
will not be checking your e-mail. (5)

Personal Folders file A data file in Outlook contain-
ing all the information that you create, including mes-
sages, contacts, appointments, and tasks. (6)

poll A feature of Microsoft Exchange Server that 
allows users to vote in response to an e-mail message 
and tabulates the results. (5)

Reading pane An area displayed, by default, to the 
right of the Inbox, used to facilitate the reading of 
messages without opening them. (1)

recurring Occurring repeatedly; used to describe 
appointments, meetings, tasks, or events that repeat 
within the Calendar. (3)

Ribbon A structure in Microsoft Office 2007 programs 
that combines the functionality of menus and toolbars, 
meant to give easier access to program functions and 
features. (1)

RPC over HTTP A protocol that allows an Outlook 
client to access an Exchange server over either an 
intranet LAN or the public Internet. (5)

rule A user-configurable set of conditions that can be ap-
plied to organize incoming or stored e-mail messages. (5)

signature Text automatically added to an e-mail 
message that you send. (5)

task A personal or work-related activity that you want 
to track to completion. (4)

task request An e-mail message asking the recipient 
to complete a specified activity. (4)

To-Do List The list of tracked tasks that can be man-
aged within the Task’s component. (4)

vCard An Internet standard for creating and sharing 
contact information. (2)

Windows Live ID An account from Microsoft that al-
lows you to sign in to MSN Messenger, MSN Hotmail, 
MSN Music, and other sites and services provided by 
Microsoft and its participating partners. (3)
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A
accepting tasks, 110–112

action, 146

Active window, xx–xxi

Add Holidays to Calendar dialog box, 82–83

Add New Category window, 166

Add New Member dialog box, 39–40

adding

 business cards to signatures, 180

 categories, 175

 flags to E-mail messages, 134–135

 hyperlinks to signatures, 126

 images to signatures, 126

 meetings, 77–78

 new contacts, 51

 Outlook data files to mail profiles, 170–172

 predefined holidays to Calendar, 82–83

 reminders, 97, 99–100

 signatures to E-mail messages, 127

address book

 creating folders, 41–42

  creating secondary, 40–43, 53–54

 deleting, 46

  scheduling attendees and meetings, 73–75

Address Book dialog box, 90

All Mail Items Instant Search dialog box, 152

All Programs Command, xvii–xviii

AllWood Mills, Inc. case study, xxxi–xxxiii

applications (Contact Management)

  attaching business cards to E-mail 

messages, 56–57, 180

  creating contact information, 57–58

  creating contacts, 52–54, 56–57

  creating distribution lists, 52–54

  creating secondary address books, 53–54

 editing contacts, 52

  editing electronic business cards, 52

  forwarding E-mail messages, 57–58

 Internet, 58

 modifying contacts, 52–53

 printing contacts, 52–54

  printing E-mail messages, 56–57

  sending E-mail messages, 56–58

  sending full contact records, 52–53

applications (Data Files)

  categorizing messages, 178, 181–182

  compressing Outlook data files, 177–178

  creating business contacts, 177

  creating home appointments, 177

  creating new Outlook data files, 177–178, 181

  setting default data files, 178, 181–182

applications (E-mail Management)

 adding business cards to signatures, 180

  creating folders and rules for automatic 

E-mail sorts, 162, 180–181

 creating signatures, 180

  delaying delivery of E-mail messages, 162, 

180–181

 flagging E-mail messages, 180–181

 polls, 162

 requesting delivery receipt, 162, 180–181

  sending private and important E-mails, 

161, 180

 setting message flags, 161

 setting security settings, 161

 sorting E-mail messages, 180

 voting, 180–181

applications (Outlook Basics)

 adding attachments, 23–24

 attaching business cards to E-mail 

messages, 56–57

 attaching multiple attachments, 125

 creating contact information, 57–58

 creating E-mail messages, 23–24, 56

 forwarding E-mail messages, 57–58

 Internet, 58

 manipulating Reading panes, 24–25

 printing E-mail messages, 23–25, 56, 56–57

 printing mail folder contents, 24–25

  responding to E-mail messages with Reply 

to All, 23

 saving attachments, 23–24

 sending E-mail messages, 23, 25, 56–58

 sorting mail folders, 24–25

applications (Schedule Management)

 changing Calendar view, 98

 printing Calendar, 98, 119–121

  scheduling appointments and events, 98, 

119–121

 setting reminders, 98, 119–121

applications (Task Management)

 assigning tasks, 116–117

 creating tasks, 116, 119–121

 Internet, 121

 locating tasks, 117

 printing tasks, 119–121

 scheduling tasks, 117

 updating tasks, 117
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Appointment Recurrence dialog 

box, 64–65

appointments

 assigning color categories, 165–166

 creating, 62–66, 94, 96–97, 177

 printing, 96–97

 reminder tips, 9, 10, 11

 scheduling, 98–100, 119–121

Appointments Calendar, 61–62

assigning

  categories to E-mail and appointments, 

165–166

  categories to meetings, contacts, and 

tasks, 166–167

 tasks, 108–112, 116–117

 tasks to categories, 175

Attach File button, 18

attaching

 electronic business cards, 56–57

 files to E-mail messages, 10, 17, 56

 multiple attachments, 25

attachments

 attaching multiple, 25

 overview, 9–12, 17, 56

 previewing message, 22

  printing E-mail message body in Memo 

Style, 22

 saving message, 22

 tips, 9, 10, 11

attendees

 notifying, 78–79

  scheduling from your address 

book, 73–75

 updating, 77–78

AutoPreview feature, 13, 18

B
business cards. See electronic business cards

buttons

 Attach File, 18

 Categories, 173

 Choose, 153

 creating E-mail polls using standard, 137

 Day View, 94

 Delay Delivery, 157

 Delete, 47

 Follow-up Flag, 157

 Forward, 18

 Full Week View, 94

 Go to Today, 94

 Insert Signature, 157

 Month View, 94

 New Appointment, 94

 New Contact, 47

 New Message, 18

 Print, 16, 18

 Print Contacts, 47

 Reply, 18

 Reply to All, 18

 Send, 18

 Send/Receive, 18

 Voting Buttons, 157

 Work Week View, 94

C
Calendar

 changing views, 98

 customizing settings, 79–83

 navigating within, 61–62, 96–97

 printing, 92–93, 97–100, 119–121

 publishing to Office Online, 87–89

 sharing, 83–89

 viewing other, 89–93

Calendar Options dialog box, 79–83, 

88–89

Card Style, 49–50

categories

 adding, 175

  assigning to E-mail and appointments, 

165–166

 assigning tasks, 175

 working with, 164–168

Categories button, 173

Categories Task Path, 73

categorizing messages sent to data 

files, 178

Check Address dialog box, 32

Check Full Name dialog box, 32–33

Choose button, 153

closing

 Outlook, 16

 Windows, xxxii

Color Categories dialog box, 148–149

Color Categories window, 165–166

color category

 creating custom, 165–166

 defined, 149

 sorting items by, 167–168

commands. See keyboard commands

completing tasks, 108

compressing data files, 177–178

condition, 146

configuring

 E-mail settings, 124

 free/busy privacy settings, 83–84

 message delivery options, 134–137
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 message importance settings, 130–131

 message sensitivity, 130–131

 RPC over TTP, 156

 security settings, 131–134

contacts

 adding, 37–38, 51

 assigning categories, 166–167

 copying between folders, 42

  creating, 28–35, 32–33, 46, 49–54, 

56–58

 creating business, 177

 creating from business cards, 47

 creating folders, 51

 creating from message headers, 34, 47

 editing, 49–53

 exporting as an Excel file, 40–41

 form tips, 34

 importing from an Excel file, 42–43, 47

 modifying, 28–35, 34–35

 moving, 42, 53–54

 printing, 44–47, 49, 51–54

 record, 37–38

 saving, 32–33, 47

 sending full, 38, 47

 tips, 30, 147

 viewing, 43–44, 47

conventions, text, ix

Copy to Folder Task Path, 47

Copy Items dialog box, 42

copying contacts between folders, 42

Create Folder dialog box, 170–171

Create a Folder Task Path, 157

Create Microsoft Personal Folders window, 198

Create New Folder

 dialog box, 41–42

 window, 139

Create New Group Schedule dialog box, 71

Create New Task, 113

Create New Task Request, 113

Create or Open Outlook Data File window, 169

Create an Outlook Data File Task Path, 173

creating

 address book folders, 41–42

  appointments, meetings, and 

events, 62–66, 94, 96–97

 business contacts, 177

 contacts, 28–35, 46–47, 49–54, 56–58

 contacts folders, 51

 custom color categories, 165–166

 custom search folders, 152–154

 data files, 168–169

 distribution lists, 38–40, 47, 50–54

 E-mail messages, 5–7, 17, 23–24, 56–58

 E-mail polls using standard buttons, 137

 external out of office messages, 130, 160

 home appointments, 177

 internal out of office messages, 129, 160

 mail folders, 138–139

 Outlook data files, 168–173, 177–178, 181

 personal folder files, 175–176

 personal signatures, 125–126, 159

 rules to categorize E-mail, 148–149

  rules to delete E-mail messages from 

senders, 146–148

 rules to forward E-mail, 149–150

  rules to manage E-mail messages, 

142–151

 rules to move E-mail messages, 142–146

  secondary address books, 40–43, 47, 

53–54

 signatures, 125–130, 180

 tasks, 102–108, 115–116, 119–121

Custom window, 135

customizing

 Calendar settings, 79–83

 Outlook experience, 154–156

 Start menu, xix

D
data files

 adding to mail profiles, 170–172

 changing settings, 172–173

 compressing, 177–178

 creating, 168–169, 177–178, 181–182

 deleting to Recycle Bin, xxxi

 setting default, 178, 181–182

Date Navigator, 61–62

Day View, 94

Declining Task dialog box, 111–112

declining tasks, 110–112

default settings, 7

Delay Delivery button, 157

delaying delivery of E-mail messages, 135, 

180–181

Delete, 42, 47

deleting

 address books, 46

 files using the Recycle Bin, xxxi

 rules, 150–151

 signatures, 127

delivery receipts, 136, 180–181

Desktop, xxix

Detailed Address Cards view, 44

dialog box (Contact Management)

 Add New Member, 39–40

 Check Address, 32
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dialog box —Cont.

 Check Full Name, 32–33

 Copy Items, 42

 Create New Folder, 41–42

 Edit Business Card, 36–37

 Move Items, 42

 Select Members: Contacts, 39

dialog box (Data Files), Create 

Folder, 171–172

dialog box (E-mail Management), 125–129, 

141, 155

 All Mail Items Instant Search, 152

 Color Categories, 148–149

 Importance, 148

 Message Options, 130–131, 132

 New Signature, 126, 128–129

 Rule Address, 150

 Rules and Alerts, 144, 148–151

 Search Text, 143–144

 Signatures and Stationery, 126–129

dialog box (Outlook Basics)

 Insert File, 10

 Print, 15–16

dialog box (Schedule Management)

 Add Holidays to calendar, 82–83

 Address Book, 90

 Appointment Recurrence, 64–65

 Calendar options, 79–83, 88–89

 Create New Group Schedule, 71

 Free/Busy Options, 83–84

 Group Schedules, 70

 Group Settings, 71

 Open Recurring Item, 77

 Open a Shared Calendar, 90

 Options, 79–83

 Outlook Options, 82

 Plan a Meeting, 73–75

  Publish Calendar to Microsoft Office 

Online, 87–89

 Published Calendar Settings, 88–89

 Select Attendees and Resources, 73–74

 Send a Calendar via E-mail, 85–86

 Send Update to Attendees, 69, 78

 Time Zone, 81–82

dialog box (Task Management)

 Declining Task, 111–112

 Task Recurrence, 104–105

dialog box tips, 32

distribution list

  creating and modifying, 38–40, 47, 

50–54

 defined, 38

Documents command, xxix

double-clicking tips, 43

drag and drop, xii–xiii

E
E–mail. See also messages

 adding flags to messages, 134–135

 adding signatures to messages, 127

 assigning color categories, 165–166

  configuring importance settings, 

130–131, 161

  configuring message delivery 

options, 134–137

  configuring message security 

settings, 131–134, 161

  configuring message sensitivity, 

130–131

 configuring settings, 124

  creating messages, 5–7, 17, 20–21, 23–24, 

56–58

 creating polls using standard buttons, 137

 creating rules to categorize, 148–149, 162

  creating rules to delete from senders, 

146–148

 creating rules to forward, 149–150

  creating rules to move messages, 

142–146

 default settings, 7

  delaying delivery of messages, 135, 162, 

180–181

 empty junk folder, 142

 forwarding messages, 57–58

 managing attachments, 9–12, 17, 56

 managing junk messages, 141–142

  printing messages, 15–16, 18, 22, 25, 

56–58

 replying, 8–9, 17

  requesting replies to be sent to another 

address, 137

 resending messages, 7–8, 17

 responding to messages, 7–9, 23

 searching all folders, 151–152

  sending Calendar information via e-mail

85–87

  sending messages, 5–7, 17, 20–21, 23, 25, 

56–58, 180

 sorting messages, 14–15, 18

 viewing messages, 12–13

 voting, 180–181

Edit Business Card dialog box, 36–37

editing

 contacts, 49–53

 electronic business cards, 36–37, 47, 52

 signatures, 126–127
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electronic business cards

 adding contacts from, 27–28

 adding to signatures, 180

 attaching, 56–57

  as automatic signatures in E-mail 

messages, 128–129

 editing, 36–37, 47, 52

 sending, 37, 47, 49–50

 sending full contacts, 38

Empty Deleted Messages Task Path, 157

emptying junk E-mail folder, 142

encrypting messages, 133–134

events

 creating, 62–66, 94

 scheduling, 97–100, 119–121

exception, 146

exiting Windows, xxxii

expanding query builder, 152

Export Contacts Task Path, 47

exporting contacts as Excel files, 40–41

F
filename extension,.ics, 90

files. See data files

Flag for Me checkbox, 134

flags, 134–135, 161, 180–181

folders

 creating custom search, 152–154

 creating new contacts, 51

 emptying junk E-mail, 142

 moving mail between, 139–140

Follow-Up Flag button, 157

formatting

 iCalendar, 90

 signatures, 126

forms

 Group Settings, 71

 New Contact, 29

 Task, 103

Forward as Attachment keyboard 

command, 18

Forward button, 18

Forward keyboard command, 18

forwarding E-mail messages, 57–58

Free/Busy Options dialog box, 83–84

Full Week, 94

G
Go to Today, 94

group schedules, 70–71

Group Schedules dialog box, 70

Group Settings dialog box, 71

Group Settings form, 71

H
hardware installation requirements, x

Help online, 46

hiding Reading panes, 13

HTTP, configuring RPC over, 156

hyperlinks, 126

I
iCalendar format, 90

.ics (filename extension), 90

images, 126

Import Contacts Task Path, 47

Importance dialog box, 148

importing contacts from an Excel 

file, 42–43, 47

Inbox printing, 22

Insert Business Card window, 128

Insert File dialog box, 10

Insert Signature button, 157

installation requirements, x

Instant Search feature, 151

Internet

 application, 121

 Calendar Subscription, 90

 E-mail address components, 5

 using, 58

inviting optional attendees to meetings, 69

J
junk E-mail

 Options window, 141–142

 tips, 142

K
keyboard commands

 All Programs, xvii–xviii

 Create New Task, 113

 Create New Task Request, 113

 Day View, 94

 Delete, 47

 Documents, xxix

 Forward, 18

 Forward as Attachment, 18

 Full Week View, 94

 keyboard menu, xxii

 Month View, 94

 Move to Folder, 47

 Move Mail Messages, 157

 Navigation pane, 18

 New Appointment, 94

 New Contact, 47

 New Distribution List, 47
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keyboard commands—Cont.

 New Message, 18

 New Search Folder, 157

 Open Selected Appointment, 94

 Open a Task, 113

 Print, 18

 Print Contacts, 47

 Reply, 18

 Reply to All, 18

 Run, xxxi

 Search, xxx

 Send, 18

 Send/Receive, 18

 Work Week view, 94

keyboard menu commands, xxii

keyboard shortcuts

 Delete, 42

 Move to Folder, 42

 tips, 42

L
letter button tips, 43

M
mail folders

 emptying deleted, 140–141

 organizing, 138–142

 printing contents, 24–25

 sorting, 24–25

Mail Format tab, 155

managing

 automated settings, 125–130

 E-mail message attachments, 9–12

 junk E-mail messages, 141–142

 Outlook data files, 181

 signatures, 125–130

marking

 tasks as complete, 102–108

 tasks as private, 107

meetings

 assigning categories, 166–167

 cancelling, 78–79

 creating, 62–66, 94

 invite optional attendees, 69

 modifying recurring, 77

 planning, 67–69

 proposing new times, 76–77

 requests, 75–79

 scheduling, 73–75

 sending requests, 66–75

Memo Style printing, 22

menus, xxii–xxiv

Message Options dialog box, 130–132

Messages. See also E-mail

 adding flags to E-mail, 134–135

 configuring delivery options, 134–137

 configuring E-mail security settings, 131–134

 configuring E-mail sensitivity, 130–131

 creating E-mail, 23, 23–24

 creating external out of office, 130, 160

 creating internal out of office, 129, 160

 creating rules to move E-mail, 142–146

 creating tasks from, 106

 delaying delivery of E-mail, 135, 162

 digitally signing, 132–133

 encrypting, 133–134

 headers, 34, 47

 managing junk E-mail, 141–142

 previewing attachments, 22

 printing E-mail with attachments, 25

 responding with Reply to All, 23

 restricting permissions, 133

 saving attachments, 22

 selecting the default format, 155

  sending Calendar information in 

E-mail, 85–87

 sending E-mail, 23, 25

 specify save location, 140

Microsoft Office Certification Program, ix

Microsoft Office Online Registration 

Assistant, 87

Microsoft Office Specialist, vii

modifying

 contacts, 28–35

 distribution lists, 38–40

 personal signatures, 125–126

 recurring meetings, 77

  rules to manage E-mail messages, 

142–151

 tasks, 102–108, 115

Month View, 94

mouse, xi–xiv

Move to Folder, 42, 47

Move Items dialog box, 42

Move Items window, 138

Move Mail Message keyboard command, 157

Move Mail Messages Task Path, 157

moving

 contacts, 42, 53–54

 mail folders, 138–139

 mail between folders, 139–140

N
navigating

 Calendar, 61–62, 96–97

 in Outlook, 4–5, 17
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Navigation pane

 keyboard command, 18

 overview, 4–5, 17

 tips, 4

New Appointment, 94

New Contact, 47

New Contact form, 29

New Distribution List, 47

New E-mail Delivery Location window, 170

New Message, 18

New Outlook Data File window, 168

New Search Folder

 keyboard command, 157

 Task Path, 157

 window, 153

New Signature dialog box, 126, 128–129

number buttons tips, 43

O
Office Online, 87–89

Online Help, 16, 46

Open Recurring Item dialog box, 77

Open Selected Appointment, 94

Open a Shared Calendar dialog box, 90

Open a Task, 113

opening E-mail message attachments, 

10–11, 17

Options dialog box, 79–83, 125–129, 141, 155

organization, text, viii

organizing mail folders, 138–142

Out of Office Message Task Path, 157

Outlook

 closing, 16

 customizing, 154–156

 navigating, 4–5

 starting, 2–3, 17, 20–21

Outlook Options dialog box, 82

Outlook Today-[Personal Folders] Properties 

window, 172

Outlook window components, 2–3

overlay mode, viewing multiple Calendars 

in, 91–92

P
permissions

 request, 90

 restricting message, 133

Personal Signature Task Path, 157

Plan a Meeting

 dialog box (Schedule Management), 73–75

 form, 67

planning meetings, 67–69

pointer shapes, xiii–xiv

previewing message attachments, 

10–11, 17, 22

Print button, 16, 18

Print Contacts, 47

Print dialog box, 15–16

Print keyboard command, 18

Print Pictures window tips, 25

printing

 appointments, 96–97

 Calendars, 92–93, 97–100, 119–121

 contacts, 44–47, 49, 51–54

 E-mail messages, 15–16, 18, 22, 25, 56–58

 Inbox contents in Table Style, 22

 mail folder contents, 24–25

 tasks, 119–121

privacy settings, 83–84

Professional Approach Web site, ix

proposing new meeting times, 76–77

Publish Calendar to Microsoft Office Online 

dialog box, 87–89

Published Calendar Settings dialog box, 

88–89

Q
query builder expansion, 152

R
read receipt requests, 136, 180–181

Reading pane, 12–13, 17, 24–25

Recycle Bin, xxxi

reminders, 97–100, 119–121

Reply to All, 18

Reply button, 18

requesting

 delivery receipts, 136

 permissions, 90

 read receipts, 136

 replies to be sent, 137

requirements, installation, x

resending E-mail messages, 5–7, 17

resizing

 Reading panes, 13

 Taskbar, xxi–xxii

 windows, xxvi–xxvii

responding

 to E-mail messages, 8–9, 17, 23

 to invitations, 76

 to meeting requests, 75–79

Restrict Permissions Task Path, 157

restricting message permissions, 133

Ribbon, xxiv, 6

right mouse button, xiii

RPC, configuring over HTTP, 156
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Rule Address dialog box, 150

rules

 categorizing E-mail, 148–149, 162

 components, 146

 creating, 180–181

 deleting, 150–151

 deleting E-mail from senders, 146–148

 forwarding E-mail, 149–150

 moving E-mail messages, 142–146

 tips, 146, 148

 turning off, 150

Rules and Alerts dialog box, 144, 148–151

Rules Task Path, 157

Rules Wizard, 143, 145–148

Run command, xxxi

S
Save & New button tips, 54

saving

 contacts, 32–33, 47

 E-mail message attachments, 11–12, 17, 22

scheduling

 appointments, 98–100, 119–121

 attendees from address books, 73–75

 events, 97–100, 119–121

 meetings from address books, 73–75

 tasks, 117

screen differences, ix

Search command, xxx

Search Folder Criteria window, 153–154

Search Text dialog box, 143–144

searching

 E-mail folders, 151–152

 tips, 145

security, configuring E-mail message 

settings, 131–134, 161

Security Properties window, 132

Select Attendees and Resources dialog 

box, 73–74

Select Members: Contacts dialog box, 39

Send button, 18

Send a Calendar via E-mail dialog box, 85–86

Send Full Contact tips, 35

Send keyboard command, 18

Send/Receive button, 18

Send Update to Attendees dialog box, 69, 78

sending

  Calendar information in E-mail 

messages, 85–87

 confidential and important messages, 161

 distribution lists, 50–51

  E-mail messages, 5–7, 17, 23, 25, 

56–58, 180

 electronic business cards, 37, 47, 49–50

 full contacts, 38, 47, 52–53

 meeting requests, 66–75, 94

 status reports on assigned tasks, 112

settings

 changing data file, 172–173

 configuring E-mail, 124

  configuring E-mail message 

importance, 130–131

  configuring E-mail message 

security, 131–134

 configuring free/busy privacy, 83–84

 customizing Calendar, 79–83

 default data files, 178, 181–182

 managing automated, 125–130

 reminders, 98

 time zones, 80–82

sharing Calendars, 83–89

shortcut menus, xxiii–xxiv

signatures

 business cards,180

 creating, 125–130, 159, 180

 defined, 125

 deleting, 127

 editing, 126–127

 formatting, 126

 managing, 125–130

 setting as default, 159

Signatures and Stationery dialog 

box, 126–129

signing messages digitally, 132–133

Small Booklet Style print preview, 45

software installation requirements, x

Sort by Categories Task Path, 73

sorting

 E-mail messages, 14–15, 18

 items by color category, 167–168

 mail folders, 24–25

 tips, 24

Start Menu, xv–xvii, xix

starting Outlook, 2–3, 17, 20–21

subscribing to Internet Calendars, 90–91

switching mail folders, 24–25

T
Table Style printing, 22

Task form, 103

Task Paths

 Categories, 173

 Copy to Folder, 47

 Create a Folder, 157

 Create New Task, 113

 Create New Task Request, 113
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 Create an Outlook Data File, 173

 Day View, 94

 Delete, 47

 Empty Deleted Messages, 157

 Export Contacts, 47

 Full Week View, 94

 Go to Today, 94

 Import Contacts, 47

 Month View, 94

 Move to Folder, 47

 Move Mail Messages, 157

 New Appointment, 94

 New Contact, 47

 New Contact Folder, 47

 New Distribution List, 47

 New Search Folder, 157

 Open Selected Appointment, 94

 Open a Task, 113

 Out of Office Message, 157

 Personal Signature, 157

 Print Contacts, 47

 Restrict Permissions, 157

 Rules, 157

 Sort by Categories, 173

 To-Do Bar Options, 157

 Work Week View, 94

Task Recurrence dialog box, 104–105

Taskbar

 Notification Area, xx

 overview, xix–xx

 resizing, xxi–xxii

TaskPad, 61–62

tasks

 accepting, 110–112

 assigning, 108–112, 116–117

 assigning categories, 166–167

 completing, 108

 creating, 102–108, 115–116, 119–121

 declining, 110–112

 locating, 112, 117

 marking as complete, 102–108

 marking as private, 107

 modifying, 102–108, 106–107, 115

 printing, 119–121

 scheduling, 117

  sending status reports on 

assigned, 112

 tips, 104, 105, 107, 108, 109, 111

 updating, 115, 117

text

 conventions, ix

 features, viii

 organization, viii

text box tips, 30

Time Zone dialog box, 81–82

time zones, 80–82

To-Do bar, 154

 Options Task Path, 157

 Options window, 154

 tips, 155

tracking responses to requests, 72–73

U
updating

 attendees, 75–78

 meeting requests, 75–79

 tasks, 115, 117

V
vCard

 electronic business cards, 36

 files, 47

view, changing Calendar, 98

viewing

 Calendars, 89–92

 contacts, 43–44, 47

 E-mail messages, 12–13

Voting Buttons button, 157

W
Web sites, Professional Approach, ix

windows

 Active, xx–xxi

 Add New Category, 166

 Color Categories, 165–166

 Create Microsoft Personal Folders, 118

 Create New Folder, 139

 Create or Open Outlook Data File, 169

 Custom, 135

 displaying simultaneously, xxvii–xxviii

 exiting, xxxii

 Insert Business Card, 128

 Junk E-mail Options, 141–142

 Move Items, 138

 New E-mail Delivery Location, 170

 New Outlook Data File, 168

 New Search Folder, 153

 Outlook Today-[Personal Folders] 

Properties, 172

 Print Pictures, 25

 resizing, xxvi–xxvii

 Search Folder Criteria, 153–154

 Security Properties, 132

 To-Do Bar Options, 154

Windows Desktop, xv

Windows Log-on screen, xiv–xv
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Windows Rights Management 

Services Client, 133

Windows tutorial

 Active Window, xx–xxi

 All Programs Command, xvii–xviii

 changing the Desktop, xxix

 customizing the Start Menu, xix

 deleting files using the Recycle Bin, xxxi

 Dialog boxes, xxiv–xxvi

 displaying program windows, xxvii–xxviii

 Documents Command, xxix

 exiting Windows, xxxii

 Menus, xxii–xxiv

 mouse, xi–xiv

 overview, xi

 resizing the Taskbar, xxi–xxii

 resizing windows, xxvi–xxvii

 Ribbon, xxiv

 Run command, xxxi

 Search command, xxx

 Start Menu, xv–xvii

  starting Windows: The Log-on 

Screen, xiv–xv

 Taskbar, xix–xx

 Taskbar Notification Area, xx

 Windows Desktop, xv

Work Week View, 94
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